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Question: Which of the following allows specifying styles for the
visual elements of the website ?

a) Cascading Style sheets
b) Web page
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Answer: Cascading Style sheets

Question: Which of the following is known as special symbol in the
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y
a) Rules
b) Selector
c) Declaration
d) Input

Answer: Rules

Question: Which of the following are two main parts of CSS rule ?
a) Selector, declaration
b) Select, declaration
c) Selector, declare
d) Selection, declaration

Answer: Selector, declaration

Question: Which of the following is an HTML element on which style
can be applied ?

a) Declaration
b) Selector
c) Select
d) Declare

Answer: Selector

Question: Which of the following is the syntax of CSS ?
a) Select {property : value}
b) Selector {value : property}
c) Selector {property : value}
d) Selection {property : value}

Answer: Selector {property : value}

Question: Which of the following has developed JavaScript ?
a) Yahoo
b) Google
c) Wikipedia
d) Netscape

Answer: Netscape

Question: Which of the following is a scripting language that allows
adding programming to web pages ?

a) Action script
b) JavaScript
c) HTML
d) CSS

Answer: JavaScript

Question: Which of the following is a scripting language that is
simple, lightweight programming language that does not contain
advanced programming functionalities ?

a) JavaScript
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b) HTML
c) C
d) Java

Answer: JavaScript

Question: Which of the following tag is used to insert JavaScript
code into an HTML page ?

a) <script>... <script>
b) <script>... </script>
c) <script>... <//script>
d) </script>... </script>

Answer: 

<script>... </script>

Question: Which of the following symbol signifies the start and end
of a JavaScript block ?

a) Semicolon
b) Square bracket
c) Curly bracket
d) Round bracket

Answer: Curly bracket

 

Question: Which of the following is a reusable block of code that
performs a particular task ?

a) Array
b) Code
c) Program
d) Function

Answer: Function

Question: Which of the following statement is used to return a value
in a function ?

a) Return
b) Function
c) Select
d) Send

Answer: Return

Question: Which of the following is generated by the browser due to
interaction between the user and the web page ?

a) Function
b) Response
c) Event
d) Value

Answer: Event
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Question: Which of the following is not an event ?
a) Abort
b) Mouse over
c) Set
d) Load

Answer: Set

Question: Which of the following is a container for storing data ?
a) Variable
b) Integer
c) Event
d) Event handler

Answer: Variable

Question: Which of the following stands for BOM ?
a) Browser Of Model
b) Browser Object Model
c) Browser Object Modelling
d) Browse Object Model

Answer: Browser Object Model

Question: Which of the following is the top level object in the
browser object model ?

a) Window
b) Document
c) Page
d) Location

Answer: Window

Question: Which of the following stands for NaN ?
a) Not a Numeric
b) Not a Number
c) Not a Noun
d) Not an Numeric

Answer: Not a Number

Question: What is the full form of CSS ?
a) Computing Style sheet
b) Cascading Style sheet
c) Computing Style Service
d) Cascading Secure Sheet

Answer: Cascading Style sheet

Question: ______allows you to specify styles for the visual elements of
the website.

a) DHTML
b) HTML
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c) CSS
d) CHS

Answer: CSS

Question: What is the use of CSS ?
a) To arrange the visual elements
b) To specify styles for the visual elements
c) To prepare coding of HTML
d) To prepare JavaScript

Answer: To specify styles for the visual elements

Question: Which is the wrong statement for CSS ?
a) Specifies styles for the visual elements.
b) Keeps it separate from the details of how to display the content.
c) Specify the appearance of particular page elements on the screen.
d) Arrange the visual elements.

Answer: Arrange the visual elements.

Question: ______is not the benefit of keeping the style separate from
the content.

a) Arrange the visual elements
b) Avoid duplication in coding
c) Easy maintenance of code
d) Use the same content with different styles for different purposes

Answer: Arrange the visual elements

Question: ______can be used for the information to be pul on internet.
a) CSS
b) HTML
c) DHTML
d) All of these

Answer: HTML

Question: ______specifies the styles for the visual elements,
a) CSS
b) HTML
c) DHTML
d) All of these

Answer: CSS

Question: ______can be done using CSS.
a) Control the font types of font and element colors
b) Background features
c) Control the positions of elements
d) All of these

Answer: All of these
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Question: ______sheet can be used to add special characters in the
website.

a) Spread
b) Work
c) Style
d) Main

Answer: Style

Question: The syntax of CSS consists of special symbols known
as______

a) Regulation
b) Rules
c) Style
d) Cascade

Answer: Rules

Question: A CSS rule has______main parts.
a) 2
b) 3
c) 4
d) 5

Answer: 2

Question: CSS syntax uses______brackets.
a) ( )
b) { }
c) [ ]
d) < >

Answer: { }

 

Question: ______is not the part of the CSS syntax.
a) Selector
b) Declarations
c) HTML details
d) None of these

Answer: HTML details

Question: ______is taken as a selector.
a) HTML details
b) HTML element
c) Any name
d) Identifier

Answer: HTML element

Question: Style can be applied to______
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a) HTML element
b) Any name
c) Identifier
d) Parameter

Answer: HTML element

Question: CSS rules contain______part.
a) Property
b) Value for the property
c) (A) and (B) both
d) (A) or (B)

Answer: (A) and (B) both

Question: ______is the wrong statement for the CSS syntax.
a) Selector must be an HTML element
b) CSS syntax is divided into two parts
c) More than one property can be used
d) Property and value is separated using;

Answer: Property and value is separated using;

Question: _____is the correct syntax of CSS.
a) Selector {Property ; Value}
b) Selector {Property : Value};
c) Selector {Property : Value}
d) Selector [Property : Value]

Answer: Selector {Property : Value}

Question: As per our syllabus, using______software CSS is created.
a) Notepad
b) KompoZer
c) Gedit
d) CompoZer

Answer: KompoZer

Question: KompoZer uses_____as default.
a) CSS
b) HTML
c) DHTML
d) PHP

Answer: CSS

Question: Using______we can get confirmation that CSS is used by
default by KompoZer.

a) Edit —> Preferences
b) Tools -> Preferences
c) (A) or (B)
d) None of these
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Answer: (A) or (B)

Question: How to open option dialog box in KompoZer ?
a) Edit —> Preferences
b) Tools ~» Preferences
c) (A) or (B)
d) View -> Preferences

Answer: (A) or (B)

 
Question: ______statement is wrong about the KompoZer software.

a) CSS can be added with HTML
b) CSS can be added easily
c) KompoZer can only be used for CSS
d) All of these

Answer: KompoZer can only be used for CSS

Question: Cascade button is on_____toolbar of KompoZer.
a) Standard toolbar
b) Composition toolbar
c) Format toolbar
d) Drawing toolbar

Answer: Composition toolbar

Question: While preparing a style, if a new file is opened and not
saved by giving a filename then dialog box opens.

a) Option
b) Page title
c) New
d) Save

Answer: Page title

Question: The element which is used to define Style sheet rule that
CSS Style sheet dialog box is under_____heading.

a) External Style sheet
b) Internal Style sheet
c) Right Style sheet
d) General Style sheet

Answer: Internal Style sheet

Question: ______tab is not displayed on the right side of CSS Style
sheet dialog box.

a) General
b) Number
c) Text
d) Box

Answer: Number
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Question: ______section is used to give specific style to the HTML
element.

a) General
b) Text
c) Background
d) All of these

Answer: All of these

Question: ______button is clicked to insert an image as the
background while preparing style.

a) Choose file
b) Select file
c) Browser
d) Select image

Answer: Choose file

Question: ______tab displays the Style sheet rule that is given to the
element.

a) General
b) Box
c) Aural
d) Code

Answer: General

Question: How many buttons are there in CSS Style sheets to prepare
style ?

a) 5
b) 6
c) 7
d) 8

Answer: 7

Question: ______view is selected to see the source code of CSS Style
sheet.

a) Design
b) Source
c) Split
d) Normal

Answer: Source

Question: _____is false for CSS Style sheet.
a) To modify the Style sheet user can make changes in CSS file.
b) CSS has less-code compared to that in HTML.
c) The web pages will load faster
d) CSS structure makes the website slow and inefficient

Answer: CSS structure makes the website slow and inefficient
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Question: _____is the disadvantage of CSS.
a) CSS has less-code compared to that in HTML
b) Compatibility varies with different browsers.
c) Style sheet features are not supported by the browser
d) (B) and (C) both

Answer: (B) and (C) both

Question: _______type of web page is static.
a) HTML
b) DHTML
c) JAVASCRIPT
d) All of these

Answer: HTML

Question: ______company has developed the JavaScript.
a) Microsoft
b) ORACLE
c) Netscape
d) Intel

Answer: Netscape

Question: _______is a simple, lightweight programming language that
does not contain the advanced programming functionalities of
language.

a) JavaScript
b) HTML
c) DHTML
d) None of these

Answer: JavaScript

Question: ______controls appearance of the web page.
a) JavaScript
b) HTML
c) DHTML
d) PHP

Answer: HTML

Question: What is the use of JavaScript in a web page ?
a) To improve the design
b) To validate the forms.
c) (A) and (B) both
d) To change the modern format in a web page

Answer: (A) and (B) both

Question: ______browser supports JavaScript.
a) Mozilla Firefox
b) Chrome
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c) Safari and Internet Explorer
d) All of these

Answer: All of these

Question: JavaScript can be used for a______in a web page.
a) Interactivity with the user
b) Control the browser
c) Dynamically create HTML content
d) All of these

Answer: All of these

Question: What type of a script is JavaScript ?
a) Application client side
b) Application server side
c) For any web page
d) All of these

Answer: Application client side

 

Question: It is used to validate the data entered in the HTML forms
on the______before sending it to the server.

a) Server side
b) Client side
c) HTML details
d) All of these

Answer: Client side

Question: _______can be checked in a form by using JavaScript.
a) Has the user left any required field empty ?
b) Has the user entered a valid date ?
c) Check whether contents of two fields are same or not ?
d) All of these

Answer: All of these

Question: _______is not true for JavaScript.
a) JavaScript is used to improve the design
b) JavaScript contains the advanced programming functionalities of languages like C and Java
c) JavaScript vaMates \he foray
d) Browsers like Chrome and Safari support JavaScript

Answer: JavaScript contains the advanced programming functionalities of languages like C and Java

Question: _______is true for JavaScript.
a) JavaScript is not a case sensitive language
b) The lines between the 
tag contains the JavaScript code

c) JavaScript is not included with HTML
d) JavaScript can not be inserted directly as an independent part in a web page
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Answer: The lines between the

tag contains the JavaScript code

Question: Generally it is preferred that the JavaScript code should be
placed in the tag.

a) <body>.....</body>
b) <head>.....</head>
c) <title>.....</title> 
d) <form>.....</form>

Answer:  <.head>.....</head.>

Question: The______tag tells the browser to interpret all the text
between the <script> tags as a script.

a) <body>
b) <head>
c) <script>
d) <form>

Answer: <.script.>

Question: When document or image is loaded it is known as_____event.
a) Load
b) Select
c) Click
d) Submit

Answer: Load

Question: _____is the event handler.
a) HTML Code
b) JavaScript Code
c) DHTML Code
d) Java programming Code

Answer: JavaScript Code

Question: ______specific code is executed when a particular event
occurs.

a) JavaScript
b) HTML
c) Java
d) DHTML

Answer: JavaScript

Question: _______is not an event handler.
a) On click ()
b) On submit ( )
c) Load ( )
d) On focus ( )

Answer: Load ( )
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Question: ______is not an event handler.
a) Blur
b) Exit
c) Reset
d) Error

Answer: Exit

Question: ______is the name of event handler for the 'click' event.
a) Click ()
b) On Click ()
c) On Click {}
d) On Click [ ]

Answer: On Click ()

Question: ______is the name of event handler for the 'submit' event.
a) On Submit ()
b) Submit ()
c) On submit ()
d) On Submit ()

Answer: On submit ()

Question: ______means the storage for storing values.
a) Variable
b) Parameter
c) Identifier
d) All of these

Answer: Variable

Question: ______is used to declare variables in JavaScript.
a) Var
b) var
c) VAR
d) vr

Answer: var

Question: ______is true for the variables in JavaScript.
a) Variable is case sensitive
b) Number, string or characters can be stored in variable
c) Variables can be declared by using var keyword
d) All of these

Answer: All of these

 

Question: ______is the use of if statement.
a) Conditional statement to change the flow of program
b) Checks for the validation of condition
c) (A) and (B) both



13/09/2022, 20:02 CBSE Class 12 Computer Science Cascading Style Sheets and JavaScript MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-cascading-style-sheets-and-javascript-mcqs-set 14/23

d) For non-conditional work

Answer: (A) and (B) both

Question: BOM stands for_____
a) Browser Oriented Model
b) Browser Object Model
c) Big Object Model
d) Big Oriented Model

Answer: Browser Object Model

Question: What is the use of Browser Object Model ?
a) To arrange the objects in browser
b) To change the web page
c) To control the elements of the web page
d) All of these

Answer: To control the elements of the web page

Question: All browsers are split into different parts or objects that
can be accessed using JavaScript. These parts are known as_____

a) BOM
b) BOC
c) MOB
d) OBC

Answer: BOM

Question: The top level object in the browser object model
is____object.

a) Document
b) Form
c) Window
d) Link

Answer: Window

Question: The window object is the_____object in the browser.
a) Main
b) Global
c) Changer
d) Normal

Answer: Global

Question: Why the window object is known as the global! object ?
a) Because it is common in all the browsers.
b) Because all other browser objects arl contained within it.
c) Because it is the top object of BOM.
d) All of these

Answer: Because all other browser objects arl contained within it.
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Question: By_____web browser window is controlled in window
object.

a) Methods
b) Properties
c) (A) and (B) Both
d) Document

Answer: (A) and (B) Both

Question: What is included in object ?
a) Document object
b) Form object
c) Radio object
d) All of these

Answer: Document object

Question: ______is the most important object in the browser object
model.

a) Form object
b) Document object
c) Radio object
d) Checkbox object

Answer: Document object

Question: ______object is used to display web page in a browser.
a) Location object
b) Form object
c) Document object
d) Text area object

Answer: Document object

Question: ______is included in the document object of BOM.
a) Form
b) Images
c) Links and other elements
d) All of these

Answer: All of these

Question: ______object is used to give reference to other objects.
a) Element
b) Document
c) Link
d) All of these

Answer: Element

Question: ______can be the object as the element object of browser
object mode.
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a) Radio button
b) Text box
c) Check box
d) All of these

Answer: All of these

Question: ______method is used to take the control to the specific
element of the form.

a) Focus
b) Alert
c) Document
d) Confirm

Answer: Focus

Question: When focus () method is used ?
a) Any time in JavaScript
b) After getting alert O message
c) After getting confirm message
d) When the for is created

Answer: After getting alert O message

Question: In internet some fields in the form are displayed with red
asterisk (*) is known as____

a) This field is optional.
b) This field is mandatory, can't leave it blank.
c) This field is out of the reach.
d) Only correct information is to be filled up.

Answer: This field is mandatory, can't leave it blank.

Question: ______is used to clear the validation of the entered data.
a) HTML
b) DHTML
c) Java
d) JavaScript

Answer: JavaScript

Question: _______is not the inbuilt function.
a) isNaN ()
b) Alert ()
c) if ()
d) Confirm ()

Answer: if ()

Question: _______built in function is there to work with number in
Javascript.

a) Digits ()
b) isNaN ()
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c) isnan ()
d) Alert ()

Answer: isNaN ()

Question: _______is the most used numerical function in Javascript.
a) isNaN ()
b) Number ()
c) Digits ()
d) None of these

Answer: isNaN ()

Question: NaN stands for_________.
a) Number and Number
b) Not a Number
c) Not a numeric
d) Numeric and Number

Answer: Not a Number

Question: isNaN(123) will give__________output.
a) True
b) False
c) erroe
d) 123

Answer: False

Question: isNaN(“Sujal”)will give_______output.
a) True
b) False
c) erroe
d) Hello

Answer: True

Question: __________element is used to write script in HTML.
a) <head>…</head>
b) <script>…</script> 
c) <scr>…</scr>
d) <body>…</body>

Answer: 

<script>…</script>

Question: _____browser supports JavaScript.
a) Mozilla Firefox
b) Chrome
c) Safari and Internet Explorer
d) All of these

Answer: All of these
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Question: JavaScript can be used for a _____ in a web page.
a) Interactivity with the user
b) Control the browser
c) Dynamically create HTML content
d) All of these

Answer: All of these

Question: What type of a script is JavaScript ?
a) Application client side
b) Application server side
c) For any web page
d) All of these

Answer: Application client side

Question: _____symbol is optional in JavaScript.
a) ColonO)
b) Semicolon(;)
c) Full stop(.)
d) Double quotes("")

Answer: Semicolon(;)

Question: What is the use of semicolon in JavaScript ?
a) Termination of statement
b) Separation of statement
c) Merge two statements
d) All of these

Answer: Separation of statement
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b) Arrays
c) Assortments
d) Groups

Answer: Arrays

Question: ________is one dimensional (1-D) data structure that can be
used to store list of items like characters, numbers.

a) Vector
b) Path
c) Matrix
d) Route

Answer: Vector

Question: ________is used to represent two dimensional (2-D) data
structures like table or rows and columns.

a) Vector
b) Path
c) Matrix
d) Route

Answer: Matrix

Question: ________are useful when same operations are to be
performed on various elements of the similar type.

a) Matrix's
b) Arrays
c) Dimensions
d) Groups

Answer: Arrays

Question: All the______of an array are stored in memory using
contiguous storage space.

a) Index's
b) Values
c) Features
d) Elements

Answer: Elements

Question: Each element is identified by an______position associated
with array variable.

a) Index
b) Value
c) Tabular
d) Element

Answer: Index

Question: In Java_______is an object used to manage list of items.

Entrepreneurship
Marketing
Painting and Sculpture
Physical Education
English
Graphics Design
Geography
Hindi
Home Science
History
Informatics Practices
Languages
Mathematics
Other Subjects
Physics
Political Science
Psychology
Sanskrit
Sociology
Urdu

Classes
Class XII
Class XI
Class X
Class IX
Class VIII
Class VII
Class VI
Class V
Class IV
Class III
Class II
Class I

Search
keywords

Search
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a) Array
b) Variable
c) Matrix
d) Element

Answer: Array

Question: Creating an array is a_______step process.
a) One
b) Two
c) Three
d) Four

Answer: Two

Question: An array object can be created in_____ways.
a) One
b) Two
c) Three
d) Four

Answer: Two

Question: Which is the way an array object can be created ?
a) Using new operator and specifying the size.
b) Directly initializing the content of array
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: Array with______dimension is known as 1-D array.
a) Double
b) Triple
c) Both (A) and (B)
d) Single

Answer: Single

Question: For example_________can be seen as a collection of one or
more scalar variables.

a) Vector
b) Path
c) Matrix
d) Variable

Answer: Vector

Question: Instead of declaring individual variables like marks 1,
marks2, marks3, marks4, marks5; one can declare array_________

a) Marks [5]
b) Mark[5]
c) Marks[l-5]
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d) All of these

Answer: Marks [5]

Question: Individual variable elements of an array marks [5] can be
accessed as :

a) Marks[1], marks[2], marks[3], marks[4], marks [5].
b) Marks[-1], marks[1], marks[2], marks[3], marks [4].
c) Marks[0], marks[1], marks[2], marks[3], marks [4].
d) Marks[-1], marks[0], marks[1], marks[2], marks [3].

Answer: Marks[0], marks[1], marks[2], marks[3], marks [4].

Question: To declare a______array a pair of square brackets [ ] is used
after array name or after data type.

a) 2-D
b) 1-D
c) 3-D
d) 4-D

Answer: 1-D

Question: The syntax to declare array is as follows________
a)[ ];
b);
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: For example, to store the marks obtained by a student in
five tests in Mathematics subject, an array of______integer elements
can be used.

a) Five
b) Six
c) Four
d) Seven

Answer: Five

Question: The array marks refers to______location where five integer
values are stored.

a) Chip
b) Memory
c) Variable
d) Address

Answer: Memory

Question: Array object named 'marks' with size for 5 elements can be
created as follows :

a) Int marks [ ] = new int [5];
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b) Int[ ] marks = new int [5];
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

 

Question: Integer of int data type uses________bytes storage space.
a) 2
b) 3
c) 4
d) 5

Answer: 4

Question: Thus array marks requires________bytes in contiguous
locations in memory.

a) 5 x 4 = 20
b) 5 x 5 = 25
c) 5 x 3 = 15
d) 5 x 2 = 10

Answer: 5 x 4 = 20

Question: To refer an element of an array, an index or subscript is
used in______after array variable name.

a) Curly bracket { }
b) Square bracket [ ]
c) Round bracket ()
d) None of these

Answer: Square bracket [ ]

Question: ______specifies the position of an element in an array.
a) Number
b) Index
c) Variable name
d) Element

Answer: Index

Question: Index value starts from_______
a) 5
b) 4
c) 1
d) 0

Answer: 0

Question: The array variable marks[5] has an index value from_______
a) 1 to 5
b) 0 to 4
c) 0 to 5
d) 1 to 4
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Answer: 0 to 4

Question: In array variable marks [5], marks [0] refers to
the_______element.

a) Last
b) Second
c) First
d) None of these

Answer: First

Question: In array variable marks [5], marks [4] refers to
the_______element.

a) Last
b) Second
c) First
d) Fourth

Answer: Last

Question: An object is a_______to variable.
a) Position
b) Location
c) Address
d) Reference

Answer: Reference

Question: Array being an object in Java, array name is also
a______variable.

a) Position
b) Location
c) Address
d) Reference

Answer: Reference

 

Question: Array name contains_______to memory location where the
array elements are stored.

a) Position
b) Location
c) Address
d) Reference

Answer: Reference

Question: As array is an object, so its elements are initialized
with_______values.

a) Default
b) Initial
c) Declared
d) Index
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Answer: Default

Question: 1-D array is initialized using_______separated values of data
elements in braces { }.

a) Semi colon
b) Comma
c) Colon
d) Full stop

Answer: Comma

Question: Which of the following is correct initialization of 1-D array
?

a) Int marks[ ] = {90, 70, 77};
b) Int [ ] marks = {90, 70, 77};
c) Int marks} ] = {90; 70; 77}
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: When an array is initialized while creating, it does not need
the use of_______operator.

a) New
b) New
c) Int
d) Float

Answer: New

Question: The array size is same as the number of values specified
in________

a) Braces
b) Index
c) Default value
d) Initialization

Answer: Braces

Question: Class methods are declared as________and can be referred
without any object in the class.

a) Private
b) Void
c) Package
d) Static

Answer: Static

Question: Every element of an array is an individual variable that can
be referred by using_______

a) Index
b) Value
c) Tabular
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d) Element

Answer: Index

Question: Like variables, to change the value of an element, an
assignment statement can be used which refers a variable element
on______side.

a) Right
b) Left
c) Middle
d) None of these

Answer: Left

Question: Instead of writing the code, various static methods
provided by Java using_______class can be used.

a) Java.Arrays
b) Java.utility
c) Java.util.Arrays
d) All of these

Answer: Java.util.Arrays

Question: Methods sort() and fill() are part of______class.
a) JavaArrays
b) Java.util
c) Java.util.Arrays
d) All of these

Answer: Java.util.Arrays

Question: To sort an entire or part of array_______method can be
used.

a) Sort()
b) Fill()
c) Display()
d) Order()

Answer: Sort()

Question: Method______is used to fill or partial array with specified
value.

a) Sort()
b) Fill()
c) Display()
d) Order()

Answer: Fill()

Question: To search an element in an array, arrays class
provides______method.

a) Search0
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b) Find()
c) Binary search()
d) Bin search ()

Answer: Binary search()

Question: search method does element by element comparison in a
serial manner.

a) Linear
b) Vertical
c) Horizontal
d) Vector

Answer: Linear

Question: ______arrays are used to store tabular data in the form of
rows and columns.

a) 2-D
b) 1-D
c) 3-D
d) 4-D

Answer: 2-D

Question: In Java, 2-D array can be declared using array name and 2
pairs of______to specify the size of two dimensions row and column
respectively.

a) Curly bracket { } { }
b) Square bracket [ ] [ ]
c) Round bracket () ( )
d) None of these

Answer: Square bracket [ ] [ ]

Question: int marks [ ] f ] = new int [5] [3], the logical view of array
elements is a table of_________

a) 3 rows and 5 columns
b) 15 columns
c) 5 rows and 3 columns
d) 15 rows

Answer: 5 rows and 3 columns

Question: Int marks [ ] [] = new int [5] [3], will physically use
contiguous memory locations that is_______bytes.

a) 15
b) 45
c) 60
d) 8

Answer: 60
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Question: To create_______array, an array of an array has to be
created.

a) 2-D
b) 1-D
c) 3-D
d) 4-D

Answer: 2-D

Question: Declaration and initialization of 2-D array is very similar to
1-D array except the number of

a) Sizes
b) Length
c) Index values
d) Dimensions

Answer: Dimensions

Question: In 2-D array, each row is considered as_______array element.
a) 2-D
b) 1-D
c) 3-D
d) 4-D

Answer: 1-D

Question: To initialize 2-D array, all these initialized rows are to be
enclosed in curly braces {} separating them by______

a) Colon (:)
b) Comma (,)
c) Semi Colon (;)
d) Full stop (.)

Answer: Comma (,)

Question: In Java, 2-D array is considered as an_______of 1-D array.
a) Matrix
b) Array
c) Dimension
d) Group

Answer: Array

Question: In 2-D array, each name is stored in different row and all
names have different number of______

a) Spaces
b) Groups
c) Characters
d) Columns

Answer: Characters
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Question: Size of each row of an array can be known
using_______property of 1-D array.

a) Length
b) Height
c) len
d) Size

Answer: Length

Question: For 2-D array_______property returns number of rows.
a) Length
b) Height
c) len
d) Size

Answer: Length

Question: For 1-D array______property returns number of columns in
specified row element.

a) Length
b) Height
c) Len
d) Size

Answer: Length

Question: ________is a collection of homogeneous type of data.
a) Matrix
b) Array
c) Dimension
d) Group

Answer: Array

Question: ________elements can be accessed using index for each
dimension in [ ].

a) Matrix
b) Array
c) Dimension
d) Group

Answer: Array

 
Question: Index value starts with_______

a) One
b) Two
c) Zero
d) Three

Answer: Zero
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Question: Declaring an______without initialization does not create an
array object.

a) Matrix
b) Array
c) Dimension
d) Group

Answer: Array

Question: String is nothing but a sequence of________
a) Spaces
b) Groups
c) Characters
d) Columns

Answer: Characters

Question: 1-D array of_______can be considered as a string.
a) Spaces
b) Groups
c) Characters
d) Columns

Answer: Characters

Question: ________literals are where a sequence of characters is
enclosed between double quotes.

a) String
b) Character
c) Numerical
d) None of these

Answer: String

Question: To use variables that can store strings, Java
supports_____types of strings.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: Strings in Java are handled by two classes namely 'String'
and________

a) Strings
b) Characters
c) Buffer
d) StringBuffer

Answer: StringBuffer
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Question: String ( ) without arguments create a________object with no
character.

a) String
b) Character
c) Buffer
d) Code

Answer: String

Question: String (char ary[ ]) creates a String object with its initial
value using ary_______

a) Value
b) Argument
c) Index
d) [ ]

Answer: Argument

Question: String (char ary[ ], int start, intlen) creates a String object
using 1-D ary argument starting at ary[start] with________number of
characters.

a) Length
b) Leng
c) Len
d) Limited

Answer: Len

Question: String (String strObj) creates a String object which is same
as object specified in________

a) Value
b) Argument
c) Index
d) Square brackets [ ]

Answer: Argument

Question: String (string literal) creates a String_________which is same
as object specified in argument.

a) Literal
b) obj
c) Object
d) Variable

Answer: Object

Question: String (string literal) creates a String object that refers to
the______specified in argument.

a) Literal
b) Obj
c) Object
d) Variable
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Answer: Literal

Question: In Java, characters are stored using_______bytes.
a) Four
b) Three
c) Two
d) Five

Answer: Two

Question: To save space, if the characters are_______an array of bytes
should be used instead of array of characters.

a) ASCII
b) Coded
c) ACSII
d) ACIIS

Answer: ASCII

Question: A______can be used with array of bytes as an argument.
a) Method
b) Destructor
c) Variable
d) Constructor

Answer: Constructor

Question: When two String objects are created using same string
literals, memory space is not allocated for______object.

a) First
b) Second
c) Both (A) and (B)
d) None of these

Answer: Second

Question: Separate memory is allocated when string objects are
created using________operator even if strings are identical.

a) New
b) new
c) int
d) Float

Answer: new

Question: "strl = - str2"_______the contents of strl and str2 and not
the objects at strl and str2.

a) Equals
b) Matches
c) Compares
d) Relates
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Answer: Compares

Question: The String class provides_______to compare strings, find
length of string, combining strings, obtaining substrings, converting
strings, splitting strings, searching for character or patterns in string
etc.

a) Constructors
b) Methods
c) Strings
d) Classes

Answer: Methods

Question: Method Boolean equals(String str) returns_______if invoking
string is same as str.

a) True
b) False
c) Can't say
d) None of these

Answer: True

Question: Method booleanequalslgnore Case (String str)
returns_______if invoking string is same as str after ignoring case (case
insensitive).

a) True
b) False
c) Can't say
d) None of these

Answer: True

Question: Method int compare To (String str) returns 0, > 0, <
0_______if invoking string is equal to, greater than or less than str
respectively.

a) String
b) Negative value
c) Integer
d) Float

Answer: Integer

Question: Method int compare To ignore Case (String str) is same
as______but Case Sensitive.

a) Equals
b) Ignore Case
c) Equals lgnore Case
d) Compare To

Answer: Compare To
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Question: A String class provides methods for_______task.
a) Extracting part of string.
b) Replacing characters or substrings.
c) Splitting string into substrings
d) All of these

Answer: All of these

Question: A String class provides methods for______task.
a) Getting number of characters.
b) Getting character at specified index position.
c) Converting string into an array of bytes.
d) All of these

Answer: All of these

Question: A String class provides methods for_____task.
a) Converting string into lowercase or uppercase
b) Appending string
c) Copy string or part of string
d) All of these

Answer: All of these

Question: Method int______returns number of characters in invoking
string.

a) IndexAt(int index)
b) Length( )
c) GetBytes()
d) To Upper Case()

Answer: Length( )

Question: Method char______returns character at index position from
the invoking string, index considered from 0.

a) Index At(int index)
b) Length( )
c) Get Bytes()
d) To Upper Case()

Answer: Index At(int index)

Question: Method byte[ ]_______returns an array of characters as
bytes from invoking string.

a) IndexAt(int index)
b) Length( )
c) Get Bytes()
d) To Upper Case()

Answer: Get Bytes()
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Question: Method void________copies characters of invoking string
fromlndx to tolndx-1 to target array from targetlndx onwards.

a) To Upper Case()
b) To Lower Case
c) Concat(String str)
d) Get Chars(intfromIndx, inttoIndx, char target [], inttargetIndx)

Answer: Get Chars(intfromIndx, inttoIndx, char target [], inttargetIndx)

Question: Method String______returns a string after appending str
with the invoking string.

a) To Uppercase0
b) To LowerCase
c) Concat (String str)
d) Get Chars (intfromlndx, inttolndx, chad target[], inttargetlndx)

Answer: Concat (String str)

Question: String______returns a string with all characters of invoking
string converted to lowercase.

a) To UpperCase()
b) To LowerCase
c) Concat (String str)
d) Get Chars (intfromlndx, inttolndx, chail target!], inttarget Indx)

Answer: To LowerCase

Question: String______returns a string with all characters of invoking
string converted to uppercase.

a) To UpperCase()
b) To LowerCase
c) Concat (String str)
d) GetChars (intfromlndx, inttolndx, chJ target!], inttargetlndx)

Answer: To UpperCase()

Question: With array variable, length is an______or property of array;
a) Attribute
b) Method
c) String
d) None of these

Answer: Attribute

Question: With String object length is a_______
a) Attribute
b) Method
c) String
d) None of these

Answer: Method
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Question: ________class of Java does not provide any method to
reverse a string.

a) Attribute
b) Method
c) String
d) None of these

Answer: String

Question: Java library also provides class in java.util package.
a) Data
b) String
c) Time
d) Date

Answer: Date

Question: ________class encapsulates both date and time and
represents the value using milliseconds precision.

a) Data
b) String
c) Time
d) Date

Answer: Date

Question: Method_______constructs Date object using current system
time.

a) Date (long elapsed Time)
b) Date()
c) To String()
d) Get Time()

Answer: Date()

Question: Method______constructs Date object using specified time in
milliseconds elapsed since January 1, 1970 GMT.

a) Date (long elapsed Time)
b) Date()
c) To String()
d) Get Time()

Answer: Date (long elapsed Time)

Question: Method String_______returns a string representing date and
time of invoking object.

a) Date (long elapsed Time)
b) Date()
c) To String()
d) Get Time()

Answer: To String()
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Question: Method long_____returns number of milliseconds since
January 1,1970 GMT.

a) Date (long elapsed Time)
b) Date()
c) ToString()
d) Get Time()

Answer: Get Time()

Question: Method void set Time (long elapsed Time) sets new date
and time of an object using elapsed time.

a) Set Time (long elapsed Time)
b) Date()
c) ToString()
d) Get Time()

Answer: Set Time (long elapsed Time)

Question: Like Date class______class is also provided in java.util
package.

a) Data
b) Calendar
c) Time
d) Date

Answer: Calendar

 

Question: ______class can be used to extract calendar information like
year, month, date, hour, minute and second.

a) Data
b) Calendar
c) Time
d) Date

Answer: Calendar

Question: Like get methods, set methods are used to set the value of
the field constants of______class.

a) Data
b) Calendar
c) Time
d) Date

Answer: Calendar

Question: Execution of call 'calendar.set (Calendar.DATE, 20)' will set
the date to________

a) Today's date
b) Yesterday's date
c) 20th
d) None of these

Answer: 20th
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Question: _______the starting index of an array.
a) 0
b) 1
c) Null
d) All of these

Answer: 0

Question: Array elements are stored in_______
a) Sequential memory locations.
b) Scattered memory locations
c) Direct memory locations
d) Random memory locations

Answer: Sequential memory locations.

Question: Identify the incorrect declaration of arrays from the
following.

a) Int a[50];
b) Float values[10] [20];
c) Double a[50];
d) Int score [10, 15];

Answer: Int score [10, 15];

Question: Array is used to represent the following.
a) A list of data items of different data types
b) A list of data items of real data type.
c) A list of data items of same data type..
d) A list of data items of integer data type

Answer: A list of data items of same data type..

Question: Array are passed to a function argument by_______
a) Value
b) Reference
c) Both value and reference
d) None of these

Answer: Reference

Question: An array a[8] will store how many values ?
a) 8
b) 7
c) 9
d) 0

Answer: 8

Question: If an array is declared as a a[10], then its elements will be
stored as_______
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a) a[l] to a[10]
b) a[l] to a[9]
c) a[0] to a[9]
d) a[0] to a[10]

Answer: a[0] to a[9]

Question: The index or subscript value for an array of size n ranges
from

a) 1 to n-1
b) 0 to n-1
c) 1 to n
d) 0 to n

Answer: 0 to n-1

Question: If a static array is not initialized, the elements will be set
to_________

a) 0
b) A float number
c) An undetermined value
d) A character constant

Answer: 0

Question: If 'a' is the object of String class and its content is
"AHMEDABAD", then what is the value of str.length()?

a) 9
b) 10
c) 8
d) 11

Answer: 9

Question: If 'a' is the object of String class and its content is "C IS A
LANGUAGE", then what is the value of str.length()

a) 14
b) 15
c) 12
d) 11

Answer: 15

Question: What type of value is returned when we use get method of
Calender class with constant MONTH ?

a) Char
b) String
c) Int
d) Boolean!

Answer: Int

 

Question: Method to String() returns________data type.
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a) Char
b) String
c) Int
d) Boolean

Answer: String

Question: Method getTime() returns________data type.
a) Long
b) String
c) Void
d) Date

Answer: Long

Question: Method concat(String str) returns______datatype,
a) Long
b) String
c) Void
d) Date

Answer: String

Question: What is the full form of GMT ?
a) Greenwich Median Time
b) Greenwich Mode Time
c) Greenwich Modern Time
d) Greenwich Mean Time

Answer: Greenwich Mean Time

Question: In Java, characters are stored using______bytes.
a) Four
b) Three
c) Two
d) Five

Answer: Two

Question: To save space, if the characters are________an array of bytes
should be used instead of array of characters.

a) ASCII
b) Coded
c) ACSII
d) ACIIS

Answer: ASCII

Question: A_______can be used with array of bytes as an argument.
a) Method
b) Destructor
c) Variable
d) Constructor
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Answer: Constructor

Question: When two String objects are created using same string
literals, memory space is not allocated for_______object.

a) First
b) Second
c) Both (A) and (B)
d) None of these

Answer: Second

Question: Separate memory is allocated when string objects are
created using_______operator even if strings are identical.

a) New
b) new
c) int
d) Float

Answer: new

Question: Method boolean equals(String str) returns_______if invoking
string is same as str.

a) True
b) False
c) Can't say
d) None of these

Answer: True

 

Question: A_____contains both data and program code (functions
referred to as methods).

a) Function
b) Class
c) Attribute
d) Code

Answer: Class

Question: When the class is executed, the______method is called and
the application runs as a normal program.

a) Main
b) Sub
c) Super
d) Super Main

Answer: Main

Question: In earlier programs no data______were used.
a) Codes
b) Classes
c) Members
d) Applications
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Answer: Members

Question: While it is possible to use only a single class in
a______project, this is not a good practice for large applications.

a) Java
b) C++
c) PHP
d) C

Answer: Java

Question: When designing software, the entire_____should be divided
into simpler components that perform logically related tasks.

a) Code
b) Class
c) Program
d) Application

Answer: Application

Question: For each above mentioned component or module,
a_____can be created.

a) Function
b) Class
c) Attribute
d) Code

Answer: Class

Question: When a program contains two or more classes, only one
class can cantain the_____method.

a) Main()
b) Major
c) Main()
d) Minor

Answer: Main()

Question: What is SciTE editor ?
a) SCintilla based Text Editor
b) Scientific based Text Editor
c) Sourceful Text Editor
d) Syntax Text Editor

Answer: SCintilla based Text Editor

Question: A class is a template for multiple objects with similar
features.

a) Function
b) Class
c) Attribute
d) Code
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Answer: Class

Question: ________embody all the features of a particular set of
objects.

a) Codes
b) Classes
c) Members
d) Applications

Answer: Classes

Question: For example, class 'Room' is a______for all rooms with their
common properties.

a) Pattern
b) Protocol
c) Template
d) Model

Answer: Template

Question: In Java, a class is defined using_____keyword.
a) Public
b) Class
c) Class
d) Void

Answer: Class

Question: Every class the programmer writes in Java is generally
made up of____components.

a) Four
b) Three
c) Two
d) One

Answer: Two

Question: ______and behavior are the components of every class.
a) Properties
b) Mannerism
c) Patterns
d) Attributes

Answer: Attributes

Question: ________are defined by variables in a class.
a) Properties
b) Mannerism
c) Patterns
d) Attributes

Answer: Attributes



13/09/2022, 20:03 CBSE Class 12 Computer Science Classes and Objects In Java MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-classes-and-objects-java-mcqs-set-312647.html 26/32

Question: _______is defined by methods in a class.
a) Behavior
b) Mannerism
c) Patterns
d) Properties

Answer: Behavior

Question: ______are used to access or modify attributes.
a) Behavior
b) Methods
c) Modifiers
d) Attributes

Answer: Methods

Question: ______means a reference variable name of type class.
a) Instantiation
b) Initialization
c) Declaration
d) Modification

Answer: Declaration

Question: A______is declared with syntax.
a) Instantiation
b) Initialization
c) Declaration
d) Modification

Answer: Declaration

Question: _______means creating the object by allocating the memory.
a) Instantiation
b) Initialization
c) Declaration
d) Modification

Answer: Instantiation

Question: Keyword______is used to create the object by allocating
memory.

a) Old
b) old
c) New
d) new

Answer: new

Question: ______means to initialize the newly created object.
a) Initialization
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b) Instantiation
c) Declaration
d) Modification

Answer: Initialization

Question: A______is called to initialize the newly created object.
a) Variable
b) Constructor
c) Class
d) Method

Answer: Constructor

Question: A______is a special type of method.
a) Variable
b) Constructor
c) Class
d) Method

Answer: Constructor

Question: In Java, a class is a______
a) Brand
b) Kind
c) Type
d) Form

Answer: Type

Question: In Java, the______examples are int and Boolean.
a) Brand types
b) Form types
c) Built-in types
d) None of these

Answer: Built-in types

Question: A_______can be used to specify the type of a variable in a
declaration statement, the type of a formal parameter, or the return
type of a function.

a) Class declaration
b) Class name
c) Class types
d) All of these

Answer: Class name

Question: Declaring a variable does not create a________
a) Object
b) Memory space
c) Class
d) Boolean
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Answer: Object

Question: In Java, no_____can ever store an object.
a) Variable
b) Constructor
c) Class
d) Method

Answer: Variable

Question: A variable declared using class type can only store a_____to
an object.

a) Orientation
b) Position
c) Reference
d) Indication

Answer: Reference
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Question: Variable of class type are also referred to
as________variables.

a) Orientation
b) Position
c) Reference
d) Indication

Answer: Reference

Question: Using________keyword, an object can be created.
a) Int
b) Float
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c) New
d) Real

Answer: New

Question: Operator________allocates the memory for an object and
returns the address of the object for later use.

a) Int
b) Float
c) New
d) Real

Answer: New

 

Question: _________is the address of the memory location where the
object is stored. 

a) Memory
b) Variable
c) Reference
d) None of these

Answer: Reference

Question: There is a special portion of memory called the______where
the objects live.

a) Heap
b) Pile
c) Stack
d) All of these

Answer: Heap

Question: When an object is created, in addition to allocating
memory, a special method called_______is executed to perform initial
task.

a) Function
b) Constructor
c) Class
d) Method

Answer: Constructor

Question: An object can be created of type Room and assign its
address to variable rl as_______

a) rl = new Room();
b) rl = Room() new;
c) rl = Class Room();
d) None of these

Answer: rl = new Room();
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Question: With empty parentheses without arguments, a
default______is called.

a) Function
b) Constructor
c) Class
d) Method

Answer: Constructor

Question: A______initializes the attributes (variables) of the object
using default values.

a) Function
b) Constructor
c) Class
d) Method

Answer: Constructor

Question: The______can contain arguments that determine the initial
values of variables.

a) Room
b) Brackets
c) Parentheses
d) Class

Answer: Parentheses

Question: Observe the following Room r2 = new RoomO : - Variable
r2 contains a______or address of memory location where a new object
is created.

a) Memory
b) Variable
c) Reference
d) None of these

Answer: Reference

Question: The class determines only the_______of the variables.
a) Types
b) Collection
c) Location
d) Set

Answer: Types

Question: The actual________is contained inside the individual objects
and not in the class.

a) Information
b) Data
c) Collection
d) Variables

Answer: Data
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Question: Every______has its own set of data.
a) Class
b) Variable
c) Operator
d) Object

Answer: Object

Question: _______allocated different memory space to hold their data
values.

a) Classes
b) Variables
c) Operators
d) Objects

Answer: Objects

Question: In Java, when______are no more needed, the memory is
claimed back for reuse.

a) Classes
b) Variables
c) Operators
d) Objects

Answer: Objects

Question: Java has a garbage collector that looks for
unused______and reclaims the memory that those objects are using.

a) Objects
b) Variables
c) Cells
d) Memory spaces

Answer: Objects

Question: In Java, there is no requirement to do any explicit freeing
of______

a) Cells
b) Variables
c) Memory
d) Class

Answer: Memory

Question: In Object-oriented programming (OOP) languages,
creating an object is also called______instantiation.

a) Class
b) Object
c) Inheritance
d) Polymorphism

Answer: Object
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Question: An______for an object is created by allocating memory to
store data for that object.

a) Instance
b) Example
c) Illustration
d) None of these

Answer: Instance

 

Question: An object that belongs to a_____is said to be an instance of
that class.

a) Cells
b) Variables
c) Memory
d) Class

Answer: Class

Question: An________of a class is another word for an actual object.
a) Instance
b) Example
c) Memory
d) None of these

Answer: Instance

Question: _______is an abstract representation of an object, whereas
an instance is its concrete representation.

a) Cells
b) Variables
c) Memory
d) Class

Answer: Class

Question: The terms instance and object are often used
interchangeably in______languages.

a) Programming
b) OOP
c) All
d) None of these

Answer: OOP

Question: Each______of a class can hold different values for its
attributes in variables declared in a class.

a) Instance
b) Example
c) Illustration
d) None of these

Answer: Instance
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Question: ______variables are created at the time of creating an object
and stay throughout the life of the object.

a) Program
b) Instance
c) Inherited
d) Duplicate

Answer: Instance

Question: ______variables define the attributes of an object.
a) Program
b) Instance
c) Inherited
d) Duplicate

Answer: Instance

Question: The______defines the kind of attribute.
a) Program
b) Variables
c) Property
d) Class

Answer: Class

Question: Each_____stores its own value for that attributes.
a) Program
b) Instance
c) Inherited
d) Duplicate

Answer: Instance

Question: To define an object's behaviour_______are created.
a) Instances
b) Programs
c) Methods
d) Functions

Answer: Methods

 

Question: In Java_____can be defined inside a class only.
a) Instances
b) Programs
c) Methods
d) Functions

Answer: Methods

Question: The_______can be invoked using the objects to access or
modify the instance variables.
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a) Instances
b) Programs
c) Methods
d) Functions

Answer: Methods

Question: The____invoked using the objects are known as instance
methods.

a) Instances
b) Programs
c) Methods
d) Functions

Answer: Methods

Question: ______methods are used to define behaviour of an object.
a) Program
b) Instance
c) Inherited
d) Duplicate

Answer: Instance

Question: Invoking a______is to ask the object to perform some task.
a) Instance
b) Program
c) Method
d) Function

Answer: Method

Question: Objects are created with the_____keyword.
a) new
b) New
c) NEW
d) nEW

Answer: new

Question: The______keyword returns a reference to an object that
represents an instance of the class.

a) new
b) New
c) NEW
d) nEW

Answer: new

Question: All instances of class are allocated memory in data
structure called_______

a) Pile
b) Heap
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c) Mound
d) New

Answer: Heap

Question: Each object______has its own set of data.
a) Example
b) Instance
c) Function
d) Method

Answer: Instance

Question: Instance variables and instance methods are accessed
via_______

a) Classes
b) Variables
c) Operators
d) Objects

Answer: Objects

Question: Objects can be referred by using_____operator.
a) Colon (:)
b) Underscore(_)
c) Dot (.)
d) Angle Bracket(<)

Answer: Dot (.)

Question: The_____is an operator.
a) Colon (:)
b) Underscore(_)
c) Dot (.)
d) Angle Bracket(<)

Answer: Dot (.)

Question: Associatively of______operator is from left to right.
a) Colon (:)
b) Underscore(_)
c) Dot (.)
d) Angle Bracket(<)

Answer: Dot (.)

Question: Protection of data is possible with the use of access______
a) Modifiers
b) Operators
c) Methods
d) None of these

Answer: Modifiers
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Question: When the instance variables are referred within the
methods of the same class, there is no need to use______operator.

a) Colon (:)
b) Underscore(_)
c) Dot (.)
d) Angle Bracket(<)

Answer: Dot (.)

Question: When the programmer declares an object_______object is
not created.

a) Class
b) Variable
c) Operator
d) Method

Answer: Class

Question: Reference variable does not refer to any object and its
initial value is_____by default.

a) Zero
b) One
c) Null
d) Minus one

Answer: Null

Question: Use of null reference or null pointer is illegal and may raise
an_______

a) Exception
b) Negative value
c) Reference value
d) None of these

Answer: Exception

Question: Referring instance variable or invoking method with null
reference will give an______

a) Example
b) Error
c) Mistake
d) Inaccurate result

Answer: Error

Question: The following code is_______System.out.println(rl.length);
a) Legal
b) Illegal
c) Both (A) and (B)
d) None of these

Answer: Illegal
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Question: When an object is created using new keyword, memory is
allocated from_______area to store the value of its attributes.

a) Pile
b) Heap
c) Mound
d) New

Answer: Heap

Question: Every object has its own______variables occupying different
space in memory.

a) Example
b) Instance
c) Function
d) Method

Answer: Instance

Question: To store the value, it requires only one______per class.
a) Class
b) Variable
c) Operator
d) Method

Answer: Variable

Question: Variables can be declared within a class
using_______keyword before data type.

a) Public
b) New
c) Static
d) PrintIn

Answer: Static

Question: variables are called class variables.
a) Public
b) New
c) Static
d) Private

Answer: Static

Question: Values of instance variables are stored in______(memory
allocated for the object).

a) Memory
b) Instance
c) Property
d) Method

Answer: Instance
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Question: Values of_____variables are stored in class itself.
a) Class
b) Variable
c) Operator
d) Method

Answer: Class

Question: _______variables can be accessed without creating an
instance of a class.

a) Public
b) New
c) Static
d) Private

Answer: Static

Question: Just like class variable, class_______can be defined using
static keyword in front of the method definition.

a) Class
b) Variable
c) Operator
d) Method

Answer: Method

Question: ________variables and class methods can be accessed
outside the class.

a) Class
b) Variable
c) Operator
d) Method

Answer: Class

 
Question: If the requirement is there that private data has to be
modified by others, then___methods have to be written.

a) Accessor
b) Mutator
c) Restricted
d) Prefixed

Answer: Mutator

Question: Conventionally, naming of accessor and mutator methods
is to capitalize the first letter of variable name and then prepend the
variable name with the prefixes______respectively.

a) Set and get
b) Get and setter
c) Getter and set
d) Get and set
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Answer: Get and set

Question: methods are also known as "getter".
a) Accessor
b) Mutator
c) Restricted
d) Prefixed

Answer: Accessor

Question: ______methods are also known as "setter".
a) Accessor
b) Mutator
c) Restricted
d) Prefixed

Answer: Mutator

Question: _______methods should be used to allow other methods to
read only the data value.

a) Get
b) Set
c) Getter
d) Setter

Answer: Getter

Question: _____methods should be used to allow other methods to
modify the data value.

a) Get
b) Set
c) Getter
d) Setter

Answer: Setter

Question: Just like variables of primitive data types and available
built-in data types, objects can also be passed as_______in a method.

a) Parameters
b) Limit
c) Protocols
d) None of these

Answer: Parameters

Question: ______of primitive types are passed by value.
a) Parameters
b) Limit
c) Protocols
d) None of these

Answer: Parameters
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Question: The values of actual______are copied to formal parameters
and then function is executed.

a) Parameters
b) Limit
c) Protocols
d) None of these

Answer: Parameters

Question: Object parameters are passed by_______
a) Memory value
b) Memory reference
c) Variable value
d) Reference

Answer: Reference

Question: An address (and not value) of the actual_______is copied to
formal parameter.

a) Protocol
b) Parameter
c) Value
d) All of these

Answer: Parameter

Question: Object-oriented programming languages provide
reusability feature using_______

a) Polymorphism
b) Parameters
c) Inheritance
d) All of these

Answer: Inheritance

Question: ______allows us to build new class with added capabilities
by extending existing class.

a) Polymorphism
b) Parameters
c) Inheritance
d) All of these

Answer: Inheritance

Question: Inheritance models______relationship between two classes.
a) 'is-a'
b) 'its-a'
c) 'has-a'
d) 'is-at'

Answer: 'is-a'
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Question: _____class is also referred to as super class or base class.
a) Child
b) Parent
c) Sub
d) None of these

Answer: Parent

Question: In the same way; child class is also referred to
as_____derived class or extended class.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

Question: Whenever two classes have_______relationship, inheritance
is used.

a) 'is-a'
b) 'its-a'
c) 'has-a'
d) 'is-at'

Answer: 'is-a'

Question: A________inherits all instance variables and methods from
super class and it may have its own added variables and methods.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

Question: Constructors are not inherited in_______
a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

Question: ______inherits all methods of super class and it may have
additional methods.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class
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Question: A sub class is not a subset of______In fact, sub class usually
contains more information and methods than its super class.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Super class

Question: When an object of_____is instantiated, memory is allocated
for all its attributes including inherited ones.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

Question: In Java, to create a sub class, keyword '_____' is used in the
class definition.

a) Extends
b) Int
c) Float
d) Create

Answer: Extends

Question: If the visibility of instance variables of_______is changed to
private, the variables are not directly accessible outside the class.

a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Super class

Question: _______members are directly available only in the class in
which they are defined and nowhere else.

a) Public
b) Private
c) Protected
d) Packaged

Answer: Private

Question: _______members are available as 'private' members in the
inherited sub class.

a) Public
b) Private
c) Protected
d) Packaged
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Answer: Protected

Question: Java does not support multiple_______
a) Polymorphism
b) Parameters
c) Inheritance
d) All of these

Answer: Inheritance

Question: A sub class can be derived from only one_______
a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

Question: Which of the following defines attributes and methods ?
a) Class
b) Object
c) Instance
d) Variable

Answer: Class

Question: Which of the following keyword is used to declare Class
variables and class methods ?

a) Static
b) Private
c) Public
d) Package

Answer: Static

 

Question: Which of the following operator creates an object and
returns its reference ?

a) Dot (.)
b) New
c) Colon (:)
d) Assignment (=)

Answer: New

Question: Which of the following method can be called without
creating an instance of a class ?

a) Instance method
b) Class method
c) Constructor method
d) All of the above

Answer: Class method
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Question: Which of the following refers more than one method
having same name but different parameters ?

a) Overloaded methods
b) Overridden methods
c) Duplicate methods
d) All of the above

Answer: Overloaded methods

Question: Which method is invoked automatically with creation of an
object ?

a) Instance method
b) Constructor
c) Class method
d) All of the above

Answer: Constructor

Question: Which of the following is the keyword used to refer a
superclass constructor in sub class constructor ?

a) Extends
b) Super
c) Name of the superclass
d) New

Answer: Extends

Question: Which of the following is used to invoke an instance
method in Java ?

a) The name of the object, colon(:) and the name of the method
b) The name of the object, dot(.) and the name of the method
c) The name of the class, colon(:) and the name of the method
d) The name of the class, dot(.) and the name of the method

Answer: The name of the object, dot(.) and the name of the method

Question: _______members are directly available only in the class in
which they are defined and nowhere else.

a) Public
b) Private
c) Protected
d) Packaged

Answer: Private

Question: _______members are available as 'private' members in the
inherited sub class.

a) Public
b) Private
c) Protected
d) Packaged
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Answer: Protected

Question: Java does not support multiple__________
a) Polymorphism
b) Parameters
c) Inheritance
d) All of these

Answer: Inheritance

Question: A sub class can be derived from only one_________
a) Inherited Class
b) Parent Class
c) Sub Class
d) Super class

Answer: Sub Class

 

Question: ________methods are global to the class itself and available
to any other classes or objects.

a) Class
b) Variable
c) Operator
d) Method

Answer: Class

Question: Class methods can be used anywhere regardless of
whether an_______of the class exists or not.

a) Example
b) Instance
c) Illustration
d) Method

Answer: Instance

Question: The methods that operate on a particular object, or affect
that object, should be defined as_____methods.

a) Example
b) Instance
c) Illustration
d) Method

Answer: Instance

Question: _______that provide some general utility but do not directly
affect an instance of the class are better declared as class methods.

a) Methods
b) Functions
c) Instances
d) Examples
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Answer: Methods

Question: The designers of Java have already provided a large
number of______classes with such class methods.

a) Programmed
b) Internal
c) Built-in
d) Built-out

Answer: Built-in

Question: The______definitions in the source code specify the things
that are part of the class itself.

a) Public
b) Non-static
c) Static
d) Private

Answer: Static

Question: The______definitions in the source code specify the things
that will become part of every instance object belonging to a class.

a) Public
b) Non-static
c) Static
d) Private

Answer: Non-static

Question: Class variables and class methods can be accessed using a
class name or_____variable.

a) Reference
b) Instance
c) New
d) Private

Answer: Reference

Question: Class variables and class methods can be accessed
from_____methods also.

a) Reference
b) Instance
c) New
d) Private

Answer: Instance

Question: Instance variables and______methods can't be accessed
from class methods, as class methods do not belong to any object.

a) Reference
b) Instance
c) New
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d) Private

Answer: Instance

Question: Variables defined inside methods or blocks are
called_____variables.

a) Public
b) Global
c) Private
d) Local

Answer: Local

Question: Formal parameters of the methods are also______variables.
a) Public
b) Global
c) Private
d) Local

Answer: Local

Question: _______variables are not initialized by default values.
a) Public
b) Global
c) Private
d) Local

Answer: Local

Question: ________variables are variables defined within a class but
outside any method.

a) Instance
b) Private
c) Local
d) Global

Answer: Instance

Question: ________variables are allocated memory from heap area
when an object is instantiated (created).

a) Class
b) Instance
c) Local
d) Global

Answer: Instance

Question: _______variables are initialized by default values.
a) Class
b) Instance
c) Local
d) Global
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Answer: Instance

Question: _______variables are variables defined within a class, outside
any method, with the static keyword.

a) Class
b) Instance
c) Local
d) Global

Answer: Class

Question: _______variables are allocated memory only once per class
and is shared by all its objects.

a) Class
b) Instance
c) Local
d) Global

Answer: Class

Question: ______variables are initialized with default values.
a) Class
b) Instance
c) Local
d) Global

Answer: Class

Question: _____requires the use of constructors.
a) Declaration
b) Instantiation
c) Initialization
d) Inheritance

Answer: Initialization

Question: The word________means "many forms"; different forms of
methods with same name. 

a) Declaration
b) Instantiation
c) Polymorphism
d) Inheritance

Answer: Polymorphism

Question: In Java, there can be different methods that have the same
name but different_________

a) Variables
b) Declarations
c) Programs
d) Signature
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Answer: Signature

Question: The above feature of Java is called________
a) Method Overloading
b) Method Offloading
c) Variable Overloading
d) Program Overloading

Answer: Method Overloading

Question: The methods______is a combination of the method name,
the type of return value (object or base type), a list of parameters.

a) Variables
b) Declarations
c) Programs
d) Signature

Answer: Signature

Question: The example given below is an example of : static int
max(int x, int y) {...} static int max(int x, int y, int z) {...} static double
max(double x, double y, double z)

a) Method Overloading
b) Method Offloading
c) Variable Overloading
d) Program Overloading

Answer: Method Overloading

Question: _______is a special kind of method that is invoked when a
new object is created.

a) Destructor
b) Constructor
c) Invoker
d) Creator

Answer: Constructor

Question: can perform any action; but it is mainly designed to
perform initializing actions.

a) Destructor
b) Constructor
c) Invoker
d) Creator

Answer: Constructor

Question: Every class is having its default constructor; sometimes
referred to as no-argument________

a) Destructor
b) Constructor
c) Invoker
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d) Creator

Answer: Constructor

Question: Default_____does not take any argument.
a) Destructor
b) Invoker
c) Constructor
d) Creator

Answer: Constructor

Question: ________initializes the attributes of a newly created object
using default values based on their data types.

a) Destructor
b) Invoker
c) Constructor
d) Creator

Answer: Constructor

 

Question: Constructor must have the same______as class name.
a) Name
b) Style
c) Format
d) Arrangement

Answer: Name

Question: Constructor user not have______type.
a) Data
b) Return
c) Operator
d) All of these

Answer: Return

Question: Constructor is invoked implicitly only when an object is
constructed using______operator.

a) new
b) New
c) NEW
d) nEW

Answer: new

Question: ______cannot be invoked explicitly elsewhere in the
program.

a) Destructor
b) Invoker
c) Constructor
d) Creator
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Answer: Constructor

Question: Like other methods, constructor can also be overloaded.
a) Destructor
b) Invoker
c) Constructor
d) Creator

Answer: Constructor

Question: In absence of______constructors in a class, objects are
constructed using default no-arument constructor.

a) Denned
b) User-defined
c) Built in
d) Ready-made

Answer: User-defined

Question: A no-argument______initializes the attributes using default
values.

a) Destructor
b) Invoker
c) Constructor
d) Creator

Answer: Constructor

Question: The syntax of a no-argument constructor is_______
a)[]
b){ };
c)( ) { }
d)( ) { };

Answer: ( ) { };

Question: _______control is about controlling visibility.
a) Access
b) Modifier
c) Visibility
d) Entrance

Answer: Access

Question: _______modifiers are also known as visibility modifiers.
a) Access
b) Modifier
c) Visibility
d) Entrance

Answer: Access
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Question: If a method or variable is visible to another class, then only
it can be referred in another_______

a) Class
b) Method
c) Program
d) Application

Answer: Class

Question: The Four P's of protection are
a) Public
b) Package (default protection)
c) Protected and Private
d) All of these

Answer: All of these

Question: ________modifiers public, protected and private are used
before the type of variable or method.

a) Access
b) Modifier
c) Visibility
d) Entrance

Answer: Access

Question: ________is used to organize classes.
a) Public
b) Package
c) Protected
d) Private

Answer: Package

Question: _______statement should be added as the first non-
comment or non-blank line in the source file.

a) Public
b) Package
c) Protected
d) Private

Answer: Package

Question: When a file does not have package statement, the classes
defined in the file are placed in_______package.

a) Public
b) File
c) Default
d) Private

Answer: Default
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Question: Package statement has_______syntax.
a) Package < packageName>;
b) Package < packageName>
c) Package < Name>;
d) Package packageName;

Answer: Package < packageName>;

Question: Any_______or variable is visible to the class in which it is
defined.

a) Data type
b) Method
c) File
d) Information

Answer: Method

Question: To provide_______access, use access modifier public before
type of variable or method.

a) Public
b) File
c) Default
d) Private

Answer: Public

Question: ________keyword has been used with main() method to
make it available to everyone.

a) Public
b) File
c) Default
d) Private

Answer: Public

Question: ________keyword is used to allow the access only to sub
classes or to share with the methods declared as "friend".

a) Public
b) Private
c) Protected
d) Default

Answer: Protected

Question: Use of______protection becomes more relevant when
inheritance concept is used in object-oriented programming.

a) Public
b) Private
c) Protected
d) Default

Answer: Protected
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Question: Highest level of protection can be achieved by using
"_______" protection level.

a) Public
b) Private
c) Protected
d) Default

Answer: Private

Question: _______provides the narrowest visibility.
a) Public
b) Private
c) Protected
d) Default

Answer: Private

Question: The________methods and variables are directly accessible
only by the methods defined within a class.

a) Public
b) Private
c) Protected
d) Default

Answer: Private

Question: ______methods may seem extremely restrictive, but it is, in
fact, a commonly used level of protection.

a) Public
b) Private
c) Protected
d) Default

Answer: Private

Question: Private provides_____encapsulation; hiding data from the
world's sight and limiting its manipulation.

a) Information
b) Variable
c) Data
d) Data type

Answer: Data

Question: Anything that shouldn't be directly shared with anyone
including its sub class is_______

a) Public
b) Private
c) Protected
d) Default

Answer: Private
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Question: When access to data is restricted by declaring them
as________the purpose is to protect them from getting directly
accessed or modified by methods of other class.

a) Public
b) Default
c) Protected
d) Private

Answer: Private

Question: If the requirement is there that private data has to be used
by others, then_______methods have to be written.

a) Accessor
b) Mutator
c) Restricted
d) Prefixed

Answer: Accessor
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Question: Which of the following element is used to create an HTML
form ?

a) Text area
b) Form
c) Select and Option
d) Input

Answer: Form

 
Question: Which of the following is the tag used to implement form
element ?

a) <frm>... </frm>
b) </form>...</form>
c) <form>... <form>
d) <form>...</form>

Answer:  <form>...</form>

 

Question: Which of the following attribute of form is used to specify
where to send the form data when the form is submitted ?

a) Method
b) Action
c) Submit
d) Input

Answer: Action

 
Question: Which of the following attribute of form specifies the
HTTP method to be used when sending the data ?

a) Submit
b) Action
c) Method
d) Input

Answer: Method

Question: Which of the following method allows only a limited
amount of information to be seen at a time ?

a) GET
b) POST
c) SET
d) PUT

Answer: GET

 
Question: Which of the following values are used by method
attribute ?

a) GET and POST
b) GET and SET
c) GET and PUT
d) SET and POST

Answer: GET and POST
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Question: Which of the following method sends the data as a block
through the HTTP transaction ?

a) GET
b) SET
c) PUT
d) POST

Answer: POST

 
Question: Which of the following attribute of the input element
specifies the field that is to be created in the form ?

a) Input
b) Type
c) Name
d) Value

Answer: Type

 
Question: Which of the following element allow^ multi-line text
input ?

a) Text area
b) Input
c) Select and Option
d) Form

Answer: Text area

 
Question: Which of the following element is used to create a drop
down list or menu in a form ?

a) Input
b) Text area
c) Select
d) Form

Answer: Select

 
Question: Which of the following is a free open source web
development IDE ?

a) HTML
b) KompoZer
c) S Cite
d) Base

Answer: KompoZer

 
Question: Which of the following stands for "WYSIWYG" ?

a) When You See Is When You Get
b) What You See Is When You Get
c) What You See Is What You Get
d) When You See Is What You Get

Answer: What You See Is What You Get
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Question: Whose increase in the use has resulted in many activities
becoming online ?

a) Internet
b) Mobile
c) GPS
d) Social Networking

Answer: Internet

 

Question: What is used to fill information about various product ? 
a) Server Page
b) Home Page
c) Web Page
d) Master Page

Answer: Web Page

 
Question: What is used to help the visitors of the website to input
data ?

a) Table
b) Form
c) Database
d) File

Answer: Form

 
Question: What is well organized structure designed to input the
required data and information of website is called ?

a) Database
b) Table
c) Form
d) Report

Answer: Form

 
Question: Which of the following option is true with respect to form
?

a) Required information are filled in the form
b) Well organized input of information is done using form
c) Form contains well organized structure.
d) NONE OF THESE

Answer: NONE OF THESE

 
Question: The method of adding information in the form of the web
page is similar to which type of form?

a) Printed form
b) Hand written form
c) Online form
d) Offline form

Answer: Printed form
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Question: What does the form allow ?

a) Interactivity
b) Control in data entry
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

 
Question: What is form ?

a) Source Code
b) Object
c) Container
d) Edit

Answer: Container

 
Question: From the list given below what is used to collect different
kinds of inputs from the user ?

a) Table
b) Report
c) Form
d) Query

Answer: Form

 
Question: Which of the following element does the form contain ?

a) Label, Check box
b) Text input field, Radio button
c) Submit button, Reset button
d) All of these

Answer: All of these

 
Question: What is the use of various element of form ?

a) Enter the data
b) Validate the data
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

 
Question: Using which of the following a form can be designed easily
?

a) HTML
b) Word Pad
c) XML
d) Form Liner

Answer: HTML

 
Question: What is the full form of HTML ?

a) Hyper Text Manage Language
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b) Hyper Text Markup Language
c) Hyper Text Marker Language
d) Hyper Text Marking Language

Answer: Hyper Text Markup Language

 
Question: How many parts are elements of form divided into?

a) Two
b) Three
c) Four
d) Five

Answer: Four

 
Question: Which from the given below are the elements of form ?

a) Form, Input
b) Text area
c) Select and Option
d) All of these

Answer: All of these

 
Question: Which container is used to collect different kinds of inputs
from the user ?

a) Table
b) Form
c) Report
d) Query

Answer: Form

 
Question: Which element is used to create an HTML form?

a) Form
b) Frm
c) Frmsrc
d) Formset

Answer: Form

 

Question: What acts as a container for all the elements used in the
form ?

a) Table
b) Report
c) Form
d) Frame

Answer: Form

 

Question: Which of the following is the tag used to implement form
element ?

a) <frm>... </frm>
b) </form>...</form>
c) <form>... <form>
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d) <form>...</form>

Answer:  <form>...</form>

 

Question: Which from the given below shows the example of use of
the form element ?

a) Input elements
b) Input-elements
c) Input elements
d) Input elements

Answer: Input elements

 

Question: How many attributes does form tag have ?
a) Two
b) Three
c) Four
d) Five

Answer: Two

Question: Which of the given below are the attributes of the form
tag ?

a) Action
b) Method
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: Which attribute of form element is used to specify where
to send the form data when the form is submitted ?

a) Method
b) Action
c) (A) or (B)
d) None of these

Answer: Action

Question: Which attribute of tag is used to control the processes
executing after the form is submitted ?

a) Action
b) Method
c) (A) or (B)
d) None of these

Answer: Action

Question: What does action attribute take as value ?
a) Website name
b) Name of web server
c) File name
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d) Name of folder

Answer: File name

 

Question: After filling the data in the form, the file specified in action
attribute is opened when the user clicks on which button ?

a) Finish button
b) OK button
c) Reset button
d) Submit button

Answer: Submit button

Question: Which attribute of form element specifies the HTTP
method to be used when sending the data ?

a) Action
b) Method
c) (A) or (B)
d) None of these

Answer: Method

Question: What is the full form of HTTP ?
a) Hyper Text Taged Protocol
b) Hyper Text Timeline Protocol
c) Hyper Text Transfer Protocol
d) Hyper Text Terminal Protocol

Answer: Hyper Text Transfer Protocol

Question: Which attribute decides how to submit the information of
form on specified address ?

a) Method
b) Action
c) (A) or (B)
d) None of these

Answer: Method

Question: How many values can method attribute of form element
take ?

a) Two
b) Three
c) Four
d) Five

Answer: Two

Question: Which values can method attribute of form element take ?
a) HTML, HTTP
b) Get, Post
c) Action, Method
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d) Any of these

Answer: Get, Post

Question: Which is the default value of method attribute of form
element ?

a) Get
b) Post
c) Action
d) (A) or (B)

Answer: Get

Question: Which value of method attribute adds the retrieved data
from the form to the end of URL and sends to the server ?

a) Post
b) Get
c) Action
d) All of these

Answer: Get

Question: What is the full form of URL ?
a) Uniform Redefine Locator
b) Uniform Rearrange Locator
c) Uniform Reform Locator
d) Uniform Resource Locator

Answer: Uniform Resource Locator

Question: Which of the following shows the use of action attribute ?
a) To specify the address where the information has to be sent when form is submitted.
b) To specify the specifications of HTTP
c) Both (A) and (B)
d) None of these

Answer: To specify the address where the information has to be sent when form is submitted.

Question: Which value of method attribute provides facility of
sending limited information at one time ?

a) Get
b) Post
c) Action
d) (A) or (B)

Answer: Get

Question: Which value of method attribute sends information in
form of blocks using HTTP transaction ?

a) Post
b) Get
c) Action
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d) All of these

Answer: Post

Question: Which of the following term provides facility of sending
information in form of blocks using HTTP transaction ?

a) Get
b) Action
c) Post
d) Any of these

Answer: Post

Question: Which of the following specifies the use of method
attribute ?

a) Specifies the address where the information has to be sent after submitting the form.
b) Specifies the HTTP method.
c) Both (A) and (B)
d) None of these

Answer: Specifies the HTTP method.

Question: Which value of method attribute sends information in the
form of request ?

a) Get
b) Post
c) Action
d) (A) or (B)

Answer: Post

Question: Which value of method attribute does not have any
restriction of length of information ?

a) Post
b) Get
c) Action
d) All of these

Answer: Post

Question: Which elements are used in form ?
a) Input objects
b) Output objects
c) Process objects
d) All of these

Answer: Input objects

Question: Which of the given below is an example of Input element ?
a) Text box, Password
b) Radio button, Check box
c) Submit button, Reset button
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d) All of these

Answer: All of these

Question: Which tag is used to implement input element in the form
?

a) <input>
b) <input>….</input>
c) (A) or (B)
d) None of these

Answer: (A) or (B)

Question: Which attribute is used along with <input> tag ?
a) Type
b) Name
c) Value
d) All of these

Answer: All of these

Question: Which attribute of the input element specifies the Held
that is to be created in the form?

a) Type
b) Name
c) Value
d) All of these

Answer: Type

Question: What is the use of type attribute?
a) To specify the field that is to be created.
b) To specify the name to be used for the field,
c) To specify the default value of the field.
d) All of these

Answer: To specify the field that is to be created.

 

Question: Which attribute of the input element specifies the name to
be used for the field in the form?

a) Type
b) Name
c) Value
d) Any of these

Answer: Name

Question: What is the use of name attribute ?
a) To specify the field that is to be created.
b) To specify the name to be used for the field.
c) To specify the default value of the field.
d) All of these
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Answer: To specify the name to be used for the field.

Question: Which attribute of the input element specifies the default
value of the field in the form ?

a) Type
b) Name
c) Value
d) Any of these

Answer: Value

Question: What is the use of value attribute ?
a) To specify the field that is to be created
b) To specify the name to be used for the field
c) To specify the default value of the field
d) All of these

Answer: To specify the name to be used for the field

Question: Which are the various input elements that can be created
using type attribute of  <input> tag?

a) Submit button, Reset button
b) Text box
c) Radio button, check box, drop down menu
d) All of these

Answer: All of these

Question: Which input element is used to enter text in the form ?
a) Password
b) Text box
c) Radio button
d) Check box

Answer: Text box

Question: From the given options below, what is the text box used
for ?

a) Title of the web page
b) User's name
c) E-mail address
d) All of these

Answer: All of these

Question: Which element is used to create text box in form ?
a) Text
b) Box
c) Text Box
d) Text Line

Answer: Text
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Question: Which type of data can be entered in the text box ?
a) Text
b) Numeric
c) Symbolic
d) All of these

Answer: All of these

Question: What is the syntax of creating text box in the form ?
a) <input type = text name=var value=txt>
b) <input type = "text" name="var" value="txt">
c) <input type = 'text' name='var' value='txt'>
d) {<input type = "text" name="var" value="txt">}

Answer: <input type = "text" name="var" value="txt">

 

Question: Which element is used to create password field in form ?
a) Password
b) Text box
c) Radio button
d) Check box

Answer: Password

Question: Password field is similar to which of the following ?
a) Drop down menu
b) Text box
c) Radio button
d) Check box

Answer: Text box

Question: Characters are not displayed to the user in which of the
following ?

a) Radio button
b) Checkbox
c) Text box
d) Password

Answer: Password

Question: In which of the following the characters typed are
converted into non readable format ?

a) Password
b) Text box
c) Radio button
d) Check box

Answer: Password
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Question: In which form are the characters typed in the password
field displayed ?

a) Dots
b) Asterisk
c) Square
d) All of these

Answer: All of these

Question: Which of the following does not let any one read the
typed text when user does login ?

a) Password
b) Text box
c) Radio button
d) Check box

Answer: Password

Question: What is the syntax of creating password box in the form ?
a) <input = "password" name="var" > 
b) <input value = "password" name="var" > 
c) <input type = "password" name="var" >
d) <input type = "password" value="var" >

Answer: <input type = "password" name="var" >

Question: What is used to select only one option from the given
many options in the form ?

a) Radio button
b) Check box
c) Text box
d) Password

Answer: Radio button

Question: Which element is used to create radio button in form?
a) Button
b) Radio
c) Button_radio
d) Radio_button

Answer: Radio

Question: How many radio buttons can be selected from many radio
buttons available in a single group ?

a) 1
b) 2
c) 3
d) 4

Answer: 1
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Question: It is possible to select more than one radio button. Select
correct option for this statement ?

a) This statement is true
b) This statement is false
c) We cannot be sure of this statement
d) None of these

Answer: This statement is false

Question: What is the shape of radio button ?
a) Circle
b) Square
c) Triangle
d) Rectangle

Answer: Circle

Question: What appears in the circle of radio button which is
selected ?

a) Line
b) Arrow
c) Dot
d) Tick

Answer: Dot

Question: Generally what is used to select a single item from a given
group of item ?

a) Radio button
b) Checkbox
c) Text box
d) Password

Answer: Radio button

Question: Which attribute is used to display a radio button selected
by default ?

a) Check
b) Select
c) Checked
d) Selected

Answer: Checked

Question: What is true from the following for the checked attribute
of radio button ?

a) Compulsory
b) Optional
c) Sometimes compulsory
d) Sometimes optional

Answer: Optional
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Question: What is the syntax of creating radio button in the form ?
a)<input="radio" name="var" value="txt">
b)<input=" radio" name="var" type=,,txt">
c) <input ="radio" type="var" value="txt">
d)<inputtype="radio" name="var" value="txt">

Answer: <inputtype="radio" name="var" value="txt">

Question: What is used to select only one option from the given
many options in the form ?

a) Radio button
b) Check box
c) Text box
d) Password

Answer: Check box

Question: Which element is used to create check box field in form ?
a) Check box
b) Checkjbox
c) Box
d) Box_check

Answer: Check box

Question: When one radio button is selected than what happens to
the other radio buttons of the same group ?

a) Active
b) Deactivate
c) Special
d) Normal

Answer: Deactivate

 

Question: It is possible to select more than one check box. Select
correct option for this statement ?

a) This statement is true
b) This statement is false
c) We cannot be sure of this statement
d) None of these

Answer: This statement is true

Question: What is the shape of check box ?
a) Circle
b) Square
c) Triangle
d) Rectangle

Answer: Square
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Question: What appears in the square of check box which is selected
?

a) Line
b) Arrow
c) Dot
d) Tick

Answer: Tick

Question: What is used to select a more than one item from a given
group of item ?

a) Radio button
b) Check box
c) Text box
d) Password

Answer: Check box

Question: Which attribute is used to display a check box selected by
default ?

a) Check
b) Select
c) Checked
d) Selected

Answer: Checked

Question: What is true from the following for the checked attribute
of check box ?

a) Compulsory
b) Optional
c) Sometimes compulsory
d) Sometimes optional

Answer: Optional

Question: What is the syntax of creating check box in the form ?
a) <input type = "checkbox" name="var" value="txt">
b) <input name = "checkbox" name="var" value="txt">
c) <input name = "checkbox" type='var' name='txt'> (
d) <input type = "checkbox" value="var" name="txt">

Answer: <input type = "checkbox" name="var" value="txt">

Question: Which button is used to send the values of data entered in
the form ?

a) Send Button
b) Enter Button
c) Submit Button
d) Reset Button

Answer: Submit Button
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Question: Which button is used to send the values of data entered in
the form to the server ?

a) Reset Button
b) Submit Button
c) Enter Button
d) Send Button

Answer: Submit Button

Question: On clicking which button, the values of data entered in the
form is submitted to the file specified in the action attribute of the
form element ?

a) Enter Button
b) Send Button
c) Reset Button
d) Submit Button

Answer: Submit Button

 

Question: What is the syntax of creating submit button in the form ?
a) <input type="submit" value="label">
b) <input ="submit" valuer "label ">
c)  <input value= "submit" type="label">
d) <inputname="submit" value="label">

Answer: <input type="submit" value="label">

Question: On clicking which button, the values of data entered in the
form are cleared and set back to default values ?

a) Send Button
b) Enter Button
c) Submit Button
d) Reset Button

Answer: Reset Button

Question: What is the use of reset button ?
a) Replace the data values entered in the form by its default values.
b) Replace the data values entered in the form by blank spaces.
c) (A) or (B)
d) To change all the values filled in the form with the values present on the web server

Answer: (A) or (B)

Question: The values of data entered in the form are set to which
values when reset button is clicked ?

a) Set back to default value
b) Null
c) New
d) Old

Answer: Set back to default value
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Question: What happens when reset button is clicked ?
a) The values of data entered in the form are cleared.
b) The values of data entered in the form are set back to default values.
c) Both (A) and (B)
d) The values of data entered in the form can be modified.

Answer: Both (A) and (B)

Question: What to the syntax oi creating ies,et YsuWaw vsv the form
?

a) <input=" reset" value="label"> 
b) <input type="reset" value="label">
c) <inputvalue="reset" name="label">
d) <input value="reset" type="label">

Answer: <input type="reset" value="label">

Question: Match the following :
      (A)                                                                          (B)

(1) Radio               (A) The values of data entered in the form is submitted to the file specified in the action
attribute of the form element using it.

(2) Check box        (B) Is used to add any type of data/textual data.

(3) Text                 (C) Is used to select only one options from all the given options.

(4) Password          (D) Similar to Text field, characters typed in it are not displayed.

(5) Submit             (E) Used to setback the values of data entered in the form to default values.

(6) Reset               (F) Is used to select one or more than one options at a time.

a) (1- C),(2 - F), (3 - B), (4 - D), (5 -E), (6 - A)
b) (1- C),(2 - F), (3 - D), (4 - B), (5 - A), (6 - E)
c) (1- C),(2 - F), (3 - B), (4 - A), (5 - D), (6 - E)
d) (D) (1- C),(2 - F), (3 - B), (4 - D), (5 - A), (6 - E)

Answer: (D) (1- C),(2 - F), (3 - B), (4 - D), (5 - A), (6 - E)

Question: Which element allows multi line text input in form ?
a) Text box
b) Text area
c) Text Line
d) Text Object

Answer: Text area

 

Question: Which element is used to implement text area element ?

a) <textarea>.....< / textarea>
b) <text>....</text>
c) </textarea>..</textarea>
d) </text>...<text>

Answer: <textarea>.....< / textarea>
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Question: Which tag is used to create drop down menu in the form
?

a) Drop down
b) Pull down
c) Select
d) List

Answer: Select

Question: What is used when displaying all the options on the
screen is not required ?

a) Radio Button
b) Drop down Menu
c) Check box
d) Text area

Answer: Drop down Menu

Question: Which tag is used to create a drop down menu ?
a) <option>...</option> 
b) <dropdown>...</dropdown>
c) <list>...</list>
d) <select>...</select>

Answer: <select>...</select>

Question: Which element is used to specify the values that are to
be displayed in the menu ?

a) <select>
b) <list>
c) <option>
d) <value>

Answer: <option>
 

Question: Which tag is used to create the elements within the menu
?

a) <option>...</option>
b) <dropdown>...</dropdown>
c) <list>...</list>
d) <select>...</select>

Answer: <option>...</option>

Question: Which attribute is used to display specific option to be
selected by default ?

a) Check
b) Select
c) Checked
d) Selected

Answer: Selected
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Question: What is true from the following for the selected attribute
of radio button ?

a) Compulsory
b) Optional
c) Sometimes compulsory
d) Sometimes optional

Answer: Optional

Question: Which of the following specifies the correct code to create
text area element ?

a) <option> <select value="Ahmedabad"> Ahmedabad </select> <select value="Rajkot"> Rajkot
</select> </option> 
b)  <select> <option type="Ahmedabad"> Ahmedabad </option> <option type="Rajkot"> Rajkot
</option> </select>
c) <select> <option value="Ahmedabad"> Ahmedabad </option> <option value="Rajkot"> Rajkot
</option> </select>
d) <select> <option value="Ahmedabad"> <option value="Rajkot"> </select>

Answer: <select> <option value="Ahmedabad"> Ahmedabad </option> <option value="Rajkot">
Rajkot </option> </select>

Question: How is designing a form using HTML tags ?
a) Tedious
b) Very Easy
c) Motivating
d) All of these

Answer: Tedious

Question: Form can be created easily with which of the following ?
a) IED
b) ILD
c) IDE
d) IDL

Answer: IDE

Question: What is the full form of IDE ?
a) Integrated Database Environment
b) Integrated Development Environment
c) Integrated Document Environment
d) Integrated Declaration Environment

Answer: Integrated Development Environment

Question: What is IDE ?
a) Software application
b) Hardware application
c) Database
d) Source Code

Answer: Software application
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Question: What is true for Integrated Development Environment
(IDE) from the following ?

a) It provides facility to make form easily.
b) It is software application.
c) It provides facility to programmers to make software.
d) All of these

Answer: All of these

Question: Which facility is provided for Integrated Development
Environment (IDE) from the following ?

a) GUI (Graphical User Interface)
b) Text/Code editor
c) Compiler/interpreter, Debugger
d) All of these

Answer: All of these

Question: What is full form of GUI ?
a) Graphical User Interface
b) Graphical Useful Interface
c) Graphical Useful Integration
d) Graphical Universal Interface

Answer: Graphical User Interface

Question: Which is the example of open source IDE from the
following ?

a) KompoZer
b) Eclipse
c) JBuilder, Netbeans
d) All of these

Answer: All of these

Question: Which option is true for KompoZer ?
a) It is IDE software for web development
b) It is free of cost
c) It is open source
d) All of these

Answer: All of these

Question: From which website can KompoZer be downloaded ?
a) http://www.KompoZer.com
b) http://www.KompoZer.net
c) http://www.KompoZer.co.in
d) http://www.KompoZer.org

Answer: http://www.KompoZer.com

http://www.kompozer.com/
http://www.kompozer.net/
http://www.kompozer.co.in/
http://www.kompozer.org/
http://www.kompozer.com/
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Question: What is a simple graphical interface which provides web
page editor in KompoZer ?

a) WYSIWYG
b) WYSIWGY
c) WYSIWGY
d) WYSIYWG

Answer: WYSIWYG

Question: What is full form of WYSIWYG ?
a) What You Saw Is What You Get
b) What You Say Is What You Get
c) What You See Is What You Get
d) What You Said is What You Get

Answer: What You See Is What You Get

Question: How is "What You See Is What You Get (WYSIWYG)"
interface ?

a) What you can see, the same you get in the result.
b) You can see and also modification can be done.
c) In it you can see the result and similar insertion can be done.
d) None of these

Answer: What you can see, the same you get in the result.

Question: Which type of software is KompoZer ?
a) Web Source System
b) Web Database System
c) Web Authoring System
d) Web Development System

Answer: Web Authoring System

Question: What does KompoZer integrate ?
a) Web page development
b) Web file management
c) Web server development
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: How can a web page be created using KompoZer ?
a) Easy
b) Quick
c) Both (A) and (B)
d) Difficult

Answer: Both (A) and (B)

Question: What is used by user to edit a web page ?
a) Database
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b) Source Code
c) Master File
d) Master Code

Answer: Source Code

Question: In KompoZer who gives rapid access to the files on both
local machines and remote servers ?

a) Site Manager
b) Server Manager
c) Source Code Manager
d) Section Manager

Answer: Site Manager

Question: In KompoZer, Site Manager gives rapid access to the files
located on which servers ?

a) Local
b) Remote
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: What can be done to the web pages and associated files
on a remote server from within KompoZer ?

a) Download
b) Upload
c) Both (A) and (B)
d) None of these

Answer: Upload

Question: What is used to support styles in KompoZer ?
a) CSS
b) CSC
c) SCC
d) SCS

Answer: CSS

Question: What is the full form of CSS ?
a) Cascading Section Sheet
b) Cascading Sheet Style
c) Cascading Sheet Section
d) Cascading Style Sheet

Answer: Cascading Style Sheet

Question: Which menu - option is used to open KompoZer ?
a) Applications -> Programming -> KompoZer
b) Applications -> Program -> KompoZer
c) Applications -> Place -> KompoZer
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d) Applications -> System -> KompoZer

Answer: Applications -> Programming -> KompoZer

Question: Under which option is KompoZer displayed ?
a) Accessories
b) Office
c) Programming
d) Graphics

Answer: Programming

Question: Which menu - option is used to view the different toolbars
and status bar ?

a) Show -> Show/Hide
b) View -> Show/Hide
c) Display -» Show/Hide
d) Format -> Show/Hide

Answer: View -> Show/Hide

Question: Which option is listed in Show/Hide option of View menu
in KompoZer ?

a) Composition Toolbar, Edit Mode Toolbar
b) Format Toolbar 1, Format Toolbar 2
c) Status Bar, Sidebar (Site Manager), Rulers
d) All of these

Answer: All of these
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b) Three
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a) Format Toolbar A, Format Toolbar B
b) Format Toolbar I, Format Toolbar II
c) Format Toolbar 1, Format Toolbar 2
d) Format Toolbar i, Format Toolbar ii

Answer: Format Toolbar 1, Format Toolbar 2

Question: How many menus are displayed in the menu bar of
KompoZer ?

a) Six
b) Seven
c) Eight
d) Nine

Answer: Eight

Question: Which menus are displayed in the menu bar of KompoZer
?

a) File, Edit, View
b) Insert, Format, Table
c) Tools, Help
d) All of these

Answer: All of these

Question: How many toolbars are displayed below menu bar ?
a) Two
b) Three
c) Four
d) Five

Answer: Three

Question: Which toolbars are displayed below menu bar ?
a) Composition Toolbar
b) Format Toolbar 1
c) Format Toolbar 2
d) All of these

Answer: All of these

Question: What is the use of composition toolbar ?
a) To create a new file and save it
b) Open a file
c) Publish a website
d) All of these

Answer: All of these

Question: What is the use of Format Toolbar 1 and Format Toolbar 2 ?
a) Format the text
b) Add bullets and numbering
c) Similar formatting option
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d) All of these

Answer: All of these

Question: In KompoZer which toolbar is used to create new file, open
a file, save a file and publish website ?

a) Composition Toolbar
b) Format Toolbar 1, Format Toolbar 2
c) Both (A) and (B)
d) Edit mode Toolbar

Answer: Composition Toolbar

Question: In KompoZer which toolbar is used to format the text,add
bullets and numbering and perform similar formatting operations ?

a) Composition Toolbar
b) Format Toolbar 1, Format Toolbar 2
c) Both (A) and (B)
d) Edit mode Toolbar

Answer: Format Toolbar 1, Format Toolbar 2

 

Question: How many panes are displayed in the center of the
KompoZer window ?

a) Two
b) Three
c) Four
d) Five

Answer: Two

Question: Which panes are displayed in the center of the KompoZer
window ?

a) Site Manager
b) Page pane
c) Both (A) and (B)
d) Page tab

Answer: Both (A) and (B)

Question: In KompoZer, which pane is a powerful tool used to
navigate within the site or between the sites ?

a) Site Manager
b) Page pane
c) Both (A) and (B)
d) Page tab

Answer: Site Manager

Question: Which button is used to close site manager ?
a) Exit Button
b) End Button
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c) Close Button
d) Leave Button

Answer: Close Button

Question: Which key is used to close site manager
a) Function Key F6
b) Function Key F7
c) Function Key F8
d) Function Key F9

Answer: Function Key F9

Question: In KompoZer, what does Page Pane show ?
a) Blank web page
b) Blank untitled web page
c) Web page named untitled
d) All of these

Answer: All of these

Question: Which toolbar is shown at the bottom right side of the
page pane window ?

a) Edit mode Toolbar
b) Format Toolbar 1, Format Toolbar 2
c) Composition Toolbar
d) All of these

Answer: Edit mode Toolbar

Question: How many modes are there in Edit mode toolbar ?
a) Two
b) Three
c) Four
d) Five

Answer: Three

Question: Which modes are there in Edit mode toolbar ?
a) Normal
b) HTML Tags
c) Preview
d) All of these

Answer: All of these

Question: Which facility is provided by Normal HTML Tags and
Preview mode of Edit mode ?

a) Editing
b) Decoration
c) Insertion
d) Help
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Answer: Editing

Question: Which mode of Edit mode toolbar is used to display web
page along with its table outlines ?

a) Normal
b) HTML Tags
c) Preview
d) All of these

Answer: Normal

Question: Normal mode is similar to which mode ?
a) HTML Tags
b) Preview
c) Both (A) and (B)
d) None of these

Answer: Preview

Question: Which mode of Edit mode toolbar is useful for those who
are familiar with HTML ?

a) Preview
b) Normal
c) HTML Tags
d) All of these

Answer: HTML Tags

Question: Which color marker is used to indicate the start tag for all
elements ?

a) Red
b) Yellow
c) Green
d) Blue

Answer: Yellow

Question: What happens on clicking the yellow marker which
indicates the start tag for all elements ?

a) Select and highlights whole of the element (
b) Select and highlights whole sub element
c) Select and highlights program of the element
d) Select and highlights function of the element

Answer: Select and highlights whole of the element 

Question: Which mode of Edit mode toolbar is used to display the
page view as seen in a browser ?

a) Normal
b) HTML Tags
c) Preview
d) All of these
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Answer: Preview

Question: From the given modes below in which mode the script do
not run and therefore their effects will not be seen ?

a) Preview
b) Normal
c) HTML Tags
d) All of these

Answer: Preview

Question: From the given modes below in which mode links do not
operate ?

a) Normal
b) HTML Tags
c) Preview
d) All of these

Answer: Preview

Question: In KompoZer, what does it display ?
a) Page tab
b) Edit mode Toolbar
c) Site Manager
d) Composition Toolbar

Answer: Edit mode Toolbar

Question: How many tabs are displayed on the left side of the page
pane ?

a) Three
b) Four
c) Five
d) Six

Answer: Three

 

Question: Which tab is displayed on the left side of the page pane ?
a) Design
b) Split
c) Source
d) All of these

Answer: All of these

Question: Which tab is used to design the web page ?
a) Design
b) Split
c) Source
d) Any of these

Answer: Design



13/09/2022, 20:04 CBSE Class 12 Computer Science Creating HTML Forms Using KompoZer MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-creating-html-forms-using-kompozer-mcqs-set-f 7/26

Question: Which tab displays the HTML source of the current
element ?

a) Design
b) Split
c) Source
d) All of these

Answer: Split

Question: Which tab shows all details of the HTML code ?
a) Design
b) Split
c) Source
d) Any of these

Answer: Source

Question: Which tab helps in editing the source code ?
a) Design
b) Split
c) Source
d) Any of these

Answer: Source

Question: What is seen in the bottom of the window ?
a) Site Manager
b) Status Bar
c) Page Tab
d) Composition Toolbar

Answer: Status Bar

Question: When any item in page is clicked, where does its structure
appear ?

a) Page Tab
b) Page Area
c) Site Manager
d) Status Bar

Answer: Status Bar

Question: To customize any toolbar,right click on the respective
toolbar and click on which option ?

a) Customize Toolbar
b) Format Toolbar
c) Change Toolbar
d) Edit Toolbar

Answer: Customize Toolbar
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Question: In KompoZer, which menu-option is used to create a new
file ?

a) File —> New
b) Compose —> New
c) Application -> New
d) Define -> New

Answer: File —> New

Question: In KompoZer, New tool button is located on which toolbar
?

a) Composition Toolbar
b) Edit Mode Toolbar
c) Format Toolbar - 1
d) Format Toolbar - 2 180)

Answer: Composition Toolbar

 

Question: Which dialog box appears when File -> New option is
selected in KompoZer ?

a) Create a new document
b) Create a new template
c) Create a new document or template
d) Create a document or template

Answer: Create a new document or template

Question: How many options are displayed in Create a new
document or template dialog box in KompoZer ?

a) Two
b) Three
c) Four
d) Five

Answer: Three

Question: Which options are displayed in Create a document or
template dialog box in KompoZ ?

a) A blank document
b) A new document based on a template
c) A blank template
d) All of these

Answer: All of these

Question: Which options of Create a new document template dialog
box should be selected create a new file in KompoZer ?

a) A blank document
b) A new document based on a template
c) A blank template
d) Any of these

Answer: A blank document
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Question: In KompoZer, which menu-option is used open an existing
file ?

a) File -» Start
b) File -> Open
c) File -> Display
d) File -> View

Answer: File -> Open

Question: In KompoZer, which menu - option is used open a file
which has been recently opened ?

a) File -» Current Pages
b) File -» Latest Pages
c) File -> Recent Pages
d) File —> Fresh Pages

Answer: File -> Recent Pages

Question: In KompoZer,Open tool button is located which toolbar ?
a) Composition Toolbar
b) Edit Mode Toolbar
c) Format Toolbar - 1
d) Format Toolbar -2

Answer: Composition Toolbar

Question: In KompoZer, which menu - option is used create a new
form ?

a) File -» Form —> Define Form
b) Insert -> Form -» Define Form
c) Format -> Form -> Define Form
d) View -» Form -> Define Form

Answer: File -» Form —> Define Form

Question: In KompoZer tool button used to design new form is
located on which toolbar ?

a) Composition Toolbar
b) Edit Mode Toolbar
c) Format Toolbar - 1
d) Format Toolbar -2

Answer: Composition Toolbar

Question: Which dialog box opens when tool button located on
Composition toolbar is clicked ?

a) Form Description
b) Form Properties
c) Form Document
d) Form Template

Answer: Form Properties
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Question: Which option of Form properties dialog box shows added
options for the form when clicked ?

a) More Properties
b) Extra Properties
c) View Properties
d) Add Properties

Answer: More Properties

Question: Which options are displayed beneath Setting of Form
properties dialog box ?

a) Form Name
b) Action URL
c) Method
d) All of these

Answer: All of these

Question: In which option is form name typed in Form properties
dialog box ?

a) Form Name
b) Action URL
c) Method
d) Any of these

Answer: Form Name

Question: In which option of Form properties dialog box is the name
of file entered where the form data has to be submitted ?

a) Form Name
b) Action URL
c) Method
d) Any of these

Answer: Action URL

Question: In which option of Form properties dialog box can GET or
POST method selected ?

a) Form Name
b) Action URL
c) Method
d) Any of these

Answer: Method

Question: On clicking OK button after entering all details in Form
properties dialog box, what is the form named by default ?

a) Untitled
b) New
c) Form
d) Document

Answer: Untitled
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Question: In KompoZer a form is with which color outline by default
?

a) Light Red
b) Light Green
c) Light Yellow
d) Light Blue

Answer: Light Blue

Question: In KompoZer, in Normal view, the forms are shown
surrounded by which colored dotted box ?

a) Black
b) Blue
c) Red
d) Green

Answer: Blue

Question: What can be placed in the form surrounded by dotted blue
box ?

a) Text Box, Text area
b) Radio Button, Check box, Drop Down Menu
c) Submit button, Reset Button
d) All of these

Answer: All of these

Question: Which key is pressed to make space for work in dotted
blue box surrounding form for work ?

a) Enter Key
b) Control Key
c) Page Up/Page Down Key
d) Insert Key

Answer: Enter Key

Question: In KompoZer, which menu-option is used to create a form
label ?

a) Format -» Form -> Define Label
b) Form -^ Insert -> Define Label
c) Insert -> Form -> Define Label
d) View -> Form -> Define Label

Answer: Insert -> Form -> Define Label

Question: What should be placed where form label should appear ?
a) Pointer
b) Cursor
c) Arrow Key
d) Tab Key

Answer: Cursor
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Question: Where should it be clicked to come out of the label field ?
a) Outside field, above or below it
b) Outside field, on left or right side
c) Any place outside field
d) On the field

Answer: Any place outside field

Question: In KompoZer, which menu-option is used to create a input
text field in Form ?

a) View —> Form —> Form Field
b) Insert -> Form -> Form Filed
c) Format -> Form -> Form Field
d) Form -> Insert -> Form Field

Answer: Insert -> Form -> Form Filed

Question: Which input field type options are displayed in Field Type
drop down menu of Form field properties dialog box ?

a) Text, Password, Check Box, Radio Button
b) Submit Button, Reset Button, Button
c) File, Hidden, Image
d) All of these

Answer: All of these

Question: Which properties are displayed when More Properties
option of Form field properties dialog box is clicked ?

a) Field Size
b) Maximum Length
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: Which option of Form field properties dialog box should
be used to show some text before the user actually enters data ?

a) Initial Value
b) Default Value
c) Display Value
d) Form Value

Answer: Initial Value

Question: The value of Field size and Maximum Length properties of
text box are given under which properties ?

a) Text box Properties
b) Field Properties
c) Master Properties
d) Fewer Properties

Answer: Fewer Properties



13/09/2022, 20:04 CBSE Class 12 Computer Science Creating HTML Forms Using KompoZer MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-creating-html-forms-using-kompozer-mcqs-set-f 13/26

Question: In KompoZer, which menu-option is used to insert submit
button in the form ?

a) View -> Form -> Form Field
b) Insert —> Form —> Form Field
c) Format —> Form —> Form Field
d) Edit -> Form -> Form Field

Answer: Insert —> Form —> Form Field

 

Question: What should be the value of Field Value to insert submit
button in the form ?

a) Submit
b) Button
c) Add
d) Send

Answer: Submit

Question: To preview the form Preview tool button of which toolbar
should be clicked ?

a) Edit Mode Toolbar
b) Composition Toolbar
c) Format Toolbar 1
d) Format Toolbar 2

Answer: Edit Mode Toolbar

Question: Which program relieves a programmer from the tedious
job of writing the source code which takes a long time ?

a) HTML
b) JavaScript
c) KompoZer
d) All of these

Answer: KompoZer

Question: Which tab of KompoZer can be clicked to see the source
code of the form ?

a) Design
b) Source
c) Split
d) Any of these

Answer: Source

Question: In KompoZer, which menu-option is used to save a file ?
a) File -» Keep
b) File -^ Store
c) File -> Save
d) File -> Put

Answer: File -> Save
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Question: In KompoZer, Save tool button is located on^ which
toolbar ?

a) Edit Mode Toolbar
b) Composition Toolbar!
c) Format Toolbar 1
d) Format Toolbar 2

Answer: Composition Toolbar!

Question: Which dialog box opens when save tool button is clicked
in KompoZer ?

a) Page Title
b) Form Title
c) Save
d) Save As

Answer: Page Title

Question: Where is the web page displayed ?
a) Web server
b) Web Database
c) Web Browser
d) Web Source code

Answer: Web Browser

Question: Where is the page title of web page displayed ?
a) Title bar
b) Menu bar
c) Toolbar
d) Status bar

Answer: Title bar

Question: Whose name as title page should be give when multiple
web pages are created ?

a) Web browser
b) Web Server
c) Web Source code
d) Website

Answer: Website

Question: What is displayed when OK button of Page Title dialog box
of File —> Save option clicked ?

a) Dialog box of Save
b) Dialog box of Save As
c) Dialog box of Save Page As
d) Dialog box of Page As

Answer: Dialog box of Save Page As
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Question: With which extension a file in KompoZer be saved ?
a) .htm, .html
b) .hmt, .hmtl
c) .cp, .cmp
d) .pub, .pab

Answer: .htm, .html

Question: With which name shall the page be saved when that page
is the home page that will open when you type the website's URL ?

a) master.html
b) home.html
c) main.html
d) index html

Answer: index html

Question: From which toolbar is Heading selected to give title to the
form ?

a) Format Toolbar 1
b) Format Toolbar 2
c) Composition Toolbar
d) Edit Mode Toolbar

Answer: Format Toolbar 1

Question: How many types of headings are available in paragraph
format of Format Toolbar 1 ?

a) Four
b) Five
c) Six
d) Seven

Answer: Six

Question: On which toolbar is Align Center icon which is used to
align Form heading in center located ?

a) Format Toolbar 1
b) Format Toolbar 2
c) Composition Toolbar
d) Edit Mode Toolbar

Answer: Format Toolbar 2

Question: How many types of alignment for text are available on
Format Toolbar 2 ?

a) Two
b) Three
c) Four
d) Five

Answer: Four
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Question: Which alignment is available for text alignment in
KompoZer ?

a) Align Left, Align Right
b) Align Center
c) Align Justified
d) All of These

Answer: All of These

Question: Which menu-option is used to create label in form ?
a) Form -> Insert —> Define Label
b) Insert -> Form —> Define Label
c) Form -> Insert -> Add Label
d) Insert —> Form —> Add Label

Answer: Insert -> Form —> Define Label

Question: Which menu-option is used to create label for input field
in form ?

a) Insert -> Form —> Form Field
b) Form —> Insert —> Form Field
c) Insert -> Form —> Form Input
d) Form —> Insert -> Form Input

Answer: Insert -> Form —> Form Field

Question: Which type of field is useful when only one option from
the given options is to be selected ?

a) Radio Button
b) Check Box
c) Text Area
d) (A) or (B)

Answer: Radio Button

 

Question: Which menu-option is used to create radio button in form
?

a) Insert —> Form —> Form Input
b) Form —> Insert —> Form Field
c) Insert —> Form —> Form Field
d) Form —> Insert —> Form Input

Answer: Insert —> Form —> Form Field

Question: When radio button option is selected in Field Type then
which option is seen in Field Setting ?

a) Group Name
b) Field Value
c) Initially Selected
d) All of these

Answer: All of these
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Question: Which option should be selected when a radio button
should appear selected by default ?

a) Group Name
b) Field Value
c) Initially Selected
d) Initially Checked

Answer: Initially Selected

Question: How should the name of radio buttons in same group be ?
a) Same
b) Different
c) Various forms
d) Any of these

Answer: Same

Question: Which type of field is useful when one or more than one
options from the given options are to be selected ?

a) Radio Button
b) Check Box
c) Text Area
d) (A) or (B)

Answer: Check Box

Question: Which menu-option is used to create check box in form ?
a) Insert -» Form -> Form Input
b) Form —»Insert —> Form Field
c) Insert —> Form —» Form Field
d) Form —> Insert —» Form Input

Answer: Insert —> Form —» Form Field

Question: When check box option is selected in Field Type then
which option is seen in Field Setting ?

a) Field Name
b) Field Value
c) Initially Checked
d) All of these

Answer: All of these

Question: Which option should be selected when a check box should
appear selected by default ?

a) Field Name
b) Field Value
c) Initially Checked
d) Initially Checked

Answer: Initially Checked
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Question: Which type of field is used to insert multi line text box ?
a) Radio Button
b) Check Box
c) Text Area
d) (A) or (B)

Answer: Text Area

Question: Which menu-option is used to create text area field in
form ?

a) Insert —> Form —> Text Area
b) Form —> Insert —> Text Area
c) Insert -» Field -> Text Area
d) Field -> Insert -> Text Area

Answer: Insert —> Form —> Text Area

 

Question: Which options are displayed in Setting options of text area
Properties dialog box when text area field is created in form ?

a) Field Name
b) Rows
c) Columns
d) All of these

Answer: All of these

Question: Where is the text written which should be displayed by
default in text area field ?

a) Field Name
b) Initial Text
c) Rows
d) Columns

Answer: Initial Text

Question: Whose values should be given to create text area field ?
a) Rows, columns
b) Height, Width
c) Top, Bottom
d) Up, Down

Answer: Rows, columns

Question: What should be used when it is not necessary to display all
options at a time on the screen ?

a) Radio Button
b) Check box
c) Drop Down Menu
d) Text area

Answer: Check box
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Question: Which menu-option is used to create drop down menu in
form ?

a) Insert —> Form —> Drop down List
b) Insert —> Form —> Selection List
c) Form -> Insert -> Drop down List
d) Form -> Insert -» Selection List

Answer: Insert —> Form —> Selection List

Question: Which options are displayed in Setting List Properties
dialog box beneath option drop down menu ?

a) Text
b) Value
c) Initially Selected
d) All of these

Answer: All of these

Question: Which buttons are displayed in Selection List Properties
dialog box ?

a) Add Option, Add Group
b) Remove, Advanced Edit
c) Move Up, Move Down
d) All of these

Answer: All of these

Question: Which button should be clicked to add various options of
drop down list ?

a) Add Group
b) Add Option
c) Advanced Edit
d) Remove

Answer: Add Option

Question: Which menu-option is used to create Submit Reset button
in form ?

a) Insert —> Form —> Form Field
b) Form -> Insert -> Form Field
c) Insert -» Button -> Form Field
d) Button —> Insert -» Form Field

Answer: Insert —> Form —> Form Field

Question: What is by default background color of form KompoZer ?
a) Red
b) Yellow
c) Light Blue
d) White

Answer: White
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Question: Which menu-option is used to change background color of
form ?

a) Edit —> Page Colors and Background
b) Format -> Page Colors and Background I
c) View -> Page Colors and Background
d) Change —> Page Colors and Background I

Answer: Format -> Page Colors and Background I

Question: Which dialog box opens when one select! format 'Page
Colors and Background option! change background color of form ?

a) Page Colors and Background
b) Form Colors and Background
c) Page Background and Colors
d) Background Colors

Answer: Page Colors and Background

Question: Which option should be selected in Page Color and
Background dialog box to background color of form ?

a) Reader's default Colors
b) Use custom Colors
c) Background Image
d) Any of these

Answer: Use custom Colors

Question: Which type of colors can be changed using Use custom
colors of Page Color and Background dialog box ?

a) Normal text, Link text
b) Active link text, Visited link text
c) Background
d) All of these

Answer: All of these

Question: Which value should be given to type attribute of input
element to create text box in form ?

a) Input
b) Text
c) Textual
d) None of these

Answer: Text

Question: Which value should be given to type attribute of input
element to create password field in form ?

a) Input
b) Password
c) Pass_word
d) None of these

Answer: Password
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Question: Which value should be given to type attribute of input
element to create radio button in form ?

a) Input
b) Radio
c) Button_radio
d) None of these

Answer: Radio

Question: Which option of Form properties dialog box shows added
options for the form when clicked ?

a) More Properties
b) Extra Properties
c) View Properties
d) Add Properties

Answer: More Properties

Question: Which options are displayed beneath Setting of Form
properties dialog box ?

a) Form Name
b) Action URL
c) Method
d) All of these

Answer: All of these

Question: In which option is form name typed in Form properties
dialog box ?

a) Form Name
b) Action URL
c) Method
d) Any of these

Answer: Form Name
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b) It helps in attracting less number of customers
c) It helps in selling the products
d) It helps in promoting the business

Answer: It helps in attracting less number of customers

Question: What is a website ?
a) Collection of files
b) Group of directories
c) Interlinked collection of Web Pages
d) Collection of advertisements

Answer: Interlinked collection of Web Pages

Question: How should be the website ?
a) User friendly
b) Accurate
c) Informative
d) All of these

Answer: All of these

Question: ______in the website will enable the company to get the
maximum amount of traffic, therefore making the maximum amount
of profit.

a) Website is interactive
b) Website is user friendly
c) Website is providing accurate and useful information
d) All of these

Answer: All of these

Question: As per our syllabus software is to be used to create
websites.

a) PHP
b) KompoZer
c) Notepad
d) Publisher

Answer: KompoZer

Question: How should be the planning of the website ?
a) Interactive
b) Precise and easily understandable
c) User friendly
d) All of these

Answer: Interactive

Question: Before creating a website, we should be clear with the of
the website.

a) Definition
b) Aim
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c) Both (A) and (B)
d) Thinking

Answer: Both (A) and (B)

Question: What should be the purpose of the website ?
a) To provide information to a group of people
b) To attract the new customers
c) To sell the products online
d) All of these

Answer: All of these

Question: Having decided the purpose_______of the website can be
properly developed.

a) Content
b) Layout
c) Both (A) and (B)
d) Investment

Answer: Both (A) and (B)

Question: What kind of information should be there in the website ?
a) General
b) Detailed
c) Containing specific and non-specific data
d) All of these

Answer: All of these

Question: The proportion of the different type and extent of detailed
and specific information depends on the_______

a) Nature of the expected audience
b) Nature of the website
c) Nature of the investment
d) All of these

Answer: Nature of the expected audience

 

Question: The user expectations from the website are important to
know for_____

a) It helps to develop the appropriate content and layout of the site
b) Getting information about how much investment to be done
c) We can come to know about the interest of the people
d) All of these

Answer: It helps to develop the appropriate content and layout of the site

Question: In case, large graphical files are kept on the website can
happen.

a) Website becomes attractive
b) They will take a long time to download
c) Users can become impatient while waiting for large files and leave the site
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d) All of these

Answer: All of these

Question: What kind of information should be there in the website ?
a) Complete and relevant
b) Complete and irrelevant
c) Incomplete and irrelevant
d) Complete, irrelevant and unattractive

Answer: Complete and relevant

Question: Excessive use of irrelevant information can
cause_____frustration to the users as they are unable to seek the
specific data.

a) We can come to know about the products of the company
b) We can come to know about the services of the company
c) Both (A) and (B)
d) Frustration to the users as they are unable to seek the specific data

Answer: Both (A) and (B)

Question: What is the advantage of having navigation in the website
?

a) Moving from one page to another is easy
b) The user knows where he is
c) Easily get back to home page
d) All of these

Answer: All of these

Question: __________ensures that site can serve its intended purpose.
a) Ensuring that appropriate information (both general and detailed) is available
b) It is easily accessible
c) It becomes valuable tool for individual
d) All of these

Answer: All of these

Question: The website design should scale for the devices like_______
a) Computers
b) Smart phones
c) Tablets
d) All of these

Answer: All of these

Question: The website should be designed keeping in mind that it is
well displayed in all the popular web browsers like_______

a) Internet Explorer
b) Mozilla Firefox
c) Chrome, Opera
d) All of these
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Answer: All of these

 
Question: ________is not the web browser program.

a) Internet Explorer
b) Mozilla Firefox
c) Chrome, Opera
d) KompoZer

Answer: KompoZer

Question: _____is the entry page of website.
a) Home page
b) Contact us page
c) Address page
d) Contact me page

Answer: Home page

Question: The first page of the website is known as________
a) Main page
b) Home page
c) Contact us page
d) Address page

Answer: Home page

Question: The_____of the website is the first page that opens when
the user enters the URL address in the address bar of the browser.

a) Home page
b) Contact us page
c) Main page
d) Any one of these

Answer: Home page

Question: Generally what is there in the home page of the website ?
a) List of categories of products
b) Categorized pictures
c) Necessary hyperlinks
d) All of these

Answer: All of these

Question: _______is useful to insert a table in KompoZer.
a) Table -> Insert Table
b) Insert-> Table
c) Table-> Draw Table
d) Insert -> Draw Table

Answer: Insert-> Table

Question: Generally_____name is given to the home page.
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a) Home.html
b) Index.html
c) Bill.html
d) Homepage.html

Answer: Index.html

Question: Where is each website created on web server ?
a) In a directory
b) As an independent file
c) On C drive
d) As per user's choice

Answer: In a directory

Question: Each web page is an independent file on_______
a) A website
b) A web server
c) Computer
d) All of these

Answer: A web server

Question: What is the predefined file used to display content by web
server.

a) Name of a particular website
b) homepage.html
c) index.html
d) mainpage.html

Answer: index.html

 
Question: When web server appends the URL without file name, then
server displays______file by default.

a) Index.html
b) Predefined file
c) Both (A) and (B)
d) Mainfile.html

Answer: Both (A) and (B)

Question: How to insert an image in a cell of a table ?
a) Insert -> Picture (
b) Insert -> Image
c) Insert -> Clipart
d) Insert -> Cell -^ Image

Answer: Insert -> Image

Question: _______command is used to change the title of the web
page.

a) Format —> Page Title
b) Format -> Properties
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c) Format —> Page Title & Properties
d) Edit -* Page Title

Answer: Format —> Page Title & Properties

Question: ______command is used to give the links to the categories.
a) Insert —> Link
b) Format —» Link
c) Insert -> Hyperlink
d) Edit -> Hyperlink

Answer: Insert —> Link

Question: When JavaScript is used in the web page, the details are
separated using______

a) , (comma)
b) ; (semi colon)
c) : (colon)
d) #(hash)

Answer: , (comma)

Question: When JavaScript is used in the web page, the details of
production are separated using_____

a) , (comma)
b) : (colon)
c) ; (semi colon)
d) # (hash)

Answer: : (colon)

Question: What is a cookie ?
a) One type of parameter
b) A person making food
c) Variable stored in user's computer
d) Identifier

Answer: Variable stored in user's computer

Question: ______type of information is provided by cookie.
a) Provide feature to remember
b) Track preferences, purchases, commissions
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: JavaScript can manipulate cookies using the______
a) Cookie property of the document object.
b) Cookie property of the image object.
c) Cookie property of the table object.
d) None of these

Answer: Cookie property of the document object.
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Question: What can be done on a cookie ?
a) Can be read
b) Can be created
c) Can be modified and deleted
d) All of these

Answer: All of these

 

Question: We are converting the data into number by using
function______

a) Parsfloat ()
b) ParseFloat ()
c) Parseflot [ ]
d) Parsecarec ()

Answer: ParseFloat ()

Question: Publishing the website is known as______
a) Uploading
b) Downloading
c) Surfing
d) None of these

Answer: Uploading

Question: The process of publishing a website means to transfer the
web pages, images and style sheets related to the site, to a web
server from which they may be accessed by the users. It is known
as_______

a) Surfing
b) Uploading
c) Downloading
d) None of these

Answer: Uploading

Question: What is necessary to upload a website ?
a) Our account on web server
b) Internet service
c) Computer
d) All of these

Answer: All of these

Question: ISP stands for_____
a) Internet Service Product
b) Internet Service Provider
c) Internet Source Product
d) Internet Source Provider

Answer: Internet Service Provider
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Question: _______offers limited free space on the web server.
a) ISP
b) Computer
c) URL
d) All of these

Answer: ISP

Question: Alternatively, to upload the website, there are
many_____that provide limited free space to the users.

a) Web hosts
b) Organizations providing hosting
c) Both (A) and (B)
d) None of these

Answer: Organizations providing hosting

Question: The free space can also be achieved for a limited time
period from______

a) Web hosts
b) Organizations providing hosting
c) Both (A) and (B)
d) None of these

Answer: Web hosts

Question: To publish a site, we need to know the settings for the
space to set up the system using______

a) File -> Website -> Publish
b) File ^Publish
c) Format -> Publish
d) File -> Go -+ Publish

Answer: File ^Publish

Question: FTP stands for_______
a) File Transfer Procedure
b) File Transfer Protocol
c) Format Transfer Protocol
d) File Trans Protocol

Answer: File Trans Protocol

 
Question: URL stands for_______

a) Universal Research Locator
b) United Resource Location
c) Universal Resource Location
d) United Resource Location

Answer: Universal Resource Location

Question: _______is not the open source IDE for web development.
a) KompoZer
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b) Aptana Studio
c) Amaya
d) Notepad

Answer: Notepad

Question: IDE stands for_______
a) International Development Environment
b) Integrated Developed Environment
c) Integrated Development Environment
d) Integrated Development Engine

Answer: Integrated Development Environment

Question: What is the function of open source "Aptana Studio" ?
a) Coding of scripting
b) Development of web application
c) Crating websites
d) All of these

Answer: Development of web application

Question: Aptana Studio is a complete web development
environment which provides language support for______

a) HTML, JavaScript
b) CSS, Ruby
c) Rails, PHP
d) All of these

Answer: All of these

Question: We have to study_____version of Aptana Studio.
a) 2.0.5
b) 3.0
c) 1.0
d) 4.0.5

Answer: 2.0.5

Question: Aptana studio can develop web application using_______
a) HTML
b) CSS
c) JavaScript
d) All of these

Answer: All of these

Question: ________website is useful to download Aptana Studio.
a) www.aptana.com
b) www.aptana.org
c) www.apt.com
d) www.aptana.com.org

Answer: www.aptana.com

http://www.aptana.com/
http://www.aptana.org/
http://www.apt.com/
http://www.aptana.com.org/
http://www.aptana.com/
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Question: Aptana studio open source can make projects using_______
a) PHP
b) Rails
c) Ruby or web
d) All of these

Answer: All of these

Question: What is BlueGriffon ?
a) WYSIWYG type general editor
b) WYSIWYG type HTML editor
c) A facility for speed calling
d) One open source communication

Answer: WYSIWYG type HTML editor

 

Question: Blue Griffon open source can be easily downloaded
from_____

a) www.bluegriffon.com
b) www.bluegriffon.org
c) www.blue.org
d) www.bgriffon.com

Answer: www.bluegriffon.org

Question: _______language is not supported by Blue Griffon.
a) English
b) Dutch, German
c) Hindi
d) Chinese

Answer: Hindi

Question: We have____version of Blue Griffon open source.
a) 1.62
b) 2.0.5
c) 3.04
d) 3.0

Answer: 1.62

Question: ______type of editor is Blue Griffon.
a) WYSIWYG
b) Open source WYSIWYG type HTML
c) WYSIWYG Text
d) Graphics and Text, HTML type web

Answer: Open source WYSIWYG type HTML

Question: WYSIWYG stands for________
a) Why you say is why you get
b) What you say is why you ge

http://www.bluegriffon.com/
http://www.bluegriffon.org/
http://www.blue.org/
http://www.bgriffon.com/
http://www.bluegriffon.org/
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c) What you say is what you get
d) What you say is where you get

Answer: What you say is what you get

Question: W3C stands for_______
a) World Wide Web Consortium
b) World 3 Consortium
c) World Wide Web Console
d) World Where Web Consortium

Answer: World Wide Web Consortium

Question: _______is not WYSIWYG type editor.
a) Amaya
b) Blue griffon
c) Aptana Studio
d) All of these

Answer: Aptana Studio

Question: Amaya was initially started as_____editor.
a) Text
b) HTML/CSS
c) Web
d) Graphic

Answer: HTML/CSS

Question: Amaya has now grown into an editor for many_____based
systems.

a) MXL
b) LXM
c) XML
d) All of these

Answer: XML

Question: Amaya is____type of open source editor.
a) Text
b) Web
c) Graphics
d) None of these

Answer: Web

 

Question: Amaya web editor can be downloaded from_____
a) www.Amaya.com
b) www.Amaya.org
c) www.w3.Amaya.org
d) www.w3.org/Amaya

Answer: www.w3.org/Amaya

http://www.amaya.com/
http://www.amaya.org/
http://www.w3.amaya.org/
http://www.w3.org/Amaya
http://www.w3.org/Amaya
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Question: ______is not the web browser program.
a) Internet Explorer
b) Mozilla Firefox
c) Chrome, Opera
d) KompoZer

Answer: KompoZer

Question: _____is the entry page of website.
a) Home page
b) Contact us page
c) Address page
d) Contact me page

Answer: Home page

Question: The first page of the website is known as_______
a) Main page
b) Home page
c) Contact us page
d) Address page

Answer: Home page

Question: _______is useful to insert a table in KompoZer.
a) Table -> Insert Table
b) Insert-> Table
c) Table-> Draw Table
d) Insert -> Draw Table

Answer: Insert-> Table

Question: Where is each website created on web server ?
a) In a directory
b) As an independent file
c) On C drive
d) As per user's choice

Answer: In a directory

Question: Each web page is an independent file on_____
a) A website
b) A web server
c) Computer
d) All of these

Answer: A web server

Question: What is the predefined file used to display content by web
server.

a) Name of a particular website
b) Homepage.html
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c) index.html
d) mainpage.html

Answer: index.html

Question: What is a cookie ?
a) One type of parameter
b) A person making food
c) Variable stored in user's computer
d) Identifier

Answer: Variable stored in user's computer

Question: What can be done on a cookie ?
a) Can be read
b) Can be created
c) Can be modified and deleted
d) All of these

Answer: All of these
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Question: It is usually understood that a compiled program is error
free and will always______successfully.

a) Complete
b) Execute
c) Perform
d) Accomplish

Answer: Execute

Question: In few cases a compiled program can_______while it its
executing.
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b) Finish
c) Dismiss
d) Discharge

Answer: Terminate

Question: The_______in a program results in an abnormal execution
and it may lead to abnormal termination of the program.

a) Exception
b) Error
c) Message
d) Mistake

Answer: Exception

Question: An is an indication of a problem thatc occurs during a
program's execution.

a) Exception
b) Inaccuracy
c) Error
d) E-fault

Answer: Exception

Question: An exception usually signals an_______
a) Exception
b) Inaccuracy
c) Error
d) E-fault

Answer: Error

Question: Although exceptions occur infrequently, one has to be
careful in handling such cases while writing the_______

a) Program
b) Message
c) Data
d) Code

Answer: Code

Question: ________handling allows a program to continue executing
as if no problem had been encountered or it may notify the user of
the problem before terminating in an uncontrolled manner.

a) Data
b) Program
c) Error
d) Exception

Answer: Exception

Question: There are few standard______available in Java, a technique
to guarantee that a particular I block of code will always be executed,
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even if I exceptions are present in our program.
a) Data info
b) Programs
c) Errors
d) Exceptions

Answer: Exceptions

Question: In Java, all kinds of error conditions are called________
a) Methods
b) Programs
c) Errors
d) Exceptions

Answer: Exceptions

Question: Errors can be broadly classified into_______categories.
a) Four
b) Three
c) Two
d) Five

Answer: Two

 

Question: ________is a type of error produced in java programs.
a) Compile-time errors
b) Run-time errors
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: A________is used to convert source code into object code.
a) Compiler
b) Interpreter
c) Translator
d) Decoder

Answer: Compiler

Question: A compiler is used to convert_______code into object code.
a) Home
b) Source
c) Beginning
d) Program

Answer: Source

Question: If there is a syntax error in the program, a compilation
error is displayed and______file is not created.

a) .Source
b) .Dat
c) .Class
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d) .Obj

Answer: .Class

Question: Examples of some common syntax errors are missing like
a________

a) Semicolon
b) Use of undeclared variable
c) Wrong spellings of identifier or keyword
d) All of these

Answer: All of these

Question: The Java_______suggests in an output, the type of error,
along with the line number where the error has occurred.

a) Compiler
b) Interpreter
c) Translator
d) Decoder

Answer: Compiler

Question: Compile-time_____are usually the mistake of a programmer
and it does not allow the program to compile unless they are solved.

a) Methods
b) Programs
c) Errors
d) Exceptions

Answer: Errors

Question: In the field of Computer Science, "Exit code" or "Exit
status" indicates whether the command or a______executed
successfully or not.

a) Data type
b) Program
c) error
d) Method

Answer: Program

Question: Code_______indicates that the command executed
successfully.

a) 1
b) -1
c) 0.0
d) 0

Answer: 0

Question: Code_______indicates that some problem occurred while
executing the command.

a) 1
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b) -1
c) 0.0
d) 0

Answer: 1

Question: If there are no syntax errors in the source code then the
program will compile successfully and will get a_______file.

a) .source
b) .dat
c) .class
d) .obj

Answer: .class

Question: The array "_______ citylist [ ] = {"Ahmedabad", "Baroda",
"Rajkot", "Surat"};" contains name of four different cities.

a) String
b) Int
c) Long
d) Boolean

Answer: String

Question: For each type of exception, there are
corresponding______classes in Java.

a) Programs
b) Exceptions
c) Java.lang
d) Java.io

Answer: Exceptions

Question: The________contains a hierarchy of classes dealing with
various exceptions.

a) Java.lang package
b) Java.io package
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: An attempt to access the array element with an index
value that is outside the range of array uses_______Exception class.

a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) All of these

Answer: Array lndex Out Of Bounds Exception

Question: An attempt to divide any number by 0
uses_______Exception class.
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a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) All of these

Answer: Arithmetic Exception

Question: An attempt to divide any number by 0 uses______Exception
class.

a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) All of these

Answer: File Not Found Exception

Question: An attempt to use null in a case where an object is
required uses_____Exception class.

a) PrinterlOException
b) NullPointerException
c) NumberFormatException
d) None of these

Answer: NullPointerException

Question: An attempt to convert string to a number type
uses_______Exception class.

a) PrinterlOException
b) NullPointerException
c) NumberFormatException
d) None of these

Answer: NumberFormatException

Question: An I/O error has occurred while printing uses ..........
Exception class.

a) Printer lO Exception
b) Null Pointer Exception
c) Number Format Exception
d) None of these

Answer: Printer lO Exception

 

Question: The following code will result in Exception. int numerator
= 15; int denominator = 0; answer; answer = numerator /
denominator;

a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) All of these

Answer: Arithmetic Exception
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Question: What is the full form of JVM ?
a) Java Virtual Mechanism
b) Java Virtual Method
c) Java Virtual Machine
d) Java Virtual Manner

Answer: Java Virtual Machine

Question: An______is an error condition.
a) Allowance
b) Exclusion
c) Error
d) Exception

Answer: Exception

Question: ________handling is an object-oriented technique for
managing errors.

a) Allowance
b) Exclusion
c) Error
d) Exception

Answer: Exception

Question: While performing exception handling, one has to try to
ensure that the program does not______abruptly nor does it generate
unexpected output.

a) Terminate
b) Finish
c) Dismiss
d) Discharge

Answer: Terminate

Question: Java uses keywords like_______to write an exception
handler.

a) Try
b) Catch
c) Finally
d) All of these

Answer: All of these

Question: The keywords______are used in the presence of exceptions,
these keywords represent block of statements.

a) Try
b) Catch
c) Finally
d) All of these

Answer: All of these
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Question: A______contains the code that may give rise to one or more
exceptions.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Try block

Question: A________contains the code that is intended to handle
exceptions of a particular type that were created in the associated try
block.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Catch block

Question: A_______is always executed before the program ends,
regardless of whether any exceptions are generated in the try block
or not.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Finally block

 

Question: The______statement contains a block of statements within
the braces.

a) Try
b) Catch
c) Finally
d) None of these

Answer: Try

Question: A______block may give rise to one or more exceptions.
a) Try
b) Catch
c) Finally
d) None of these

Answer: Try

Question: The code between a try block creates a.......... exception.
a) Double
b) Single
c) Triple
d) None of these

Answer: Single
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Question: The_______must immediately follow the try block.
a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Catch block

Question: _______contains the code that is to be created to handle an
exception.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Catch block

Question: The______is an exception handler.
a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Catch block

Question: For a______try block there can be one or more catch blocks.
a) Single
b) Double
c) Tirple
d) None of these

Answer: Single

Question: A catch block consists of the keyword catch followed by a
single______

a) Operator
b) Method
c) Block
d) Parameter

Answer: Parameter

Question: The catch code to handle exception has to be written
between_________

a) Codes
b) Blocks
c) Parentheses
d) Parameters

Answer: Parentheses
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Question: The_______identifies the type of exception that the block is
to deal with.

a) Operator
b) Method
c) Block
d) Parameter

Answer: Parameter

Question: Java supports______types of exceptions
a) Various
b) Single
c) Multiple
d) Some

Answer: Various

Question: Any program which tries to access array element by
specifying index position that is outside the range leads to an_______

a) Illegal message
b) Exclusion
c) Error
d) Exception

Answer: Exception

Question: When above kind of exception occurs, an object of type is
created and is thrown.

a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) All of these

Answer: Array lndex Out Of Bounds Exception

Question: A corresponding_______handles the above exception and
does not allow the program to terminate unexpectedly.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Catch block

Question: The catch block contains a______to object "eobj" which is
created and thrown by the try block.

a) Space
b) Cell
c) Memory
d) Reference

Answer: Reference
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Question: In a single program_______exceptions can occur.
a) Various
b) Single
c) Multiple
d) Some

Answer: Multiple

Question: If a particular file has to be uploaded to a remote
computer, it may lead to_______distinct exceptions.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: If a particular file has to be uploaded to a remote
computer, an exception may occur if the file is not present in
the_______

a) Computer
b) Network
c) Internet
d) System

Answer: Computer

Question: If a particular file has to be uploaded to a remote
computer, another exception may occur if the computer is not
connected to the________

a) Computer
b) Network
c) Internet
d) System

Answer: Network

Question: There is a provision in Java to support______exceptions.
a) Various
b) Single
c) Multiple
d) Some

Answer: Multiple

 

Question: The code that generates exception should be written
within the______

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Try block
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Question: There can be multiple________to handle each type of
exception separately.

a) Try blocks
b) Catch blocks
c) Finally blocks
d) All of these

Answer: Catch blocks

Question: The last______can handle any type of exception.
a) Try block
b) Catch block
c) Finally block
d) None of these

Answer: Catch block

Question: The catch block, must be the last block when there are
multiple catch blocks.

a) First
b) Second
c) Third
d) Default

Answer: Default

Question: While writing the program, the order of the specific catch
blocks does not matter but the______block has to be placed at the
end of all catch blocks.

a) First
b) Second
c) Third
d) Default

Answer: Default

Question: _______try blocks can be nested together, but care must be
taken to write a corresponding catch block for each try block.

a) Various
b) Single
c) Multiple
d) Some

Answer: Multiple

Question: The_______is generally used to clean up the end of
executing a try block.

a) Try block
b) Catch block
c) Finally block
d) All of these
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Answer: Finally block

Question: A________is used when the programmer wants to be sure
that some particular code is to be run, no matter what exceptions are
thrown within the associated try block.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Finally block

Question: A________is always executed, regardless of whether or not
exceptions are thrown during the execution of the associated try
block.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Finally block

Question: A______is widely used if a file needs to be closed or a
critical resource is to be released at the completion of the program.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Finally block

 

Question: Each try block must always be followed by at
least________that is either a catch block or a finally block.

a) One block
b) Two blocks
c) Three blocks
d) None of these

Answer: One block

Question: However, in the presence of______the program executes the
statements within the finally block before it gets terminated.

a) Try block
b) Catch block
c) Finally block
d) All of these

Answer: Finally block

Question: A________is associated with a particular try block and it
must be located immediately following any catch blocks for the
corresponding try block.



13/09/2022, 20:05 CBSE Class 12 Computer Science Exception Handling In Java MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-exception-handling-java-mcqs-set-311066.html 14/24

a) Finally block
b) Catch block
c) Try block
d) None of these

Answer: Finally block

Question: If there are no______then the finally block can be
positioned immediately after the try block.

a) Try blocks
b) Catch blocks
c) Finally blocks
d) None of these

Answer: Catch blocks

Question: If the finally block or catch blocks are not positioned
correctly, then the program will not

a) Compile
b) Interpret
c) Translate
d) Decode

Answer: Compile

Question: The_______keyword is used to explicitly throw an Exception
object.

a) Throws
b) Throws
c) Throw
d) Try

Answer: Throw

Question: For example, an object of______was created when one tries
to perform a divide by zero operation.

a) Array lndex Out Of Bounds Exception
b) Arithmetic Exception
c) File Not Found Exception
d) None of these

Answer: Arithmetic Exception

Question: Java does provide mechanism to create an______object and
throw it explicitly.

a) Illusion
b) Exclusion
c) Error
d) Exception

Answer: Exception
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Question: The object that one throws, must be of type of
java.lang________, otherwise a compile error occurs.

a) Throwable
b) Throws
c) Throw
d) Throws

Answer: Throwable

Question: The syntax to throw an exception object is
a) Throw exception_object;
b) Throws exception_object;
c) Throws exception_object
d) Throw object;

Answer: Throw exception_object;

Question: When a_______statement is encountered, a search for
matching catch block begins.

a) Throwable
b) Throws
c) throw
d) Throws

Answer: throw

Question: Any subsequent statements in the_______are not executed.
a) Try block
b) Try or catch block
c) Catch block
d) Try or finally block

Answer: Try or catch block

Question: There are______alternative approaches to handle, when an
exception occurs in a method or a constructor.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: A_______clause can be used in a method declaration or
constructor declaration to inform that the code within the
constructor or method may throw an Exception.

a) Throwable
b) Throws
c) throw
d) throws

Answer: throws
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Question: When a______or a method that can throw exceptions is
written to its caller, it is useful to document that fact.

a) Constructor
b) Variable
c) Operator
d) Compiler

Answer: Constructor

Question: The________keyword is used with the declaration of
method.

a) Throwable
b) Throws
c) throw
d) throws

Answer: Throwable

Question: A_______can throw multiple exceptions.
a) Method
b) Variable
c) Operator
d) Compiler

Answer: Method

Question: Each type of______that a method can throw must be stated
in the method header.

a) Declaration
b) Variable
c) Error
d) Exception

Answer: Exception

Question: _______allows creating own exception classes according to
application-specific problems.

a) C ++
b) C
c) Java
d) PHP

Answer: Java

Question: _______does not provide built-in exception classes for
application specific exceptions.

a) C ++
b) C
c) Java
d) PHP

Answer: Java
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Question: User-defined exceptions can be created by creating a
subclass of______class.

a) Declaration
b) Input
c) Method
d) Exception

Answer: Exception

Question: If the______accepts data from the keyboard, it is advisable
to execute the program at command prompt.

a) Program
b) Application
c) User
d) Compiler

Answer: Program

Question: A good program must always handle_______rather than the
program being terminated abruptly.

a) Declarations
b) Inputs
c) Methods
d) Exceptions

Answer: Exceptions

Question: Advantage of using exception-handling in Java programs
is______

a) It allows maintaining normal flow of program. In the absence of exception handling, the flow of
program is disturbed.
b) It allows writing separate error handling code from the normal code.
c) Error types can be grouped and differentiated within the program.
d) All of these

Answer: All of these

Question: Advantage of using exception-handling in Java programs
is______

a) Assertions can be used to debug the program before deploying it to the clients.
b) It provides an easy mechanism to log various run-time errors while executing the program.
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: Which of the following is the correct syntax in a user
defined exception ?

a) Catch (InvalidMarksException eobj)
b) Catch(AritmeticException eobj)
c) Catch (ArraylndexOutOfBounds e)
d) All of these

Answer: Catch (InvalidMarksException eobj)
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Question: A throws clause can be used in the following manner :

a) MethodJVfodifiers methodJVame (parameters) throws Exception list...{......// body of the method......}
b) MethodJVIodifiers return_type method_Name (parameters) throws Exception list... {...... / / body of
the method......}
c) Return_type method_Name (parameters) throws Exception list...{...... // body of the method......}
d) None of these

Answer: MethodJVIodifiers return_type method_Name (parameters) throws Exception list... {...... / /
body of the method......}

Question: A method header can be like_________
a) Perform Division throws Arithmetic Exception, Array lndex Out Of Bounds Exception { ...... // body
of the method .... }
b) Perform Division() throws Arithmetic Exception, Array Index Out Of Bounds Exception
c) Perform Division O throws Arithmetic Exception! ... // body of the method .... }
d) Perform Division O throws Arithmetic Exception, Array Index Out Of Bounds Exception { ...... //
body of the method .... }

Answer: Perform Division O throws Arithmetic Exception, Array Index Out Of Bounds Exception {
...... // body of the method .... }

Question: The statement "throw myobject;"_________
a) Throws the exception object implicitly
b) Throws the exception object explicitly
c) Throws the object implicitly
d) None of these

Answer: Throws the exception object explicitly

Question: Which of these keywords must be used to monitor for
exceptions ?

a) Try
b) Finally
c) Throw
d) Catch

Answer: Try

Question: The finally block is executed when an exception is thrown,
even if no catch matches it. Choose the correct option.

a) True
b) False
c) Can't say
d) None of these

Answer: True

Question: Exceptions can be caught or re-thrown to a calling
method. Choose the correct option.

a) True
b) False
c) Can't say
d) None of these
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Answer: True

Question: The throw keyword in a program are not executed. Choose
the correct option.

a) True
b) False
c) Can't say
d) None of these

Answer: True

Question: Which of these keywords is not a part of exception
handling ?

a) Try
b) Finally
c) Thrown
d) Catch

Answer: Thrown

Question: Which of the following is true about try/catch blocks in
Java ? (I) All try/catch blocks must have a finally block. (II) A
try/catch block is limited to two or less catch blocks. (III) Barring the
Java virtual machine from exiting, the finally block will always be
executed.

a) (I) and (III)
b) (I) only
c) (III) only
d) (I) and (II)

Answer: (I) and (III)

Question: What will be the output of the program ? public class Test {
public static void main(String [ ] args) { try { return; } finally {
System.out.println("Finally");} }

a) Finally
b) Compilation fails
c) The code runs with no output
d) An exception is thrown at run time

Answer: Finally

Question: The key words used with exception handling are
a) Generate, handled, conclude
b) Generate, catch, finally
c) Throw, catch, conclude
d) Try, catch, finally

Answer: Try, catch, finally

Question: What happen behind the code int a=50/0 ?
a) Object of exception class thrown
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b) Error in Code
c) Error message
d) None of these

Answer: Object of exception class thrown

Question: When an array is accessed beyond the array
size_________exception is thrown.

a) Array Element Out Of Limit
b) Array Index Out Of Bounds Exception
c) Array Index Out Of Bounds
d) Array Element Out Of Bounds

Answer: Array Index Out Of Bounds Exception

Question: What is the output of this program ? class
exception_handling { public static void main(String args[ ]) try { int a,
b; b = 0; a = 5 / b; System.out.print("A"); } catch (Arithmetic
Exception e) { System.out.print("B"); } }

a) A
b) B
c) Compilation error
d) Run time error

Answer: B
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Question: Storage devices of a computer can be broadly classified
into_______categories.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: _______storage is temporary.
a) Volatile
b) Non-volatile
c) Movable
d) Immovable
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Answer: Volatile

Question: In_______storage values stored in variables are lost when a
computer is shutdown.

a) Volatile
b) Non-volatile
c) Movable
d) Immovable

Answer: Volatile

Question: A Java program that stores a value in a________uses
Random Access Memory (RAM).

a) Cell
b) Program
c) Variable
d) All of these

Answer: Variable

Question: Apart from variables, objects and their references are
generally stored in______

a) ROM
b) PROM
c) RAM
d) Hard Disk

Answer: RAM

Question: Once the program terminates or the computer shuts down,
the data is________from RAM.

a) Stored
b) Lost
c) Available
d) Accessible

Answer: Lost

Question: _______storage is permanent storage.
a) Volatile
b) Non-volatile
c) Movable
d) Immovable

Answer: Non-volatile

Question: Data is not_______when a computer loses power in a Non-
volatile storage.

a) Stored
b) Lost
c) Available
d) Accessible
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Answer: Lost

Question: When a Java program is saved on a disk, it is
using______storage.

a) Temporary
b) Provisional
c) Conditional
d) Permanent

Answer: Permanent

Question: A computer_______is a collection of data stored on a non-
volatile device.

a) File
b) Desktop
c) Directory
d) Device

Answer: File

 

Question: _______exist on permanent storage devices, such as hard
disks, USB drives, optical disks and compact discs.

a) Files
b) Manuals
c) Directories
d) Devices

Answer: Files

Question: Data stored in files is often called_______data.
a) Text
b) Persistent
c) Informative
d) Binary

Answer: Persistent

Question: Files can be further classified broadly into_______categories.
a) One
b) Two
c) Three
d) Four

Answer: Two

Question: ______files contain data that can be read in a text editor.
a) Text
b) Manuscript
c) Memo
d) Binary

Answer: Text
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Question: In the_______files the data has been encoded using a
scheme such as ASCII or Unicode.

a) Text
b) Memo
c) Informative
d) Binary

Answer: Text

Question: ______files can be data files that contain facts, such as
payroll file that contains employee numbers, names and salaries.

a) Binary
b) Memo
c) Program
d) Text

Answer: Text

Question: Some_______files can be program files or application files
mat store software instructions.

a) Binary
b) Memo
c) Program
d) Text

Answer: Text

Question: are examples of editors through which text files can be
created.

a) G edit
b) vi
c) pico
d) All of these

Answer: All of these

Question: The extensions of the files created through the above
editor can have an extension like_________

a) Text
b) Java
c) C
d) All of these

Answer: All of these

Question: _____files contain data that has not been encoded as text.
a) Binary
b) Memo
c) Informative
d) Text

Answer: Binary
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Question: The contents of a_______file are in binary format, which
means the data is access terms of bytes.

a) Binary
b) Memo
c) Informative
d) Text

Answer: Binary

Question: The Binary files extensions examples are_______
a) Jpeg
b) Mp3
c) Class
d) All of these

Answer: All of these

Question: Java language supports various operations that can be
performed on file or on_______

a) Programs
b) Attributes
c) Directories
d) Queries

Answer: Directories

Question: _______operations that can be performed on files using Java
programs.

a) Determining the path of a file or a directory
b) Opening a file
c) Writing to a file
d) All of these

Answer: All of these

Question: _______operations that can be performed on files using Java
programs.

a) Reading from a file
b) Closing or deleting a file
c) Querying the attributes of a file
d) All of these

Answer: All of these

Question: Java provides built-in_______that contains methods to help
with the tasks related to file.

a) Variables
b) Packages
c) Classes
d) Devices

Answer: Classes
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Question: The Java classes are present in package.
a) Java, bytes
b) Java.io
c) Java.util
d) Java.method

Answer: Java.io

Question: Java uses the concepts of______in file handling.
a) File systems
b) Streams
c) Packages
d) Classes

Answer: Streams

Question: Java provides_____different categories of java classes to
perform I/O operations on bytes and characters.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: Which of the following is not a Binary file extension ?
a) Jpeg
b) Mp3
c) Class
d) txt

Answer: txt

 

Question: Which of the following is not a Text file extension ?
a) Txt
b) Java
c) Jpeg
d) C

Answer: Jpeg

Question: The_______class encapsulates information about the
properties of a file or a directory.

a) Java.io.file
b) Java.oi.file
c) Java.util.io
d) Java.io.util

Answer: Java.io.file
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Question: ________class can be used to access attributes of files and
directions.

a) File
b) I/O
c) Java
d) util

Answer: File

Question: A programmer can do______a file or a directory.
a) Create
b) Rename
c) Delete
d) All of these

Answer: All of these

Question: The creation of a file Object that belongs to_____class does
not imply that the file or directory exists.

a) File
b) I/O
c) Java
d) Util

Answer: File

Question: The______of a file can also be accessed like its permissions,
length of a file or last modification time.

a) Features
b) Attributes
c) Qualities
d) Traits

Answer: Attributes

Question: A file________encapsulates a path name or reference to a
physical file or a directory on the hard disk.

a) Method
b) Class
c) Object
d) Handler

Answer: Object

Question: There are nearly______that can be used to perform various
operations on a file or a directory.

a) 25 methods
b) 30 methods
c) 35 methods
d) 20 methods

Answer: 30 methods
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Question: _______does not provide any method to read from a file or
write into a file.

a) File class
b) File method
c) File object
d) File operator

Answer: File class

Question: There are several_______classes to perform to read from a
file or write into a file.

a) File
b) Stream
c) Package
d) Object

Answer: Stream

 

Question: By using the file class, one can create a______to any file by
providing its absolute path in string format or by providing the
relative path.

a) Location
b) Reference
c) Stream
d) Object

Answer: Reference

Question: The file class provides_______constructors to refer a file or a
directory.

a) File (String path)
b) File (String directory_path, String file_name)
c) File (File directory, String file_name)
d) All of these

Answer: All of these

Question: In Linux, "password" file is present in_______directory stores
the information of the users existing in the system.

a) "/etc"
b) “/pwd"
c) "/file"
d) “/dir"

Answer: "/etc"

Question: Suppose one wants to display its attributes, then its Java
file object can be created using_______ways.

a) One
b) Two
c) Three
d) Four



13/09/2022, 20:05 CBSE Class 12 Computer Science File Handling MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-handling-mcqs-set-311074.html 9/21

Answer: Three

Question: _______method of file class returns true if the file or
directory exists, otherwise returns false.

a) Boolean exists( )
b) Boolean is File()
c) Boolean is Directory( )
d) Boolean is Hidden( )

Answer: Boolean exists( )

Question: ______method of file class returns true if the file exists,
otherwise returns false.

a) Boolean exists ( )
b) Boolean is File( )
c) Boolean is Directory( )
d) Boolean is Hidden( )

Answer: Boolean is File( )

Question: _____method of file class returns true if the directory exists,
otherwise returns false.

a) Boolean exists( )
b) Boolean is File( )
c) Boolean is Directory( )
d) Boolean is Hidden( )

Answer: Boolean is Directory( )

Question: _______method of file class returns true if the file or
directory is hidden.

a) Boolean exists ( )
b) Boolean is File( )
c) Boolean is Directory( )
d) Boolean is Hidden( )

Answer: Boolean is Hidden( )

Question: ______method of file class returns the absolute path of the
file exists or directory.

a) String[ ] list( )
b) String get Path( )
c) String get Name( )
d) String get Absolute Path()

Answer: String get Absolute Path()

Question: ________method of file class returns the name of the file or
directory referred by the object.

a) String[ ] list( )
b) String get Path( )
c) String get Name( )
d) String get Absolute Path()
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Answer: String get Name( )

Question: _______method of file class returns the path to the file or
directory.

a) String[ ] Hst( )
b) String get Path( )
c) String get Name( )
d) String get Absolute Path()

Answer: String get Path( )

Question: _______method of file class returns the name of the files and
directories in a directory.

a) String[ ] list( )
b) String get Path( )
c) String get Name( )
d) String get Absolute Path()

Answer: String[ ] list( )

Question: _______method of file class returns the number of bytes in
that file.

a) Long length( )
b) File[ ] list Files( )
c) Both (A) and (B)
d) None of these

Answer: Long length( )

Question: ________method of file class returns an array of abstract
path names denoting the files in the directory.

a) Long length ( )
b) File[ ] list Files( )
c) Both (A) and (B)
d) None of these

Answer: File[ ] list Files( )

Question: ______method to list all the files present in a directory.
a) Display()
b) List( )
c) Dir()
d) Files()

Answer: List( )

Question: To modify a file or display the contents of a file, the
concept of______has to be understood.

a) Files
b) Streams
c) Packages
d) Objects
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Answer: Streams

Question: Java uses______classes to carry out read and write
operations on files.

a) Files
b) Streams
c) Packages
d) Objects

Answer: Streams

Question: ______is an input device.
a) Monitor
b) Speaker
c) Keyboard
d) Plotter

Answer: Keyboard

Question: ______is an output device.
a) Monitor
b) Speaker
c) Keyboard
d) Plotter

Answer: Monitor

Question: ________can be classified as both input and output device as
data can be stored and read from the files.

a) Monitor
b) Speaker
c) Keyboard
d) Hard disk

Answer: Hard disk

 

Question: _________are manufactured by various companies and come
with different storage capacities like 500GB or 1 TB.

a) Monitor
b) Speaker
c) Keyboard
d) Hard disk

Answer: Hard disk

Question: ______can be connected using different cables like USB or
SATA.

a) Hard disk
b) Scanner
c) Printer
d) Mouse

Answer: Hard disk
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Question: A Java programmer does not need to worry about the
technical details like type of______or its capacity while developing a
program to perform read / write operations over the files

a) Hard disk
b) Scanner
c) Printer
d) Mouse

Answer: Hard disk

Question: The above point is possible because Java language
provides functionality of______

a) Files
b) Streams
c) Directories
d) Objects

Answer: Streams

Question: A______is an abstract representation of an input or output
device that is used as a source or destination for data.

a) File
b) Directory
c) Stream
d) Disk

Answer: Stream

Question: Visualize a______as a sequence of bytes that flows into the
program or that flows out of the program.

a) File
b) Directory
c) Stream
d) Disk

Answer: Stream

Question: One can write data or read data using_______
a) Files
b) Streams
c) Directories
d) Objects

Answer: Streams

Question: When data is written to stream, the stream is called
an________

a) Output stream
b) Input stream
c) I/O stream
d) Both (A) and (B)



13/09/2022, 20:05 CBSE Class 12 Computer Science File Handling MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-handling-mcqs-set-311074.html 13/21

Answer: Output stream

Question: The_______can transfer data from the program to a file on a
hard disk or a monitor or to some other computer over the network.

a) Output stream
b) Input stream
c) I/O stream
d) Both (A) and (B)

Answer: Output stream

Question: An______is used to read data from an external device to the
program.

a) Output stream
b) Input stream
c) I/O stream
d) Both (A) and (B)

Answer: Input stream

 

Question: _______can transfer data from keyboard or from the file on
a hard disk to the program.

a) Output stream
b) Input stream
c) I/O stream
d) Both (A) and (B)

Answer: Input stream

Question: The main reason for using streams for input or output
operations is to make our program independent of
the_______involved.

a) Hard Disks
b) Keyboards
c) Printers
d) Devices

Answer: Devices

Question: _______is advantage of using streams.
a) Programmer does not need to worry about the technical details of the device.
b) The program can work for a variety of input/ output devices without any changes to the source
code.
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: To understand byte streams and character streams, one
needs to differentiate between character and byte______

a) Representation
b) Collection
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c) Numbers
d) Particulars

Answer: Representation

Question: If '5' is represented as a Character, its ASCII value will
be______

a) 51
b) 52
c) 53
d) 54

Answer: 53

Question: If 5 is represented as a character, its binary representation
will be_______

a) 53
b) 5
c) 101
d) 00110101

Answer: 00110101

Question: If '5' is represented as a binary number, then its value will
be______

a) 53
b) 5
c) Five
d) 101

Answer: 5

Question: If '5* is represented as a binary number, then its binary
representation will be_______

a) 00000101
b) 11001100
c) 10101100
d) 11111000

Answer: 00000101

Question: A character is generally stored using ASCII or Unicode
format but when it is used for calculation purpose and then
it's________value is meaningful.

a) Binary
b) Actual
c) Objective
d) Text

Answer: Binary

Question: In the statement int i = 32, the_____is true.
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a) Declares 'i' as an integer type variable
b) That T stores number 32.
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: The number 32 can be represented as two
separate_______'3' and '2'.

a) Numbers
b) Values
c) Characters
d) All of these

Answer: Characters

Question: For numerical calculations, data types like int, float or
double are used, that allows storing the numbers in_______format.

a) Actual
b) Text
c) Character
d) Binary

Answer: Binary

Question: Java supports two types of streams_______stream
and______stream.

a) Byte
b) Character
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: ______transfer data in the form of bytes to the file or
devices are known as byte stream or binary stream.

a) Streams
b) Files
c) Data Flow
d) Commands

Answer: Streams

Question: The files that are created using______stream are known as
binary files.

a) Byte
b) Character
c) Both (A) and (B)
d) None of these

Answer: Byte
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Question: If variables are to be stores like integer, double or boolean
into a file, then_______files should be used.

a) Byte
b) Text
c) Character
d) Binary

Answer: Binary

Question: ______files can also be used to store arrays or objects.
a) Byte
b) Text
c) Character
d) Binary

Answer: Binary

Question: Similarly text files and program codes are created
using_______stream.

a) Byte
b) Character
c) Both (A) and (B)
d) None of these

Answer: Character

Question: Text files and program codes can be opened in text editors
like vi and SciTE.

a) SciTE
b) vi
c) Both (A) & (B)
d) None of these

Answer: Both (A) & (B)

Question: Java provides_____set of classes, character stream class and
binary stream class.

a) One
b) Two
c) Three
d) Four

Answer: Two
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b) Character
c) Both (A) and (B)
d) None of these

Answer: Byte

Question:

In the box A, the answer will be________

a) Stream
b) Byte
c) Output
d) Input

Answer: Stream

Question:

In the box B, the answer will be_______

a) Stream
b) Byte
c) Output
d) Input

Answer: Byte

Question:

In the box C, the answer will be______

a) Stream
b) Byte
c) Output
d) Character

Answer: Character

Question:
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In the box D, the answer will be______

a) Stream
b) Input
c) Output
d) Character

Answer: Input

Question:

In the box E, the answer will be____

a) Stream
b) Byte
c) Output
d) Character

Answer: Output

Question:

In the box F, the answer will be_______

a) Reader
b) Byte
c) Output
d) Input

Answer: Reader

Question: Java streams can be classified into______basic types.
a) One
b) Two
c) Three
d) Four

Answer: Two

Question: Java streams are namely input stream and_________stream.
a) Stream
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b) Byte
c) Output
d) Character

Answer: Output

 
Question: The_________stream reads data from the source (file,
keyboard).

a) Stream
b) Input
c) Output
d) Character

Answer: Input

Question: The_______stream writes data to the destination (file,
output device).

a) Stream
b) Byte
c) Output
d) Character

Answer: Output

Question: The______package contains a collection of stream classes
that support reading and writing in a file.

a) Java.io
b) Java.util
c) Java.package
d) All of these

Answer: Java.io

Question: _______stream classes are a group of classes available in
java.io package.

a) Input
b) Byte
c) Output
d) Character

Answer: Character

Question: Character stream classes can be used to read and
write________Unicode characters.

a) 8 bit
b) 16 bit
c) 32 bit
d) 64 bit

Answer: 16 bit

Question: _______stream classes can be further classified into reader
and writer classes.
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a) Input
b) Byte
c) Output
d) Character

Answer: Character

Question: ________classes are a group of classes designed to read
characters from files.

a) Writer
b) Reader
c) Output
d) Input

Answer: Reader

Question: The______classes are a group of classes designed to write
characters into a file.

a) Writer
b) Reader
c) Character
d) Byte

Answer: Writer

Question: Writer classes are inherited from the_______class.
a) Object
b) Writer
c) Reader
d) Character

Answer: Object

Question: Writer classes are______classes (classes that cannot be used
to create an object) and come with set of methods to be
implemented by its sub classes.

a) Intellectual
b) Abstract
c) Byte
d) Java.io

Answer: Abstract

Question: Input Stream Reader and Buffered Reader are the subclass
of_______class.

a) Object
b) Writer
c) Reader
d) Character

Answer: Reader

Question: ______class is the subclass of Input Stream Reader class.
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a) File Reader
b) File Writer
c) File java
d) Java File

Answer: File Reader

Question: Output Stream Writer, Buffered Writer and Print Writer are
the sub classes of_______class.

a) Object
b) Writer
c) Reader
d) Character

Answer: Writer

Question: File Writer class is the_______of Output Stream Writer class.
a) Super class
b) Sub.io
c) Sub class
d) Base class

Answer: Sub class

Question: Writer class is the______for writing a character stream.
a) Super class
b) Sub.io
c) Subclass
d) Baseclass

Answer: Baseclass

Question: The abstract_______class defines the functionality that is
available for all character output streams.

a) Object
b) Writer
c) Reader
d) Character

Answer: Writer

Question: Methods of______class are used by its sub classes.
a) Writer
b) Object
c) Reader
d) Character

Answer: Writer

Question: The writer method______closes the stream.
a) Void write (int)
b) Void close ()
c) Void write (Strings)
d) All of these
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Answer: Void close ()

Question: The writer method_______writes string 's' to the stream.
a) Void write (int C)
b) Void close ()
c) Void write(String s)
d) All of these

Answer: Void write(String s)

Question: The writer method________writes the lower 16 bits of 'c' to
the stream.

a) Void write (int C)
b) Void close 0
c) Void write(String s)
d) All of these

Answer: Void write (int C)

 

Question: The Output Stream_______class extends Writer class.
a) Writer
b) Object
c) Reader
d) Character

Answer: Writer

Question: The_______converts stream of characters to a stream of
bytes.

a) Input Stream
b) Output Stream
c) Reader Stream
d) Writer Stream

Answer: Output Stream

Question: The File Writer class extends______Writer and outputs
characters to a file.

a) Input Stream
b) Output Stream
c) Reader Stream
d) Writer Stream

Answer: Output Stream

Question: The File Writer class has________constructor which throws
IO Exception

a) File Writer (String file path)
b) File Writer (File file obj)
c) File Writer (String file path, Boolean append)
d) All of these

Answer: All of these
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Question: Which of the following constructor is of File Writer Class ?
a) File Writer (String file path)
b) File Reader (File file obj)
c) File Writer constructor
d) All of these

Answer: File Writer (String file path)

Question: In the constructor "__________", if append is true, characters
are appended to the end of file, otherwise the existing contents of
the file are overwritten.

a) File Writer (String file path)
b) File Writer (File file obj)
c) File Writer (String file path, Boolean append)
d) None of these

Answer: File Writer (String file path, Boolean append)

Question: In the following example - an object of_______can be
created. File Writerfwobject = new File Writer
("/Java/files/Charfilel.txt");

a) File Stream
b) File Writer
c) File Reader
d) File Demo

Answer: File Writer

Question: It is important to close the stream______after writing to a
file is accomplished.

a) Object
b) Reader
c) File
d) Directory

Answer: Object

Question: _______files consume system resources and depending on
the file mode.

a) Closed
b) Large
c) Small
d) Open

Answer: Open

Question: ________class is the base class for reading a character
stream.

a) Object
b) Reader
c) File
d) Directory
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Answer: Reader

 

Question: The abstract_______class defines the functionality that is
available for all character input streams.

a) Object
b) Reader
c) File
d) Directory

Answer: Reader

Question: ______class should be used in program to perform read
operations.

a) File Stream
b) File Writer
c) File Reader
d) File Demo

Answer: File Reader

Question: _________method of Reader class closes the stream.
a) Void close()
b) Int read()
c) Void read()
d) None of these

Answer: Void close()

Question: ________method of Reader class, reads next available
character from the stream, it returns "-1" to indicate the end of
stream.

a) Void close 0
b) Int read()
c) Void read()
d) None of these

Answer: Int read()

Question: The Input Stream Reader class extends______class.
a) Stream
b) Writer
c) Reader
d) Demo

Answer: Reader

Question: _______class converts a stream of bytes to a stream of
characters.

a) Stream
b) Writer
c) Reader
d) Demo
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Answer: Reader

Question: The_______class extends Input Stream Reader class and
reads characters from a file.

a) File Stream
b) File Writer
c) File Reader
d) File Demo

Answer: File Reader

Question: Which of the following is a File Reader constructor ?
a) File Reader (String file path)
b) File Reader (File file obj)
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: Which of the following is not a File Reader constructor ?
a) File Reader (String file path)
b) File Reader (File file obj)
c) Both (A) and (B)
d) File Reader(int i, int j)

Answer: File Reader(int i, int j)

Question: In the following example - an object of_______can be
created. File Reader frobject = new File Reader
("/Java/flles/Charfflel.txt");

a) File Reader
b) File Writer
c) Both (A) and (B)
d) File Demo

Answer: File Reader

Question: While reading from a file,______must identify that the file
has ended.

a) Program
b) Code
c) Class
d) Method

Answer: Program

Question: The Java_______method returns "-1" to identify the end of
data in the stream.

a) Close()
b) Read()
c) Print()
d) Write()
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Answer: Read()

Question: The______and_______classes in the java.io package, gives the
ability to read and write from and into files in the disk.

a) File lnput Stream
b) File Output Stream
c) File Reader Stream
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: The above mentioned streams are the sub classes
of______and______classes.

a) Reader Stream
b) Input Stream
c) Output Stream
d) Both (B) and (C)

Answer: Both (B) and (C)

Question: The file_______is a subclass of Output Stream and is used to
write bytes to the file or some output stream.

a) Reader Stream
b) Input Stream
c) Output Stream
d) Both (B) and (Q

Answer: Output Stream

Question: _______method of File Output Stream class closes the file
output stream and releases any system resources associated with the
stream.

a) Void write (int b)
b) Void close ()
c) Void write (byte [] b)
d) Void read()

Answer: Void close ()

Question: ________method of File Output Stream class writes the
specified byte to this file output stream.

a) Void write (int b)
b) Void close ()
c) Void write (byte [] b)
d) Voidread()

Answer: Void write (int b)

Question: ______method of File Output Stream class writes b.length
bytes from the specified byte array to this file output stream.

a) Void write(int b)
b) Void close()
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c) Void write (byte [] b)
d) Voidread()

Answer: Void write (byte [] b)

Question: The constructors of_______can accept either a string
containing the path to the file location or an object of the file class.

a) File Output Stream
b) File lnput Stream
c) File Reader Stream
d) File Constructor

Answer: File Output Stream

Question: The constructor File Output Stream (String name)
throws________

a) File Out of Bounds Exception
b) File Not Found Exception
c) File Found Exception
d) None of these

Answer: File Not Found Exception

 

Question: The constructor File Output Stream (File file) throws_______
a) File Not Found Exception
b) File Out of Bounds Exception
c) File Found Exception
d) None of these

Answer: File Not Found Exception

Question: The following example will create an instance
of________FileOutputStreamfosobject = new File Output Stream
("/home/Akash/myflle.txt");

a) File Output Stream
b) File lnput Stream
c) File Reader Stream
d) File Constructor

Answer: File Output Stream

Question: The_______is a subclass of Input Stream and is generally
used to read byte data from the files.

a) File lnput Stream
b) File Reader Stream
c) File Writer Stream
d) File Output Stream

Answer: File Output Stream

Question: ______method of File lnput Stream class reads a byte of
data from this input stream.

a) Void close( )
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b) Int read(byte[] b)
c) Int read( )
d) Void write()

Answer: Int read( )

Question: _______method of File lnput Stream class closes the file
input stream and releases any system resources associated with the
stream.

a) Void close( )
b) Int read(byte[] b)
c) Int read( )
d) Void write()

Answer: Void close( )

Question: ______method of FilelnputStream class reads up to b.length
bytes of data from this input stream into an array of bytes.

a) Void close( )
b) Int read(byte[] b)
c) Int read( )
d) Void write()

Answer: Int read(byte[] b)

Question: A_______can get input from live interaction through
keyboard / GUI or it may take input as command line arguments or
from the files.

a) Program
b) Code
c) Class
d) Method

Answer: Program

Question: _______class belongs to the java.util package.
a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Keyboard

Question: It provides various methods to read input from the______or
from the file.

a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Scanner
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Question: A special feature of this class is that it breaks the input
string into tokens (words) using a______

a) Delimiter
b) Printer
c) Console
d) White space

Answer: Delimiter

 
Question: _____is the default delimiter.

a) Delimiter
b) Printer
c) Console
d) White space

Answer: White space

Question: Each______can be of different type, for example a string like
"India-1947" can also be read as "String-int" values.

a) Symbol
b) Token
c) Word
d) Mark

Answer: Token

Question: Which of the following is not a Scanner related constructor
or method ?

a) Scanner (String str)
b) Scanner (Input Stream isobject)
c) Scanner (File fobject)
d) Scanner(Files i)

Answer: Scanner(Files i)

Question: A______object can be created from a string, file object or
Input Stream object.

a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Scanner

Question: The method______of Scanner class closes the Scanner.
a) Void close ()
b) String next()
c) Boolean has Next()
d) int nextlnt()

Answer: Void close ()

Question: The method_____of Scanner class returns the next token.
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a) Void close()
b) String next()
c) Boolean hasNext()
d) int nextlnt()

Answer: String next()

Question: The method______of Scanner class returns true if there is a
token in input.

a) Void close()
b) String next()
c) Boolean has Next()
d) int nextlnt()

Answer: Boolean has Next()

Question: The method_______of Scanner class scans the next token of
the input as Int.

a) Void close 0
b) String next()
c) Boolean has Next()
d) int nextlnt()

Answer: int nextlnt()

Question: The method______of Scanner class scans the next token of
the input as Float.

a) Float next Float( )
b) String next()
c) Boolean has Next()
d) int nextlnt()

Answer: Float next Float( )

Question: The method_______of Scanner class scans the next token of
the input as Line.

a) Float next Float( )
b) String next()
c) Boolean has Next()
d) String next Line( )

Answer: String next Line( )

Question: _______class can also be used to read from a file.
a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Scanner

Question: The_______class is especially used when the input is to be
types in hidden form (characters must not be echoed on the screen).
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a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Console

Question: The______class provides a method for reading password.
a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Console

Question: The Console class belongs to______package.
a) Java.io
b) Java.util
c) Java.class
d) Java.console

Answer: Java.io

Question: ________method of Console class is used to write a
formatted string to this console's output stream using the specified
format string and arguments.

a) String read Line( )
b) Char[ ] read Password()
c) Console printf(String format, Object args)
d) None of these

Answer: Console printf(String format, Object args)

Question: _______method of Console class reads a single line of text
from the console.

a) String readLine( )
b) Char[ ] readPassword()
c) Console printf(String format, Object args)
d) None of these

Answer: String readLine( )

Question: _______method of Console class reads a password or
passphrase from the console with echoing disabled.

a) String read Line()
b) Char[ ] read Password()
c) Console printf(String format, Object args)
d) None of these

Answer: Char[ ] read Password()

Question: Scanner class is used for performing which of the
following operations ?
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a) Read from a file
b) Navigate through a file
c) Scan a file
d) All of these

Answer: Read from a file

Question: Which of the following is correct syntax ?
a) Public static void main (String args[ ])
b) Public static void main (String args)
c) Public static void main(String args[ ])
d) Public static void main(String args[ ]);

Answer: Public static void main(String args[ ])

Question: The_______class provides a method for reading password.
a) Printer
b) Console
c) Scanner
d) Keyboard

Answer: Console
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Answer: Structure

Question: Both computer networks and external storage devices are
usually not as fast as internal components of a________

a) System
b) Computer
c) CPU
d) Workstation

Answer: Computer

Question: If the_______is used for file transfers, more time may be
taken in the transfer due to slow Internet speed.

a) Hard disk
b) Directory structure
c) Internet
d) RAM

Answer: Internet

Question: Heavy file transfers put load on the usually
clogged_______connection.

a) HTML
b) Structure
c) Broadband
d) Internet

Answer: Internet

Question: Unless the user or organization has unlimited_____plan,
higher amount of data may result in higher cost as well.

a) Usage
b) Structure
c) Broadband
d) Internet

Answer: Internet

Question: There is a need to reduce the amount of storage space
occupied by_______files (and entire directory structures), whenever
possible.

a) System
b) Computer
c) CPU
d) Workstation

Answer: Computer

Question: From a convenience point of view, in many cases it is also
desirable to have a single file to handle rather than a large bunch of
files or a complex_______structure.
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a) Directory
b) File
c) Memory
d) Hard disk

Answer: Directory

Question: ________scientists have developed techniques to place a
whole directory structure into a single file for convenience.

a) Peripheral
b) Computer
c) Expert
d) Research

Answer: Computer

Question: Computer scientists have developed techniques to place a
whole directory structure into a single file for convenience. Such a
file is called an________

a) Library
b) Archive
c) Collection
d) File

Answer: Archive

 

Question: The computer scientists have also developed a number
of________for reducing the storage requirements of computer files
and directory structures.

a) Methods
b) Systems
c) Procedures
d) Techniques

Answer: Techniques

Question: The above techniques (of Q 11) are called data
a) Solidarity
b) Firmness
c) Compression
d) Resolution

Answer: Compression

Question: Data________generally works by identifying repetition in the
data and encoding the data in a way that reduces or eliminates such
repetition.

a) Solidarity
b) Firmness
c) Compression
d) Resolution

Answer: Compression
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Question: Actual data compression programs use
sophisticated_______based on information theory to achieve even
greater reduction in size.

a) Algorithm
b) Instruction
c) Flowchart
d) Method

Answer: Algorithm

Question: Linux provides ready-made free and open source software
for managing______files.

a) Library
b) Archive
c) Collection
d) File

Answer: Archive

Question: The ready-made free open-source software for managing
archive files is called_______

a) Archive manager
b) Library manager
c) File manager
d) Directory explorer

Answer: Archive manager

Question: The________permits the user to combine may files or an
entire directory tree into a single file known as an archive.

a) Archive manager
b) Library manager
c) File manager
d) Directory explorer

Answer: Archive manager

Question: On Linux systems_______is the most common archive
format.

a) zip
b) rar
c) tar
d) gz

Answer: tar

Question: Full form of tar is_______
a) Tap achiever
b) Tape archiver
c) Tape archive resolution
d) None of these

Answer: Tape archiver
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Question: ________also provides the facility of compressing file
formats.

a) zip
b) rar
c) tar
d) zar

Answer: tar

Question: The most common compressed file formats are
the________file formats.

a) zip
b) tar.zip
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: The zip file format supports storing multiple files in a
single zip file, on_______

a) Unix
b) Linux
c) Windows
d) Android

Answer: Unix

Question: In_______systems the common practice is to combine the
files into a single uncompressed file in the tar format and then
compress the file in the zip format using gzip.

a) Unix
b) Linux
c) Windows
d) Android

Answer: Linux

Question: In Linux______is an open source archiving program.
a) GNU
b) gzip
c) zip
d) zip. rar

Answer: gzip

Question: A gzip file commonly has the extension_______
a) Tar.zip
b) tar.rar
c) tar.gz
d) tar.gzip

Answer: tar.gz
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Question: The gzip file is called a________
a) tar ball
b) rar ball
c) gar ball
d) zip ball

Answer: tar ball

Question: The_______is a very common format for distributing
software or bundles of files on the Linux platform.

a) Tar ball
b) Rar ball
c) Gar ball
d) Zip ball

Answer: Tar ball

Question: The_______format is also used by different applications
under different names.

a) GNU
b) gzip
c) zip
d) zip.rar

Answer: zip

Question: The JAR files used in Java and the OpenOffice.org office
suite file formats use_______compression.

a) GNU
b) Gzip
c) Zip
d) Zip.rar

Answer: Zip

Question: ______uses the extension part of the filename to identify
the file format when opening an archive and to select the file format
when creating a new archive.

a) Archive Manager
b) Library Manager
c) File Manager
d) Directory Explorer

Answer: Archive Manager

 

Question: ________can also be used to explore the contents of
archives, to extract files from the archives, to add new files to the
archive, to delete files from the archive, and perform other such
operations.

a) Archive Manager
b) Library Manager
c) File Manager
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d) Directory Explorer

Answer: Archive Manager

Question: There is no menu item to start the archive manager
by_______

a) Menu
b) Default
c) Simple steps
d) Stages

Answer: Default

Question: One can double-click on an archive file in the________file
browser to start the archive manager.

a) Chrome
b) Explorer
c) Nautilus
d) Firefox

Answer: Nautilus

Question: A new_______can be created by right-clicking a file or
directory and selecting the Compress option from the context menu.

a) Library
b) Archive
c) Collection
d) File

Answer: Archive

Question: By right-clicking a file or directory and selecting the
Compress option from the context menu, creates a new_______with
that file or directory as its contents.

a) Library
b) Archive
c) Collection
d) File

Answer: Archive

Question: Archive Manager can be added to the____sub menu of the
Application menu.

a) Programs
b) Application
c) Panel
d) Accessories

Answer: Accessories

Question: When an archive is open in the________the view is similar to
a directory open in the Nautilus file browser.
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a) Archive manager
b) Library manager
c) File manager
d) Directory explorer

Answer: Archive manager

Question: Double-clicking a______opens that directory and shows its
contents.

a) Directory
b) Menu
c) Icon
d) File

Answer: Directory

Question: The Up and Back buttons in the toolbar can be used to go
to the parent______(if it exists the archive) and the previous directory
(if any) respectively.

a) Directory
b) Menu
c) Icon
d) File

Answer: Directory

Question: The________helps us in creating and using archive files for
backup for transfer via external storage device, for transfer via
network for saving disk space, etc.

a) Archive manager
b) Library manager
c) File manager
d) Directory explorer

Answer: Archive manager

 

Question: _______has many built-in tools to play multimedia content
like audio, video, etc.

a) Linux
b) Unix
c) Ubuntu
d) Archive Manager

Answer: Ubuntu

Question: _______media player is great open source tool,
a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VCL



13/09/2022, 20:06 CBSE Class 12 Computer Science File System MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-system-mcqs-set-311102.html 9/21

Question: _____is a short form of Video LAN client.
a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VLC

Question: ______is popular because of its versatility and features.
a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VLC

Question: Started as an academic project by the music-loving
students of a university in Paris, _____ is now a community project
available under multiple operating systems and has been
downloaded over a billion times.

a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VLC

Question: One of the issues faced with _____content is that there are a
variety of ways of converting multimedia information coming from
hardware devices (audio / video streams) into computer data and
then converting the computer data back into audio / video streams
for playing on the hardware devices.

a) Multimedia
b) Hypermedia
c) Software
d) Interactive program

Answer: Multimedia

Question: The conversion (coding) and reverse conversion
(decoding) is performed by a software component called________

a) Coder
b) Decoder
c) Code decoder
d) Codec

Answer: Codec

Question: The full form of______is coder decoder.
a) Coder
b) Decoder
c) Code decoder
d) Codec
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Answer: Codec

Question: Each multimedia data format requires its own_______
a) Coder
b) Decoder
c) Codec
d) Code decoder

Answer: Codec

Question: The advantage of VLC is that it supports all the popular
codecs and hence all the popular_______

a) Set-ups
b) Formats
c) Presentations
d) Plans

Answer: Formats

Question: ______also supports all the major types of devices including
web cameras, HD monitors, speakers of all types, microphones,
headphones.

a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VLC

Question: _______can convert multimedia files from one format to
another.

a) Windows Media Player
b) VLC
c) VCL
d) QuickTime

Answer: VLC

Question: ______can also stream (send) audio / video to and receive
audio / video from another computer (s) over the network.

a) Windows Media Player
b) VCL
c) VLC
d) QuickTime

Answer: VLC

Question: An entire directory can be opened using the Media 
Open_______option.

a) Directory
b) Menu
c) Icon
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d) File

Answer: Directory

Question: If a directory is opened_________will actually open all media
flies in that directory playable by it.

a) Windows Media Player
b) VCL
c) VLC
d) QuickTime

Answer: VLC

Question: When one or more flies are opened, they are added to
the________of the media player.

a) Filelist
b) Quicklist
c) Medialist
d) Playlist

Answer: Playlist

Question: The_______is a list of media files (tracks) to be played.
a) Filelist
b) Quicklist
c) Medialist
d) Playlist

Answer: Playlist

Question: One can play the media in the________in sequence, or in
random order.

a) Filelist
b) Quicklist
c) Media list
d) Playlist

Answer: Playlist

Question: The________can be opened using the View  Playlist option
and saved using the Media � Save Playlist to File option.

a) Filelist
b) Playlist
c) Quicklist
d) Medialist

Answer: Playlist

Question: VLC supports multiple file formats for playlist,
but_________is more common.

a) M3U
b) MU3
c) UM3
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d) MP3

Answer: M3U

 

Question: At the bottom of the window, VLC displays a______bar
showing how much of the current track has been played and what is
its total duration.

a) Growth
b) Progress
c) Development
d) Improvement

Answer: Progress

Question: In VLC Player, when the track is playing, the play button
turns into a______button.

a) Still
b) Progress
c) Pause
d) Stop

Answer: Pause

Question: The______button on the player has two parallel bars on it.
a) Play
b) Progress
c) Pause
d) Stop

Answer: Pause

Question: In the VLC player, if the playback is paused, the button
reverts back to______mode.

a) Play
b) Progress
c) Pause
d) Stop

Answer: Play

Question: In full screen mode of VLC player, the_____like play / pause,
stop is hidden.

a) Panels
b) Controls
c) Switches
d) Buttons

Answer: Controls

Question: The_______of the VLC player can be displayed in a
temporary floating window by moving the mouse cursor over the
video.
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a) Panels
b) Controls
c) Switches
d) Buttons

Answer: Controls

Question: VLC can also be used to_______multimedia files from one
format to another.

a) Alter
b) Change
c) Convert
d) Transform

Answer: Convert

Question: The______button can be used to start the conversion
process of the multimedia files from one format to another.

a) Convert / Save
b) Convert / Open
c) Convert / File
d) Convert / Format

Answer: Convert / Save

Question: Google maps is a free Internet-based service provided
by_______

a) Microsoft
b) Netscape
c) Apple, Inc
d) Google, Inc

Answer: Google, Inc

Question: ________has, over a period of years, collected extensive map
data for the whole earth through various means like satellite
imagery, cars with cameras mounted on them, data purchased from
other organizations and data provided by millions of individual users
around the world.

a) Microsoft
b) Google
c) Apple
d) Htc

Answer: Google

 

Question: ________allows anybody to edit the maps and identify
landmarks, buildings, etc.

a) Google
b) Google watch
c) Google maps
d) Google games

Answer: Google maps
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Question: _______also allows users to upload photographs of the
place and post reviews of the place.

a) Google
b) Google watch
c) Google maps
d) Google games

Answer: Google maps

Question: The service is also heavily used on_______devices like
smartphones and tablets.

a) Mobile
b) Desktop
c) Computer
d) All of these

Answer: Mobile

Question: The Google maps service can be accessed from the web
browser by opening the web site http://www.google.co.in and
selecting the______option from the top menu.

a) Games
b) Maps
c) Tools
d) Bookmarks

Answer: Maps

Question: The Google maps service can be directly visited by
entering the________http://maps.google.co.in.

a) URL
b) Address
c) Resource
d) Locator

Answer: URL

Question: The______service can be accessed from the mobile phone's
web browser as well as from the Google maps application.

a) Google
b) Google watch
c) Google maps
d) Google games

Answer: Google maps

Question: On a mobile phone, the user's location can be known with
very high accuracy if the______facility is used.

a) GPRS
b) 2G
c) 3G
d) GPS

http://www.google.co.in/
http://maps.google.co.in/
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Answer: GPS

Question: Full form of GPS is_______
a) Global Placing System
b) Global Positioning System
c) Global Putting System
d) Global Positioning Scheme

Answer: Global Positioning System

Question: The_____finds a user's location with an estimated error of
only few meters using satellite signals.

a) GPRS
b) 2G
c) 3G
d) GPS

Answer: GPS

Question: _______allow the user to correct the location, if it is
inaccurate.

a) Google
b) Google watch
c) Google maps
d) Google games

Answer: Google maps

Question: The map can be scrolled (pan) by dragging it in different
directions or by clicking on the arrows in a______on the left hand side.

a) Circle
b) Scroll
c) Bar
d) Box

Answer: Circle

Question: A vertical slider_____on the left allows us to zoom in and
out on the map.

a) Circle
b) Scroll
c) Bar
d) Box

Answer: Bar

Question: By clicking on the Satellite______the view can be switched
to the satellite image.

a) Panel
b) Control
c) Switch
d) Button
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Answer: Button

Question: In the Satellite view, the images taken by______in the sky
are shown.

a) Satellites
b) Digital camera
c) Hybrid camera
d) Planets

Answer: Satellites

Question: On a highway or in a crowded city area, walking or driving,
the______service decides the route based on the current location and
destination and guides with on-screen as well as voice (spoken)
instructions.

a) Google tools
b) Google watch
c) Google maps
d) Google games

Answer: Google maps

Question: The Google maps service even provides turn-by-turn
guidance while travelling if a mobile phone device is equipped
with______receiver.

a) GPRS
b) 2G
c) 3G
d) GPS

Answer: GPS

Question: Government organizations and businesses use the Google
maps service to provide people_______on how to reach their offices.

a) Information
b) Data
c) Facts
d) Documents

Answer: Information

Question: The service also has a facility using which anyone can
display a map of any place on one's_______

a) Books
b) Website
c) Office
d) Files

Answer: Website

Question: Tourist information websites and Tourism departments
of________also make use of this service.
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a) Groups
b) Businesses
c) Governments
d) Organizations

Answer: Governments

Question: Google maps can also be used to______-bus routes, current
location of running trains, etc.

a) Display
b) Exhibit
c) Present
d) Demonstrate

Answer: Display
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Question: R command for accessing on line help is
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d) Help.start()
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Question: R command for viewing some demonstration! is________
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d) Demo()

Answer: Demo()
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Question: R command to open the on line help in aj browser
is_________

a) On-line help()
b) Assist()
c) Help()
d) Help.start()

Answer: Help.start()

Question: To get help on a particular function_____I help (function
name) can be used.

a) Syntax
b) Function
c) Composition
d) Grammar

Answer: Syntax

Question: While quitting R, the software prompts whether
the_______values of variables) has to be saved, from the current
session.

a) Information
b) Data
c) Variables
d) All of these

Answer: Data

Question: The function_______displays a list of all the variables
defined.

a) List_variables()
b) Disp()
c) List()
d) ls()

Answer: ls()

Question: A series of consecutive numbers (range) may be generated
using the syntax_________

a) Begin rend
b) Start :end
c) Base :end
d) None of these

Answer: Start :end

Question: In R software________function can be used to find the
minimum value for a list.

a) Median(list)
b) Mean(list)
c) Max(list)
d) Min(list)
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Answer: Min(list)

Question: In R software_______function can be used to find the
maximum value for a list.

a) Median(list)
b) Mean(list)
c) Max(list)
d) Min(list)

Answer: Max(list)

Question: In R software______function can be used to find the mean
for a list.

a) Median(list)
b) Mean(list)
c) Max(list)
d) Min(list)

Answer: Mean(list)

 
Question: In R software,_______function can be used to find the
median for a list.

a) Median(list)
b) Mean(list)
c) Max(list)
d) Min(list)

Answer: Median(list)

Question: In R software, the function________with various arguments
is used for drawing a plot.

a) Plotbar
b) Bar_plot
c) Barplot
d) Bar-plot

Answer: Barplot

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The first argument (no_students) specifies the______list.

a) Data
b) Info
c) Student
d) Variable

Answer: Data

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
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students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: All other arguments have the form________

a) Name=variable
b) Value^name
c) Name=value
d) Variable=name

Answer: Name=value

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The argument______is used to specify the main title in
the plot.

a) Main
b) Xlab
c) Ylab
d) Ylim

Answer: Main

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques : The argument_______is used to specify the X-axis label
in the plot.

a) Main
b) Xlab
c) Ylab
d) Ylim

Answer: Xlab

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The argument________is used to specify the Y-axis label
in the plot.

a) Main
b) Xlab
c) Ylab
d) Ylim

Answer: Ylab

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The argument______is used to specify the values to be
displayed for the bars of the plot.

a) Names.arg
b) Names.org
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c) Names.list
d) Names.ylim

Answer: Names.arg

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The argument_____is used to specify the range of values
to be plotted on the Y-axis in the plot.

a) Main
b) Xlab
c) Ylab
d) Ylim

Answer: Ylim

Question: Related to R commands : >barplot (no_students,
main="Faculty wise students", xlab= "faculty", + ylab= "Number of
students", names. arg=faculty_names, +ylim=c (0, 1000), border=
"blue") Ques: The argument_______is used to specify the border color
in the plot.

a) Main
b) Xlab
c) Ylab
d) Border

Answer: Border

Question: In R software, for long commands, when Enter is pressed
before the command is complete, R issues the_____prompt until the
command is completed.

a) #
b) *
c) >
d) +

Answer: +

Question: In R software, by_______the graph does not have grid lines.
a) Default
b) Command
c) Argument
d) None of these

Answer: Default

Question: Using R software________can also be produced.
a) Diagrams
b) Histograms
c) Figures
d) Flowcharts
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Answer: Histograms

Question: _________is one such open source software designed to
assist project managers in preparing, maintaining and following a
well-defined project plan.

a) Rational_Plan
b) Rational-Plan
c) Rational Plan
d) Plan Rational

Answer: Rational Plan

Question: _____assists the project managers throughout the life cycle
of their projects.

a) RationaL Plan
b) Rational-Plan
c) Rational Plan
d) Plan Rational

Answer: Rational Plan

Question: ______comprises three different desktops products.
a) RationaL Plan
b) Rational-Plan
c) Rational Plan
d) Plan Rational

Answer: Rational Plan

Question: Rational Plan comprises of the________desktop product.
a) Single
b) Multi
c) Viewer
d) All of these

Answer: All of these

Question: Rational Plan________.allows the users to manage
independent projects that do not have common resources and has
no interrelations between different projects.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Single

Question: Rational n Plan_______allows the manager to associate
general project information like name, notes, links, assumptions,
constraints or risks.

a) Single
b) Multi
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c) Viewer
d) All of these

Answer: Single

Question: Rational Plan_______allows creating, editing and deleting
calendars, building schedules.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Single

 

Question: Rational Plan_________provides project tracking tools such
as critical path, mark completion value for tasks, work and cost time
phased information.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Single

Question: Using______a printable report can be generated as well as
data can be imported from other project management tool or data
can be exported into other formats.

a) RationaL Plan
b) Rational-Plan
c) Rational Plan
d) Plan Rational

Answer: Rational Plan

Question: Rational Plan_______allows the user to manage projects that
share company resources across projects.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Multi

Question: Rational Plan______also manages interdependence's
between projects.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Multi
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Question: Rational Plan________includes all the features of Rational
Plan Single Project.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Multi

Question: Rational Plan_______calculates the resources data (work,
cost, over allocation) considering their assignments in all projects.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Multi

Question: Rational Plan________allows links between tasks pertaining
to different projects, analyzes all our projects data and creates a
project Portfolio view.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Multi

Question: Rational Plan______is an additional tool developed to share
the project in its original file format (.xrp), but it can be used as well
to open Microsoft Project files.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Viewer

Question: Rational Plan_________is useful to anybody who needs to
check and overview the project's evolution without making changes
to the schedule, and for resources to see their assignments.

a) Single
b) Multi
c) Viewer
d) All of these

Answer: Viewer

Question: As of today, the support of______on Ubuntu 10.04 has been
removed; it is available for Ubuntu 12.04 and later versions.

a) RationaL Plan
b) Rational-Plan
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c) RationalPlan
d) PlanRational

Answer: RationalPlan

 

Question: Today________instant messaging service is being used.
a) Yahoo Messenger
b) Google Talk
c) Rediff Bol
d) All of these

Answer: All of these

Question: The instant messaging services are used for real time
like_______

a) Chatting with text
b) Audio
c) Video
d) All of these

Answer: All of these

Question: _______is one such software that allows the users to make
calls over the Internet using computer systems.

a) Skype
b) Word
c) Excel
d) R software

Answer: Skype

Question: The______service allows users to communicate with peers
using voice, video as well as text.

a) HTML
b) Media Player
c) VLC
d) Skype

Answer: Media Player

Question: _______also provides additional features like file transfer
and videoconferencing.

a) Skype
b) Internet
c) VLC
d) R software

Answer: Skype

Question: The Skype software can be downloaded free of cost,
though its source code is______and not available for modification.

a) Viewable
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b) Proprietary
c) Open-source
d) Branded

Answer: Branded

Question: To use______a working sound input and output
configuration is needed.

a) Rational Plan
b) Skype
c) Word
d) R software

Answer: Skype

Question: To start Skype, choose Application → Internet
a) Skype
b) Java
c) Ubuntu
d) R software

Answer: Skype

Question: If Skype is being opened for the first time, it will open an
end User License________window.

a) Arrangement
b) Treaty
c) Agreement
d) Contract

Answer: Agreement

Question: To use Skype service, a______user account is needed.
a) Skype
b) Ubuntu
c) Rational Plan
d) R software

Answer: Skype

 

Question: The______service also provides the facility of finding the
nearest ATM Centre, Bank, Restaurant, Bus-stop or any other such
essential place.

a) Google Tools
b) Google Watch
c) Google Maps
d) Character Maps

Answer: Google Maps

Question: The________program can be used to enter Unicode
characters into any application.
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a) Character Symbol
b) Character Map
c) Character Code
d) Character Application

Answer: Character Map

Question: From the_______program Script has to be selected from the
left pane first and then double click characters to insert them into
the Test to copy area below.

a) Character Symbol
b) Character Map
c) Character Code
d) Character Application

Answer: Character Map

Question: While using______program, spaces and punctuation can be
entered by the user from the keyboard directly into the area after
clicking in it.

a) Character Map
b) Character Codes
c) Google Maps
d) Character Selection

Answer: Character Map

Question: Brief details of the character currently selected with single-
click or entered with double-click are shown in the status line at the
bottom, while more details on the character is available in
the______tab.

a) Character Details
b) Character Map
c) Character Tools
d) Google Maps

Answer: Character Details

Question: A_______is good solution if one has to type a few characters
in another script occasionally.

a) Character Details
b) Character Map
c) Character Tools
d) Google Maps

Answer: Character Details

Question: ______is a free software environment for statistical
computing.

a) P
b) Q
c) R
d) GNU
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Answer: R

Question: R software is a_______project.
a) P
b) Q
c) R
d) GNU

Answer: GNU

Question: ______software is widely used for statistical analysis.
a) P
b) Q
c) R
d) GNU

Answer: R

Question: R software has its own_______language.
a) Scripting
b) Object-oriented
c) Simple
d) Programming

Answer: Scripting

 

Question: ______software has a case-sensitive language.
a) P
b) Q
c) R
d) GNU

Answer: R

Question: R software has______work environments namely Command
Line and Graphical.

a) one
b) Two
c) Three
d) Four

Answer: Two

Question: To use R software in a_______environment, it has to be
installed with graphic editors.

a) DOS
b) Windows
c) GUI
d) All of these

Answer: GUI
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Question: Examples of Graphic Editors are_______
a) R Commander
b) R Studio
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: The above named Graphic Editors are from______Software
Center.

a) Linux
b) Unix
c) Ubuntu
d) Archive Manager

Answer: Ubuntu

Question: To install R software on the machines, give
the______command.

a) Sudo apt-get install r-base r-base-devlop
b) Studio apt-get install r-base r-base-dev
c) Sudo apt-get install r-base r-base-dev
d) None of these

Answer: Sudo apt-get install r-base r-base-dev

Question: To invoke the_______scripts from terminal window, open
terminal and type on the command prompt.

a) Unix
b) Linux
c) R
d) Shell

Answer: R

Question: Just like the Linux shell, R uses______as the comment
marker.

a) #
b) //
c) /* */
d) ?

Answer: #

Question: Any text following_______up to the end of the line, is
treated as a comment.

a) #
b) //
c) /* */
d) ?

Answer: #
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Question: In R software, number and string are the basic________
a) Method Types
b) Declaration Types
c) Data Types
d) Variable Types

Answer: Data Types

Question: In R software_______are enclosed in single quotes or double
quotes.

a) Numbers
b) Strings
c) Characters
d) Commands

Answer: Strings

Question: In R software, common________and functions are available,
just like other programming languages.

a) Commands
b) Operators
c) Numerals
d) Characters

Answer: Operators

Question: Ordered lists of items (arrays or lists) are commonly used
and are also referred to as______

a) Vectors
b) Paths
c) Routes
d) Directions

Answer: Vectors

Question: Lists are created using the_______function to combine
several numbers into a single list.

a) C++
b) Basic
c) c
d) ls

Answer: c

Question: Most operators in R software, like +, -, *, /, and others
work equally well on single________as well as on lists.

a) Number
b) String
c) Character
d) Operand

Answer: Number
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Question: However, in R software, when both_______of binary
operators are lists, their lengths (number of elements in them)
should ordinarily be same.

a) Numbers
b) Strings
c) Characters
d) Operands

Answer: Operands

Question:

The statement > a <-- 10 defines a______'a' and assigns it a value 10.

a) Numeral
b) Letter
c) String
d) Variable

Answer: Variable

Question:

The statement > a followed by..........key press displays the value of a.

a) ENTER
b) TAB
c) SHIFT
d) F2

Answer: ENTER

Question:
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The statement > a*b followed by _____key press multiplies the value of variable 'a' and 'b' and
displays the result on the prompt.

a) ENTER
b) TAB
c) SHIFT
d) F2

Answer: ENTER

Question: R command to quitting is_______
a) Quit()
b) q()
c) Exit
d) All of these

Answer: q()
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a) I-newspaper
b) Internet-newspaper
c) www-newspaper
d) E-newspaper

Answer: E-newspaper

Question: Which of the following is the process of buying and selling
products by offering the customers to bid the price ?

a) Marketing
b) Auction
c) Bookshop
d) Booking

Answer: Auction

Question: Which of the following is known as the process of
conducting the banking transactions over the Internet ?

a) Auction
b) Bidding
c) Net banking
d) www-banking

Answer: Net banking

Question: Which of the following is a feature of traditional commerce
?

a) Operates within a certain period of time or during business hours.
b) Advertising of the product is done electronically.
c) E-payments systems are used for receiving payment.
d) Customers can browse through products and offers.

Answer: Operates within a certain period of time or during business hours.

Question: Which of the following is a feature of E-commerce ?
a) Operates within a certain period of time or during business hours.
b) No sharing of information with competitors.
c) Location renting or purchasing.
d) Advertising of the product is done electronically.

Answer: Advertising of the product is done electronically.

Question: Which of the following is not an advantage of E-commerce
?

a) Lower cost
b) Conduct business 24 x 7
c) Security
d) No geographical limitations

Answer: Security

Question: Which of the following is a disadvantage of E-commerce ?
a) Privacy
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b) Improved customer service
c) Speed
d) Conduct business 24 x 7

Answer: Privacy

Question: Which of the following E-commerce business model refers
to business and organizations that sell products or services to
consumers over the Internet using websites ?

a) Business to Consumer (B2C)
b) Business to Business (B2B)
c) Consumer to Business (C2B)
d) Government to Business (G2B)

Answer: Business to Consumer (B2C)

Question: Which of the following E-commerce business model refers
to activities between different business partners ?

a) Government to Business (G2B)
b) Consumer to Business (C2B)
c) Business to Business (B2B)
d) Business to Consumer (B2C)

Answer: Business to Business (B2B)

 
Question: Which of the following is a good example of C2C model ?

a) Auction sites
b) E-newspaper
c) Online purchasing
d) Information services

Answer: Auction sites

Question: Which of the following E-commerce business model refers
to E-commerce activities involving transactions between and among
the consumers ?

a) Government to Business (G2B)
b) Consumer to Consumer (C2C)
c) Business to Business (B2B)
d) Business to Consumer (B2C)

Answer: Consumer to Consumer (C2C)

Question: Which of the following E-commerce business model
involves reverse auctions where the consumers determine the prices
of the products or services ?

a) Consumer to Business (C2B)
b) Business to Business (B2B)
c) Consumer to Consumer (C2C)
d) Government to Business (G2B)

Answer: Consumer to Business (C2B)
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Question: Which of the following e-commerce business model is also
a part of E-governance ?

a) Business to Business (B2B)
b) Consumer to Business (C2B)
c) Consumer to Consumer (C2C)
d) Government to Citizen (G2C)

Answer: Government to Citizen (G2C)

Question: Which of the following E-commerce business model refers
to online non-commercial communication between the Government
agencies, organizations and departments with other Government
agencies, organizations and departments ?

a) Business to Business (B2B)
b) Consumer to Business (C2B)
c) Government to Government (G2G)
d) Consumer to Consumer (C2C)

Answer: Government to Government (G2G)

Question: Website of an educational institute provides information
regarding various_____

a) Courses contents
b) Students
c) Faculty
d) All of these

Answer: All of these

Question: Website of business organization provide information
regarding their______

a) Products
b) Suppliers
c) Banks
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: Last few decades Internet has become very popular
among_____

a) Individuals
b) Business organizations
c) Both (A) and (B)
d) Villagers

Answer: Both (A) and (B)

Question: Today, internet is being used by people for_____
a) Shopping
b) Paying bills
c) Banking
d) All of these

Answer: All of these
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Question: The use of Internet for conducting any business activities is
known as_____

a) E-commerce
b) F-commerce
c) G-commerce
d) None of these

Answer: E-commerce

Question: Products like____are traded online.
a) Books
b) Gadgets
c) Tickets
d) All of these

Answer: All of these

Question: Today many businesses have set up their own
a) Offices
b) Websites
c) Farms
d) Factories

Answer: Websites

Question: The major areas of business and commercial activities
where E-commerce is widely used today is______

a) Banking and insurance
b) Auction of goods
c) Marketing and selling
d) All of these

Answer: All of these

Question: _____was one of the first applications of E-commerce on
Internet.

a) Scrabble
b) Facebook
c) Bookshops
d) Play Store

Answer: Bookshops

Question: Customers prefer purchasing books via_____
a) Internet
b) Physical store
c) A mall
d) Banks

Answer: Internet

Question: Online book stores should have____on their website.
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a) Categories
b) Picture and description
c) Price and reviews
d) All of these

Answer: All of these

Question: an online book store the search of the book should be by
its_____

a) Publishers
b) Title
c) Author
d) All of these

Answer: All of these

Question: _____is an online bookstore website.
a) www.amazon.com
b) www.gswan.gov.in
c) www.irctc.co.in
d) None of these

Answer: www.amazon.com

Question: _____is not an online bookstore website.
a) www.amazon.com
b) www.shopping.indiatimes.com
c) www.irctc.co.in
d) www.bookshopofindia.com

Answer: www.irctc.co.in

Question: An electronic newspaper is also known as
a) Elec-Paper
b) E-newspaper
c) M-Paper
d) E-Paper

Answer: E-newspaper

 

Question: The electronic newspaper has advantage over the______
a) Printed newspaper
b) Television news
c) Radio news
d) All of these

Answer: All of these

Question: With the advent of _______technologies, the browser can be
set to select the news as interest of the reader.

a) Digital
b) Hybrid
c) Android
d) Analog

http://www.amazon.com/
http://www.gswan.gov.in/
http://www.irctc.co.in/
http://www.amazon.com/
http://www.amazon.com/
http://www.shopping.indiatimes.com/
http://www.irctc.co.in/
http://www.bookshopofindia.com/
http://www.irctc.co.in/
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Answer: Digital

Question: The Electronic newspaper removes the hassle
of_________process.

a) Reading
b) Printing
c) Writing
d) Browsing

Answer: Printing

Question: ______is an example of E-newspaper.
a) Flipkart
b) Amazon
c) Washington Post
d) Washington DC

Answer: Washington Post

Question: www.buybooksindia.com is an online website.
a) Government
b) Railway
c) Newspaper
d) Bookstore

Answer: Bookstore

Question: An_____is the process of buying and selling products or
services to the highest bidder.

a) Bidding
b) Auction
c) Selling
d) Buying

Answer: Auction

Question: The_______auctions have very limited participation of
people.

a) Traditional
b) Physical
c) Stand alone
d) Small

Answer: Traditional

Question: Auctions implemented using E-commerce technologies are
known as_____auction.

a) Traditional
b) Physical
c) Stand alone
d) Online

Answer: Online

http://www.buybooksindia.com/
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Question: Auction websites provide the platform for both the seller
and the_______

a) Buyers
b) Bidders
c) Members
d) All of these

Answer: Bidders

Question: The person who places the product on the website is
known as the______

a) Seller
b) Bidder
c) Member
d) None of these

Answer: Seller

 

Question: The person who bids for a product on the website is
known as the________

a) Seller
b) Bidder
c) Member
d) None of these

Answer: Bidder

Question: To sell an item through an online site, there is a need
to_____with the site.

a) Sell
b) Buy
c) Register
d) Have contact

Answer: Register

Question: _________of the auction website are required to provide
their basic contact information.

a) Seller
b) Bidder
c) Member
d) None of these

Answer: Member

Question: _____is an auction website.
a) Ebay.com
b) Flipkart.com
c) Gswan.gov.in
d) incometax.com

Answer: Ebay.com
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Question: Various______options are provided to the bidder on the
auction site.

a) Payment
b) Selection
c) Bidding
d) Selling

Answer: Payment

Question: _____is a not a website for online auction.
a) www.onlineauction.com
b) www.mybids.in
c) www.ubid.com
d) www.flipkart.com

Answer: www.flipkart.com

Question: ________is an auction website.
a) www.irctc.co.in
b) www.ubid.com
c) www.bsnl.co.in
d) www.astroved.com

Answer: www.ubid.com

Question: Now-a-days many business websites provide their
product______online over Internet.

a) Catalogue
b) Images
c) Videos
d) All of these

Answer: All of these

Question: The customers select the products from the websites by
adding them to an online______

a) Box
b) Corner
c) Shopping cart
d) File

Answer: Shopping cart

Question: After shopping online the user needs to
provide_____details.

a) Shipping
b) User
c) Payment
d) Booking

Answer: Shipping

http://www.onlineauction.com/
http://www.mybids.in/
http://www.ubid.com/
http://www.flipkart.com/
http://www.flipkart.com/
http://www.irctc.co.in/
http://www.ubid.com/
http://www.bsnl.co.in/
http://www.astroved.com/
http://www.ubid.com/


13/09/2022, 20:07 CBSE Class 12 Computer Science Introduction To E Commerce MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-e-commerce-mcqs-set-311022.html 10/32

Question: Today______can be purchased through Internet.
a) Groceries
b) Toys
c) Mobile
d) All of these

Answer: All of these

Question: Now-a-days some websites provide holiday packages
along with______

a) Clothes
b) Airline tickets
c) Mobiles
d) Toys

Answer: Airline tickets

Question: _______is the Indian railways website for booking railway
tickets.

a) Railways.com
b) Tickets.co.in
c) Irctc.co.in
d) Railtickets.co.in

Answer: Railways.com

Question: The ticket booked on the Indian Railway site is sent to the
users mail and is called_______of the ticket.

a) R-copy
b) Ticket copy
c) E-copy
d) T-copy

Answer: E-copy

Question: The booked ticket details is also sent to the users mobile in
the form of a_________

a) Mail
b) Phone Call
c) SMS
d) LMS

Answer: SMS

Question: ________is the popular site used for marketing and selling.
a) www.homeshopl8.com
b) www.flipkart.com
c) www.myntra.com
d) All of these

Answer: All of these

Question: In online billing companies send their bills through_________

http://www.homeshopl8.com/
http://www.flipkart.com/
http://www.myntra.com/
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a) E-mail
b) Fast-Mail
c) Slow-Mail
d) Post

Answer: E-mail

Question: The bills can be paid online on the company's website
using_________

a) Credit card
b) Debit card
c) Both (A) and (B)
d) cheque

Answer: Both (A) and (B)

Question: Example for paying online bills is______
a) Electric bill
b) BSNL
c) Food
d) Clothes

Answer: BSNL

Question: Educational institutes and universities provide
the________online.

a) Results
b) Enrollment forms
c) Exam schedule
d) All of these

Answer: All of these

 

Question: Students can view their_________using the website from
anywhere.

a) Results
b) Enrollment forms
c) Exam schedule
d) All of these

Answer: All of these

Question: Many organizations provide various_______to be
downloaded to use them.

a) Forms
b) Information
c) Database
d) None of these

Answer: Forms

Question: Companies can also get the information or details about
the customers by filling the____online.
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a) Forms
b) Information
c) Database
d) None of these

Answer: Forms

Question: After selling the products, companies provide______support
to the customer.

a) Physical
b) Medical
c) Online
d) All of these

Answer: Online

Question: An online complaint about any sold electronic product is
forwarded to the support.

a) Doctor
b) Member
c) Engineer
d) Teacher

Answer: Engineer

Question: The online complaint______can be tracked online.
a) Status
b) Support
c) Maintenance
d) Question

Answer: Status

Question: Software vendors allow their________customers to
download the recent updates of the software.

a) Legal
b) Licensed
c) Permitted
d) Special

Answer: Licensed

Question: Hardware vendors allow their customers to download the
device_____from their website.

a) Model
b) Type
c) Name
d) Driver

Answer: Driver

Question: Another name for Electronic Banking is________
a) E-Banking
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b) Internet-Banking
c) Net-Banking
d) None of these

Answer: Net-Banking

Question: ________banking is the process of conducting the banking
transactions over the Internet.

a) Online
b) Offline
c) Click
d) Password

Answer: Online

Question: With the help of online banking customers can avail
the_____service.

a) Check account balance at any time.
b) Transfer the money from one account to other
c) Obtain statements for any credit or debit
d) All of these

Answer: Check account balance at any time.

 
Question: In online banking customers cannot______

a) Physically deposit a cheque
b) Find transaction status
c) Pay various bills like telephone, electricity
d) Request for a cheque book.

Answer: Physically deposit a cheque

Question: For online banking the customer is provided with
a________to logon to the bank site.

a) PAN
b) TIN
c) Password
d) Cheque number

Answer: Password

Question: The URL of State Bank of India is_______
a) www.sbi.com
b) www.sbionline.com
c) www.statebankofindia.com
d) www.onlinesbi.com

Answer: www.onlinesbi.com

Question: With online banking, money can be transferred from
one_______to another.

a) Website
b) Account

http://www.sbi.com/
http://www.sbionline.com/
http://www.statebankofindia.com/
http://www.onlinesbi.com/
http://www.onlinesbi.com/
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c) Page
d) File

Answer: Account

Question: The URL of Central Bank of India is_________
a) www.centralbankofindia.com
b) www.centralbankofindia.co.in
c) www.cbofindia.com
d) www.onlinecbi.com

Answer: www.centralbankofindia.co.in

Question: The URL of Bank of Baroda is______
a) www.bankofbaroda.co.in
b) www.bob.com
c) www.bobaroda.com
d) www.onlinebob.com

Answer: www.bankofbaroda.co.in

Question: The URL of Indian Overseas Bank is________
a) www.iob.in
b) www.iob.com
c) www.iob.co.in
d) www.onlineiob.com

Answer: www.iob.in

Question: The URL of Dena Bank is_________
a) www.denabank.in
b) www.denabank.com
c) www.denabank.co.in
d) www.onlinedenabank.com

Answer: www.denabank.co.in

Question: In_______commerce, the businesses have to compete within
a single industry and limited geographical area.

a) Conventional
b) Established
c) Physical
d) Traditional

Answer: Traditional

Question: The products that customers prefer to touch, smell or
examine precisely are difficult to sell using________

a) M-commerce
b) Net-Banking
c) E-commerce
d) None of these

Answer: E-commerce

http://www.centralbankofindia.com/
http://www.centralbankofindia.co.in/
http://www.cbofindia.com/
http://www.onlinecbi.com/
http://www.centralbankofindia.co.in/
http://www.bankofbaroda.co.in/
http://www.bob.com/
http://www.bobaroda.com/
http://www.onlinebob.com/
http://www.bankofbaroda.co.in/
http://www.iob.in/
http://www.iob.com/
http://www.iob.co.in/
http://www.onlineiob.com/
http://www.iob.in/
http://www.denabank.in/
http://www.denabank.com/
http://www.denabank.co.in/
http://www.onlinedenabank.com/
http://www.denabank.co.in/
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Question: Buyers are hesitant in buying_________items using the
Internet.

a) Perishable food items
b) Expensive jewelry
c) High fashion clothes
d) All of these

Answer: All of these

Question: The arrangement of products, store design and layout is
called_________

a) Decoration
b) Merchandising
c) Mercantile
d) Business

Answer: Merchandising

Question: A traditional commerce feature is_______
a) Operates within a certain period of time
b) Hiring of sales persons, sales manager and many more
c) Location renting, advertising, inventory
d) All of these

Answer: All of these

Question: An E-commerce feature is______
a) Electronic advertising
b) E-payment system is followed
c) Reduces the per transaction cost
d) All of these

Answer: All of these

Question: E-commerce_________the time taken to perform an overall
transaction.

a) Increases
b) Reduces
c) Browses
d) None of these

Answer: Reduces

Question: _____in India is experiencing a remarkable growth and
successfully changing the way people transact.

a) M-commerce
b) Net-Banking
c) E-commerce
d) None of these

Answer: E-commerce
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Question: _____has opened up new horizons and opportunities for
millions of people.

a) M-commerce
b) Net-Banking
c) E-commerce
d) None of these

Answer: E-commerce

Question: Because of Internet, a drastic change is observed in the
lifestyles of____parts of India.

a) Urban
b) Rural
c) Society
d) Modern

Answer: Rural

Question: ______is the key factor for the growth of E-commerce in
India.

a) The growth of technology facility
b) Increase in use of much wider product range
c) Evolution of the online marketplace
d) All of these

Answer: All of these

 

Question: The penetration of E-commerce is_____in India as
compared to the other countries.

a) Low
b) High
c) Not so good
d) None of these

Answer: Low

Question: _____is not an online store.
a) Flipkart
b) ebay
c) Amazon
d) Railway

Answer: Railway

Question: Online retailers have also started offering a________option,
which is most preferred method in India.

a) Cheque-on-delivery
b) Cash-on-delivery
c) Card-on-delivery
d) All of these

Answer: Cash-on-delivery
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Question: Almost_____of Indian E-commerce business uses cash-on-
delivery mechanism.

a) 50%
b) 60%
c) 80%
d) 100%

Answer: 80%

Question: For the consumer______makes it easy to reject products at
the point of delivery.

a) Cheque-on-delivery
b) Cash-on-delivery
c) Card-on-delivery
d) All of these

Answer: Cash-on-delivery

Question: ______sales would rise in the coming years with the
availability of faster broadband services and new applications.

a) M-commerce
b) Net-Banking
c) E-commerce
d) None of these

Answer: E-commerce

Question: Using E-commerce, a customer can purchase any product
anywhere anytime and conduct business_____

a) 24 x 7
b) 48 x 7
c) 12 x 12
d) 24 x 12

Answer: 24 x 7

Question: The cost of opening a physical store is very_____as
compared to doing business on Internet.

a) Low
b) High
c) Not so good
d) None of these

Answer: High

Question: _______coverage can be reached through creating a website
and uploading it on Internet.

a) International
b) Universal
c) Large-scale
d) Global

Answer: Global



13/09/2022, 20:07 CBSE Class 12 Computer Science Introduction To E Commerce MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-e-commerce-mcqs-set-311022.html 18/32

Question: ________gives better and quicker customer service.
a) M-commerce
b) F-Banking
c) E-commerce
d) L-commerce

Answer: E-commerce

 
Question: In E-commerce______frauds result into financial loss to the
customer.

a) Financial
b) Business
c) Investment
d) Credit card

Answer: Credit card

Question: Internet / E-commerce needs protection from
a) Hackers
b) Viruses
c) Transaction risks
d) All of these

Answer: All of these

Question: Perishable products like________are not preferred to be
purchased online.

a) Fruits
b) Vegetables
c) Clothes
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: E-commerce is dependent on______and any problem in the
connectivity causes business risk.

a) The business owner
b) Internet
c) Online stores
d) Banks

Answer: Online stores

Question: __________refers to business and organizations that sells
products or services to consumers over the Internet using websites.

a) B2C
b) B2B
c) C2C
d) C2B

Answer: B2C
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Question: In______business models the sellers can sell products
directly to consumers.

a) B2C
b) B2B
c) C2C
d) C2B

Answer: B2C

Question: Apart from online retailing,_____business model also
includes services like online banking services.

a) B2B
b) B2C
c) C2C
d) C2B

Answer: B2C

Question: Example of a_____website is amazon.com.
a) B2B
b) B2C
c) C2C
d) C2B

Answer: B2C

Question: ______is an example of B2C website.
a) Rediff.com
b) fabmart.com
c) flipkart.com
d) All of these

Answer: All of these

Question: Full form of eBooks is_____
a) Example Books
b) E-commerce Books
c) Electronic Books
d) None of these

Answer: Electronic Books

Question: Full form of ISBN is_____
a) International Standard Book Number
b) Indian Standard Book Number
c) Indian Standard Book Numeral
d) None of these

Answer: International Standard Book Number

 
Question: Various forms can be filled on_____website and submitted
to the related government office.

a) G2G



13/09/2022, 20:07 CBSE Class 12 Computer Science Introduction To E Commerce MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-e-commerce-mcqs-set-311022.html 20/32

b) G2C
c) G2B
d) G2E

Answer: G2B

Question: _______is the website of the income tax department of
Government of India.

a) www.incometax.gov.in
b) www.incometaxindia.gov.in
c) www.incometaxofindia.gov.in
d) All of these

Answer: www.incometaxindia.gov.in

Question: The income tax of government of India is an example
of_____website.

a) G2E
b) G2C
c) G2G
d) G2B

Answer: G2B

Question: ______and______websites are part of E-governance.
a) G2B
b) G2C
c) G2E
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: The_____business model provides good and effective
services to the individual citizen.

a) G2B
b) G2C
c) G2G
d) G2E

Answer: G2E

Question: The Gujarat government has developed its ow network
called the_______

a) Gujarat State Wide Area Network
b) Government State Wide Area Network
c) Gujarat Service Wide Area Network
d) Government Schemes Wide Area Network

Answer: Gujarat State Wide Area Network

Question: The GSWAN website is_______
a) www.gswan.gov.in
b) www.gswan.co.in

http://www.incometax.gov.in/
http://www.incometaxindia.gov.in/
http://www.incometaxofindia.gov.in/
http://www.incometaxindia.gov.in/
http://www.gswan.gov.in/
http://www.gswan.co.in/
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c) www.gswan.com
d) www.gswan.in

Answer: www.gswan.gov.in

Question: _______refers to online non-commercial communication
between the Government agencies and Government departments.

a) G2B
b) G2G
c) G2C
d) G2E

Answer: G2G

Question: The sharing of information on_____website helps in
reducing IT costs.

a) G2C
b) G2B
c) G2G
d) G2E

Answer: G2G

Question: _____and______E-commerce models are the most widely
used models.

a) B2C and B2B
b) G2G and C2C
c) B2B and G2B
d) C2C and B2C

Answer: B2C and B2B

Question: In_____E-commerce model, the consumers are the
companies.

a) B2C
b) B2B
c) C2B
d) C2C

Answer: B2B

Question: In______E-commerce model, the consumers are individuals.
a) B2C
b) B2B
c) C2B
d) C2C

Answer: B2C

Question: Which of the following is a disadvantage of E-commerce ?
a) Speed
b) Privacy
c) Improved customer service

http://www.gswan.com/
http://www.gswan.in/
http://www.gswan.gov.in/
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d) Conduct business 24 x 7

Answer: Privacy

Question: Which of the following is not an advantage of E-commerce
?

a) Lower cost
b) No geographical limitations
c) Conduct business 24 x 7
d) Lack of trust

Answer: Lack of trust

Question: _______deals directly without the involvement of third party.
a) B2C
b) C2C
c) B2B
d) C2B

Answer: C2C

Question: Any Internet user can become a vendor or purchaser
at______websites.

a) B2C
b) B2B
c) C2C
d) C2B

Answer: C2C

Question: Auctions sites are good examples of_____model.
a) B2C
b) B2B
c) C2C
d) C2B

Answer: C2C

Question: Full form of B2C is_____
a) Business to Customer
b) Business to Consumer
c) Books to Consumer
d) Books to Clients

Answer: Business to Consumer

Question: Full form of B2B is______
a) Business to Business
b) Business to Books
c) Business to Big Business
d) None of these

Answer: Business to Business



13/09/2022, 20:07 CBSE Class 12 Computer Science Introduction To E Commerce MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-e-commerce-mcqs-set-311022.html 23/32

Question: The selected book on the online book store gets added to the shopping_____

a) Bag
b) Basket
c) Cart
d) Bin

Answer: Cart

Question: To confirm the order on a website, press the_____button.
a) Payment
b) Select
c) Pay order
d) Place order

Answer: Place order

Question: In the shopping______the quantity of the product can be
changed.

a) Bag
b) Basket
c) Cart
d) Bin

Answer: Cart

Question: _______refers to E-commerce activities between different
business partners.

a) B2B
b) B2C
c) C2C
d) C2B

Answer: B2B

Question: ______enables the businesses to form E-relationship with
their suppliers, distributors and agents.

a) C2C
b) B2C
c) B2B
d) C2B

Answer: B2B

Question: The manufacturer using______can quickly communicate to
the supplier.

a) C2C
b) B2C
c) B2B
d) C2B

Answer: B2B
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Question: In______both the seller and the buyer are business entities.
a) C2C
b) B2C
c) C2B
d) B2B

Answer: B2B

Question: With the help of B2B, the companies can improve the
activities like______

a) Supplier management
b) Inventory management
c) Payment management
d) All of these

Answer: All of these

Question: B2B is effective for effectively managing______
a) Just-in-time delivery
b) Supply chain
c) Procurement
d) All of these

Answer: All of these

Question: Commodity.com is an example of a______model of website.
a) C2C
b) B2C
c) B2B
d) C2B

Answer: B2B

 
Question: Tradeindia.com is an example of a_____model of website.

a) C2C
b) B2C
c) B2B
d) C2B

Answer: B2B

Question: refers to E-commerce activities involving transactions
between and among the consumers.

a) C2C
b) B2C
c) B2B
d) C2B

Answer: C2C

Question: ______website enables the consumers to directly deal with
each other through online auctions and advertisements.

a) B2C
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b) C2C
c) B2B
d) C2B

Answer: C2C

Question: ______deals directly without the involvement of third party.
a) B2C
b) C2C
c) B2B
d) C2B

Answer: C2C

Question: Any Internet user can become a vendor or purchaser
at_____websites.

a) B2C
b) B2B
c) C2C
d) C2B

Answer: C2C

Question: Auctions sites are good examples of______model.
a) B2C
b) B2B
c) C2C
d) C2B

Answer: C2C

Question: Example of C2C website is______
a) ebay.com
b) OLX.com
c) Quikr.com
d) All of these

Answer: All of these

Question: Full form of B2C is______
a) Business to Customer
b) Business to Consumer
c) Books to Consumer
d) Books to Clients

Answer: Business to Consumer

Question: Full form of B2B is_____
a) Business to Business
b) Business to Books
c) Business to Big Business
d) None of these

Answer: Business to Business
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Question: Full form of C2C is______
a) Customer to Consumer
b) Consumer to Consumer
c) Client to Consumer
d) Client to Customer

Answer: Consumer to Consumer

Question: _______involves reverse auctions.
a) B2C
b) B2B
c) C2C
d) C2B

Answer: C2B

Question: _______is a website model where consumers determine the
prices of the products or services.

a) B2C
b) B2B
c) C2B
d) C2C

Answer: C2B

Question: Bidstall.com is an example of____websites.
a) B2C
b) C2B
c) B2B
d) C2C

Answer: C2C

Question: JeetLe.in is an example of______websites.
a) B2C
b) B2B
c) C2B
d) C2C

Answer: C2B

Question: Full form of G2B is______
a) Governance to Big Business
b) Government to Business
c) Governance to Business
d) Government to Big Books

Answer: Government to Business

Question: Full form of G2C is_____
a) Government to Citizen
b) Government to Consumer
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c) Government to Customer
d) Government to Client

Answer: Government to Citizen

Question: Full form of G2G is______
a) Gujarat to Government
b) Government to Gujarat
c) Government to Government
d) Government to Governance

Answer: Government to Government

Question: Full form of GSWAN is_______
a) Gujarat State Wide Area Network
b) Government State Wide Area Network
c) Gujarat Service Wide Area Network
d) Government Schemes Wide Area Network

Answer: Gujarat State Wide Area Network

Question: ________refers to the services and information provided by
the government to the business organizations.

a) G2B
b) G2C
c) G2G
d) G2E

Answer: G2B

Question: A business organization can get all information to business
policies from______websites.

a) G2C
b) G2B
c) G2G
d) G2E

Answer: G2E
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Question: Which of the following is the use of technologies which
provide the location information for business purpose?

a) E-Commerce
b) M-Commerce
c) L-Commerce
d) Traditional Commerce

Answer: L-Commerce

Question: Which of the following stands for GPS ?
a) Global Positioning System
b) Global Postal System
c) Grand Positioning System
d) Google Positioning System

Answer: Global Positioning System

Question: Which of the following security aspect refers to the secrecy
of the information so that unauthorized user cannot read it ?

a) Confidentiality
b) Integrity
c) Non-repudiation
d) Authorization

Answer: Confidentiality

Question: Which of the following security aspect ensures that the
information must not be accidentally or maliciously altered or
tampered in transit ?

a) Confidentiality
b) Integrity
c) Non-repudiation
d) Authorization

Answer: Integrity

Question: Which of the following security aspect ensures that only
authentic users are allowed to use the system ?

a) Authorization
b) Confidentiality
c) Non-repudiation
d) Integrity

Answer: Authorization

Question: Which of the following security aspect ensures that the
sender of the message cannot deny that he/she has sent the
message ?

a) Authorization
b) Confidentiality
c) Non-repudiation
d) Integrity

Answer: Non-repudiation
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Question: Which of the following is a program that uses Internet to
record information that passes through a computer or router in
transit from sender to receiver ?

a) Sniffer
b) Denial of service attack
c) Malicious code
d) Spoofing

Answer: Sniffer

Question: Which of the following is an attack used to shut down a
machine or network, making it inaccessible to its intended users ?

a) Malicious code
b) Denial of Service
c) Spoofing
d) Cyber vandalism

Answer: Denial of Service

Question: Which of the following is known as electronic defacing of
an existing website page ?

a) Cyber vandalism
b) Denial of Service
c) Spoofing
d) Malicious code

Answer: Cyber vandalism

 
Question: Which of the following is pretending to be someone you
are not, or representing a website as authentic when it is actually a
fake ?

a) Cyber vandalism
b) Malicious code
c) Denial of Service
d) Spoofing

Answer: Spoofing

Question: Which of the following is a computer program that
detects, prevents and takes action to remove the malicious codes like
viruses, worms and trojan horses from the infected system ?

a) Antivirus software
b) Digital certificate
c) Firewall
d) Cryptography

Answer: Antivirus software

Question: Which of the following is the transformation of normal
text known as "plain text" into unreadable or secret text known as
"cipher text" using encryption algorithm ?
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a) Firewall
b) Encryption
c) Antivirus software
d) Digital certificate

Answer: Encryption

Question: Which of the following is the transformation of encrypted
text back into normal text ?

a) Firewall
b) Digital certificate
c) Decryption
d) Virus

Answer: Decryption

Question: Which of the following is a protocol used for securing web
transactions on the Internet ?

a) TCP/IP
b) TTP
c) Bluetooth
d) SSL

Answer: SSL

Question: Who developed SSL protocol ?
a) Google
b) Netscape
c) Yahoo
d) Firefox

Answer: Netscape

Question: Which of the following starting address indicates that site
is secured by SSL protocol?

a) http://
b) ssl://
c) https://
d) http-ssl://

Answer: https://

Question: Which of the following provides the author with a tool to
protect his/her original work from being used or taken by others
without permission ?

a) Trademark
b) Copyright
c) Digital watermarking
d) Steganography

Answer: Copyright
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Question: Which of the following is a specific logo, mark, word,
symbol, design, phrase or image which is used by an individual or a
company to distinguish a product or service from that of others in
the market ?

a) Trademark
b) Copyright
c) Digital watermarking
d) Steganography

Answer: Trademark

Question: Which of the following is the symbol for trademark ?
a) TM, MT and ©
b) TM, MS and ®
c) TM, SM and ®
d) TM, SM and ©

Answer: TM, SM and ®

Question: Which of the following is the process of hiding information
within other information ?

a) Squatting
b) Steganography
c) Name changing
d) Copyright

Answer: Steganography

Question: Which of the following is a digital code inserted into a
digital image, audio or video file which can identify the file's
copyright information ?

a) Image mark
b) Digital mark
c) Code mark
d) Water mark

Answer: Water mark

Question: Who issues the credit card and guarantees the payment to
the merchant ?

a) Merchant
b) Issuing bank
c) Acquiring bank
d) Customer

Answer: Issuing bank

Question: Which of the following payment card has a microchip
embedded in its surface ?

a) Smart card
b) Debit card
c) Credit card
d) Charge card
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Answer: Smart card

Question: Mobile Commerce is also known as_______
a) Mob-commerce
b) M-commerce
c) Mb-commerce
d) All of these

Answer: M-commerce

Question: __________refers to buying and selling of goods or services
through the use of Internet enabled wireless devices.

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce

Question: Which of the following devices is Internet enabled wireless
devices ?

a) Mobile
b) Tablet
c) Smartphone
d) All of these

Answer: All of these

Question: Full form of PDA is________
a) Palmtop Digital Assistant
b) Personal Digital Assistant
c) Palmtop Devices Assistant
d) Personal Devices Assistant

Answer: Personal Digital Assistant

Question: _________provides the user with the advantage of flexibility
and ubiquity.

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce

Question: By using______consumers can conduct transactions without
being fixed at a computer terminal.

a) Mobile phone
b) Desktop PC
c) Super Computer
d) Both (A) and (B)

Answer: Mobile phone
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Question: Which of these devices can be carried by the user wherever
he/she goes ?

a) Mobile phone
b) Desktop PC
c) Palmtop
d) Both (A) and (C)

Answer: Both (A) and (C)

Question: Mobile phones allow_____time transactions while on the
move.

a) Real
b) Artificial
c) Genuine
d) Actual

Answer: Real

Question: ____________is an example of M-commerce
a) Purchasing airline and movie ticket
b) Hotel booking and reservation
c) Stock market analysis
d) All of the above

Answer: All of the above

Question: not a M-commerce activity.
a) Purchasing airline and movie ticket
b) Typing a letter
c) Buying Shares
d) Both (A) and (B)

Answer: Typing a letter

Question: Banks and other financial institutions are increasingly
using_______to retain their business.

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce

Question: _________allow their customers to access account balance,
stock quotes and make transactions via mobile phones.

a) Shops
b) Hotels
c) Banks
d) Malls

Answer: Banks
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Question: The above service mentioned in above question is known
as_______

a) Mobile Banking
b) M-Banking
c) B-Banking
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: The stock market services offered via mobile devices is
known as_______

a) Mobile Brokerage
b) Mobile Stock
c) Mobile Marketing
d) All of these

Answer: Mobile Brokerage

Question: __________is an integration of wireless networks accessed
through handheld devices and Internet.

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce

Question: Which of the following is a limitation of M-commerce ?
a) Convenience
b) Reduces Transaction cost
c) Provides global reach
d) User Interface is less convenient

Answer: User Interface is less convenient

 
Question: Which of the following is a limitation of M-commerce ?

a) Reduces time of order
b) Conducts business 24 x 7
c) It offers a limited bandwidth
d) Customized alerts easily delivered

Answer: It offers a limited bandwidth

Question: Instant connectivity and availability of faster 3G services
has made______very popular.

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce

Question: Which of the following is an advantage of M-commerce ?
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a) It offers a limited bandwidth
b) Timely information can reach the user
c) Have limited computing power
d) Limited screen size

Answer: Timely information can reach the user

Question: Which of the following is an advantage of M-commerce ?
a) Streamlines business processes
b) Difficult to play videos.
c) Have less memory and storage capacity.
d) High cost of establishing mobile broadband

Answer: Streamlines business processes

Question: _________devices have limited computing power, memory
and storage capacity.

a) Desktops
b) Satellites
c) Mobile
d) All of these

Answer: Mobile

Question: Establishing mobile and wireless broadband infrastructure
is very______

a) Expensive
b) Cheap
c) Easy
d) Difficult

Answer: Expensive

Question: To reach larger audiences companies are expanding their
services to mobile________

a) Marketing
b) Advertising
c) Requirements
d) Sales

Answer: Advertising

Question: ___________on Internet has become a major source of
revenue for most of the portals.

a) Marketing
b) Advertising
c) Requirements
d) Sales

Answer: Advertising

Question: Retailers offer location based mobile_________
a) Marketing
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b) Advertising
c) Requirements
d) Sales

Answer: Advertising

Question: Location based advertising targets consumers and
the______increases.

a) Marketing
b) Advertising
c) Requirements
d) Sales

Answer: Sales

Question: A________placed on the mobile device of the user can be
made location specific.

a) Advertisement
b) Scheme
c) Information
d) Requirement

Answer: Advertisement

Question: A_________placed on the mobile device of the user can be
made requirement specific.

a) Advertisement
b) Scheme
c) Information
d) Location

Answer: Advertisement

Question: An advertisement on the mobile device updates the users
about the various discounts and schemes available in the nearby
areas of the current_____of the user.

a) Advertisement
b) Scheme
c) Information
d) Location

Answer: Location

Question: The rail, air or movie tickets can be easily sent to the
users______

a) Desktops
b) Homes
c) Mobile Devices
d) None of these

Answer: Mobile Devices
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Question: Tickets can be cancelled on the mobile phones using
its______

a) Schemes
b) Applications
c) Portals
d) Both (B) and (C)

Answer: Both (B) and (C)

Question: Buying and_______of tickets reduces traffic and parking
problems as the user need not travel to the particular place.

a) Selling
b) Cancelling
c) Learning
d) Both (B) & (C)

Answer: Cancelling

Question: Full form of IRCTC is________
a) Indian Railway Catering And Tourism Corporation Limited.
b) Indian Railway Cuisine And Tourism Corporation Limited
c) Indian Railway Catering And Tourism Company Limited.
d) Indian Rail Cuisine And Tourism Corporation Limited

Answer: Indian Railway Catering And Tourism Corporation Limited.

Question: IRCTC website is a website for________booking of railway
tickets.

a) Online
b) Physical
c) Easy
d) Offline

Answer: Online

Question: To login the IRCTC page for online railway ticket, the user
has to provide with the_______and password.

a) Mobile number
b) Address
c) PAN
d) User name

Answer: User name

Question: After logging on the IRCTC website the user has to give his
travel details like______

a) Source
b) Destination
c) Date of travel
d) All of these

Answer: All of these
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Question: On the IRCTC website, the user clicks on the ..........button
to see the list of trains available.

a) Search
b) Find
c) List
d) Seek

Answer: Find

Question: To get more details of a particular train, the user has to
click on the______of the trains.

a) Name
b) List
c) Date
d) File

Answer: Name

Question: After booking the train, the user gets an______message
from IRCTC on the mobile device.

a) A-ticket
b) M-ticket
c) E-ticket
d) PC-ticket

Answer: E-ticket

Question: How-a-days one can book tickets without being fixed at
the computer_______or being physically present at the railway station.

a) Terminal
b) Workstation
c) Desktop
d) Unit

Answer: Terminal

Question: ________sites are becoming very popular these days.
a) Booking
b) Store
c) Auction
d) Wireless

Answer: Auction

Question: A user can make a bid and take timely action on the
bidding process on the_______sites.

a) Booking
b) Store
c) Auction
d) Wireless

Answer: Auction
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Question: Through_______networks, many auction sites have built
gateways and interfaces.

a) Wired
b) Landline
c) Telegraphy
d) Wireless

Answer: Wireless

Question: _______is an auction website which can be viewed on a
mobile device.

a) Ebay
b) Flipkart
c) Big Bazzar
d) IRCTC

Answer: Ebay

Question: ________are extensively used for listening to audio, video
and playing games.

a) TV
b) Land Phone
c) Mobile Devices
d) All of these

Answer: Mobile Devices

Question: The mobile users can_____to entertainment libraries.
a) Connect
b) Subscribe
c) Join
d) Attach

Answer: Subscribe

 
Question: After booking the train, the user gets an______message
from IRCTC on the mobile device.

a) A-ticket
b) M-ticket
c) E-ticket
d) PC-ticket

Answer: E-ticket

Question: ______services such as pay-per-download, pay-per-event or
on subscription basis can cater to a large number of mobile users.

a) Entertainment
b) Hobby
c) Amusement
d) Liesure

Answer: Entertainment
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Question: _______purchase allow customers to shop online anywhere.
a) Television
b) Desktop PC
c) Cameras
d) Mobile

Answer: Mobile

Question: Customers can order / buy products while using
a_______payment method.

a) Unsafe
b) Vulnerable
c) Weak
d) Secure

Answer: Secure

Question: Instead of using_______catalog, retailer can send a list of
products directly to the mobile device.

a) Paper
b) Hard
c) Soft
d) Document

Answer: Paper

Question: All retailers' can have a mobile version of_____site.
a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: E-commerce

Question: The_______of the flipkart.com shows the purchase process
in detail.

a) Front-page
b) Electronic-page
c) Home-page
d) Last-page

Answer: Home-page

Question: Today, many popular banks and financial institutions
use______

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: M-commerce
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Question: All financial institutions allow their______to access account
information.

a) Customers
b) Consumers
c) Traders
d) Members

Answer: Customers

Question: All financial institutions have an online facility to perform
transactions like stock purchase, remit money, via______or other
mobile equipment.

a) Television
b) Desktop PC
c) Cameras
d) Mobile Phones

Answer: Mobile Phones

Question: __________is an application provided by Union bank which is
available from the android market.

a) Union Mobile
b) Umobile
c) Union Bank Mobile
d) UBMobile

Answer: Umobile

Question: To use the Bank application services, the customer has to
first_______with the bank, to avail all the banking services.

a) Register
b) Enroll
c) Admit
d) Disclose

Answer: Register

Question: Which of the following the customer can do using the
bank's mobile services ?

a) Check balance
b) Transfer the funds
c) Request for a cheque book
d) All of these

Answer: All of these

Question: A wide variety of______services can be delivered to mobile
phone users.

a) Essential
b) Information
c) Data
d) Important

Answer: Information
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Question: ________service is provided to the mobile phone users.
a) News
b) Stock Market
c) Financial
d) All of these

Answer: All of these

Question: ________service is provided to the mobile phone users.
a) Sports news
b) Traffic Information
c) Friends
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: The______of the mobile phone user is an important piece of
information used during mobile commerce transactions.

a) Place
b) Size
c) Location
d) Site

Answer: Location

Question: The use of technologies which provide the location
information for business purposes is known as______

a) L-commerce
b) E-commerce
c) M-commerce
d) All of these

Answer: L-commerce

Question: _______is a wireless handheld device.
a) PDA
b) Cellular Phone
c) Pocket PC's
d) All of these

Answer: All of these

Question: Which of the following is not a wireless handheld device ?
a) Desktop PC
b) Cellular Phone
c) Pocket PC's
d) PDA

Answer: Desktop PC

 

Question: Today, many_______mobile applications and services are
emerging.
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a) Location-specific
b) Both (A) and (B)
c) Electronic-specific
d) None of these

Answer: Location-specific

Question: The mobile_______can track the user's location in order to
deliver a service or product.

a) Retailers
b) Applications
c) Software
d) Hardware

Answer: Applications

Question: _________technology uses the geographical location of the
mobile device to determine which applications are appropriate based
on that area.

a) L-commerce
b) E-commerce
c) M-commerce
d) App-Commerce

Answer: L-commerce

Question: Knowing the_______of the mobile user allows vendors to
provide location based services.

a) Area
b) Location
c) Website
d) Capacity

Answer: Location

Question: Local maps, local offers, local weather, people tracking and
monitoring is a part of______services.

a) Area-based
b) Website-based
c) Location-based
d) Information

Answer: Location-based

Question: The______technology works by using signals from GPS,
Cellular and Wi-Fi sources.

a) L-commerce
b) E-commerce
c) M-commerce
d) App-Commerce

Answer: L-commerce
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Question: Full form of GPS is_________
a) Global Positioning Software
b) Global Placed Software
c) Global Positioning System
d) Global Positioning Satellite.

Answer: Global Positioning System

Question: The________is the most accurate in determining a mobile
device's position.

a) GPS
b) Cell
c) Wi-Fi
d) All of these

Answer: GPS

Question: Full form of Wi-Fi is_______
a) Wireless Fidelity
b) Wireless Firewall
c) Wireless Faith
d) Wireless Fun

Answer: Wireless Fidelity

Question: _________is based on a worldwide satellite tracking system.
a) GPS
b) Cell
c) Wi-Fi
d) All of these

Answer: GPS

 
Question: The GPS signals are generated by a group of_______that
orbits around the earth.

a) Settlement
b) Satellite
c) Mobile
d) Devices

Answer: Satellite

Question: To locate a point, a mobile device utilizes_______satellites to
create an intersecting point.

a) One
b) Two
c) Three
d) Four

Answer: Three

Question: The intersecting point that located the device with 500
meters is known as______
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a) Triangle
b) Triangulation
c) Intersection
d) Crossing

Answer: Triangulation

Question: If the GPS signal is weak or blocked, the mobile device can
use the signals from cell towers and_____hot spots.

a) Wi-Fi
b) Satellite
c) Cellular
d) All of these

Answer: Wi-Fi

Question: The Wi-Fi signals do not broadcast their own signals
but_____companies use databases that store the locations of these
sources.

a) Mobile phones
b) Satellite
c) Cellular
d) Smart phones

Answer: Smart phones

Question: The advertisements which can be seen on the mobile
device are also_____

a) Area-specific
b) Website-specific
c) Location-specific
d) Info-specific

Answer: Area-specific

Question: ________services offers convenience and opportunity to
provide services that are more quick or precise and can meet a
customer's need.

a) Website-based
b) Location-based
c) Info-based
d) Area-based

Answer: Location-based

Question: Which of the following is a location-based application ?
a) Directory services
b) Tracking services
c) Emergency services
d) All of these

Answer: All of these
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Question: Which of the following is a location-based application ?
a) Advertising promotions
b) Mapping
c) Navigation
d) All of these

Answer: All of these

Question: _____is an example of Directory services.
a) Yellow pages
b) Medical Ambulance
c) Creating Maps
d) Plotting route

Answer: Yellow pages

Question: ______is an example of Tracking services.
a) Yellow pages
b) Locating friends in a geographic location
c) Roadside assistance
d) Mapping

Answer: Locating friends in a geographic location

Question: _______is an example of Emergency service.
a) Yellow pages
b) Locating friends in a geographic location
c) Roadside assistance
d) Mapping

Answer: Roadside assistance

Question: _____is an example of Advertising promotion.
a) Creating Maps
b) Plotting Route
c) Search and Rescue mission
d) Targeted Ads

Answer: Targeted Ads

Question: ______is an example of Mapping.
a) Police and fire response
b) Tracking of children by parents
c) Creating maps of geographical location
d) Tracking stolen cars

Answer: Creating maps of geographical location

Question: _____is an example of Navigation.
a) Plotting Route
b) Traffic updates
c) Tracking stolen cars
d) Promotional messages



13/09/2022, 20:08 CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-311028.html 21/26

Answer: Plotting Route

Question: _____is a public network system that consists of thousands
of private computer networks connected together.

a) WAN
b) Internet
c) LAN
d) MAN

Answer: Internet

Question: The valuable data or information that travels on the
Internet can easily be_______stolen, corrupted or lost.

a) Used
b) Misused
c) Touched
d) Altered

Answer: Misused

Question: While making online purchase on the E-commerce
website, customer has to provide_____number and personal details.

a) Credit Card
b) PAN
c) License
d) Adhar card

Answer: Credit Card

Question: While making online purchase all the information the
buyer fills up is transmitted to the _______ server.

a) Businessman
b) Buyers
c) Merchant
d) Commercial

Answer: Merchant

Question: The__server sends the personal details of the buyer to the
issuing bank for authorization through payment gateway.

a) Businessman
b) Buyers
c) Merchant
d) Commercial

Answer: Merchant
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p
a) Friend
b) Acquaintance
c) Server
d) Intruder

Answer: Intruder

Question: Anybody can create new programs and run them on
remote computers causing it to_____

a) Improve
b) Malfunction
c) Break down
d) Recover

Answer: Malfunction

Question: All the E-commerce / M-commerce websites have to keep
their customer's personal data very_____

a) Safe
b) Unsafe
c) Insecurely
d) Risky

Answer: Safe

Question: All the E-commerce / M-commerce websites have a lot
of_____issues.

a) Defense
b) Safety
c) Security
d) Attack

Answer: Security

Question: Which of the following does E-commerce deals with ?
a) Online Banking
b) Electronic transactions
c) Using debit / credit cards
d) All of these

Answer: All of these

Question: The E-commerce / M-commerce websites have more risk
of being targeted by____than the normal websites.

a) Friends
b) Acquaintances
c) Servers
d) Intruders

Answer: Acquaintances

Question: The E-commerce / M-commerce security must
meet_____important aspects.
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a) Two
b) Four
c) Six
d) Eight

Answer: Two

Question: ______refers to the secrecy of the information so that
unauthorized user cannot read the personal information.

a) Confidentiality
b) Secrecy
c) Unauthorized user
d) Intruders

Answer: Confidentiality

Question: _______protects the data from private attacks and ensures
that the message is not revealed or leaked.

a) Decrypting
b) Cryptography
c) Encryption
d) All of these

Answer: Cryptography

 
Question: helps in protecting the confidential data like credit card
number.

a) Decrypting
b) Cryptography
c) Encryption
d) All of these

Answer: Cryptography

Question: Confidentiality is achieved by using_____in which all
messages transmitted are encrypted.

a) Decrypting
b) Coding
c) Cryptography
d) Encryption

Answer: Cryptography

Question: _____ensures that the information must not accidentally or
maliciously altered or tampered in transit.

a) Confidentiality
b) Authorization
c) Non-repudiation
d) Integrity

Answer: Integrity
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Question: ______ensures that only authentic users are allowed to use
the system.

a) Confidentiality
b) Authorization
c) Non-repudiation
d) Integrity

Answer: Integrity

Question: ______ensures that the sender of the message cannot deny
that he/she has sent the message.

a) Confidentiality
b) Authorization
c) Non-repudiation
d) Integrity

Answer: Non-repudiation

Question: Non-repudiation is usually accomplished via digital____
a) Signatures
b) Partners
c) Messages
d) Security

Answer: Signatures

Question: Full form of TTP is____
a) Trusted Third Party
b) Trustworthy Third Person
c) Trustful Third Party
d) Trustees Third Party

Answer: Trusted Third Party

Question: ______code is one that causes damage to a computer or
system.

a) Programming
b) Unwanted
c) Malicious
d) Cruel

Answer: Malicious

Question: ______is a program that uses Internet to record information
that passes through a computer or router in transit from sender to
receiver.

a) Tapper
b) Sniffer
c) Recorder
d) Router

Answer: Sniffer



13/09/2022, 20:09 CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-e-311035.html 5/26

Question: ______programs can read e-mail messages, user login,
password and credit card numbers.

a) Tapper
b) Sniffer
c) Recorder
d) Router

Answer: Sniffer

Question: ______attack is an attack used to shut down a machine or
network, making it inaccessible to its intended users.

a) Denial-of-Service
b) Targeting
c) Connection
d) Vandalism

Answer: Denial-of-Service

Question: _____is the electronic defacing of an existing website page.
a) Denial-of-Service
b) Sniffing
c) Cyber Vandalism
d) Spoofing

Answer: Cyber Vandalism

Question: ______is pretending to be someone you are not, or
representing a website as authentic when it is actually a fake.

a) Denial-of-Service
b) Sniffing
c) Cyber Vandalism
d) Spoofing

Answer: Spoofing

Question: A website attacker can create a fake website and substitute
his______address for the real website address.

a) IP
b) DOS
c) TCP
d) TTP

Answer: IP

Question: ________software is a computer program that detects,
prevents and takes action to remove the malicious codes from the
infected system.

a) Trojan
b) Worms
c) Antivirus
d) Virus

Answer: Antivirus
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Question: _____is a type of virus.
a) Trojan
b) Trojan horses
c) Virus
d) Cyber crime

Answer: Trojan horses

Question: _____can delete the files and slow down the computer
system.

a) Software
b) Code
c) Antivirus
d) Virus

Answer: Virus

Question: Once a system is infected by_____it can spread by attaching
to other programs and files within the system.

a) Software
b) Code
c) Antivirus
d) Virus

Answer: Virus

Question: Infections on a computer system can easily spread through
Internet_____

a) Downloads
b) Code
c) Programs
d) Attachment

Answer: Downloads

Question: The_____software scans the downloaded files and the entire
computer system in order to detect the presence of an infection.

a) Software
b) Code
c) Antivirus
d) Virus

Answer: Antivirus

 

Question: _______is a device placed between the network and the
Internet to monitor and control the website traffic.

a) Firewall
b) Router
c) Bus Bar
d) Computer

Answer: Firewall
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Question: The primary goal of a_____is to keep intruders away from
the company's E-commerce infrastructure.

a) Firewall
b) Router
c) BusBar
d) Computer

Answer: Firewall

Question: ______ensures that the company's crucial data is kept safe
and not accessed by the intruders.

a) Firewall
b) Router
c) BusBar
d) Computer

Answer: Computer

Question: Infected_____to the emails can be in the form of pictures,
videos, sound clips or any other type of file.

a) Downloads
b) Attachments
c) Programs
d) Websites

Answer: Attachments

Question: Which of the following is protected by a firewall ?
a) Email services
b) Undesirable material
c) Unauthorized persons
d) All of these

Answer: All of these

Question: A firewall_____from any type of network attack.
a) Blocks
b) Unprotect
c) Protects
d) Saves

Answer: Protects

Question: Digital_____are used for proving our identity in electronic
transactions.

a) Certificates
b) ID
c) Both (A) and (B)
d) Authority

Answer: Both (A) and (B)
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Question: A____is issued by a trusted third party to establish the
identity of the holder.

a) Digital Certificate
b) Digital Data
c) Digital Signature
d) Digital Service

Answer: Digital Certificate

Question: _______is the third party who issues the Digital Certificates.
a) Certification Authority
b) Certification Owner
c) Certification holder
d) Certification key

Answer: Certification Authority

Question: The most commonly used network protection barrier
between company's network and the outside world is a______

a) Wall
b) Firewall
c) Antivirus
d) Soft wall

Answer: Firewall

 
Question: Which of the following is contained in the Digital
Certificate ?

a) Holder's name
b) Serial number
c) Expiration date
d) All of these

Answer: All of these

Question: A_______also holds a copy of the certificate holder's public
key.

a) Digital Certificate
b) Digital answer
c) Digital Sign
d) All of these

Answer: Digital Certificate

Question: The holder's public key is used for______messages and
digital signatures.

a) Decrypting
b) Encrypting
c) Crypted
d) None of these

Answer: Encrypting



13/09/2022, 20:09 CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-e-311035.html 9/26

Question: _____is an art of protecting the information by
transforming it into an unreadable form.

a) Decryption
b) Encryption
c) Cryptography
d) All of these

Answer: Cryptography

Question: ______is the transformation of normal text known as "plain
text" into unreadable or secret text.

a) Decryption
b) Encryption
c) Cryptography
d) All of these

Answer: Encryption

Question: The secret text is called the_____text.
a) Hidden
b) Plain
c) Cipher
d) Coded

Answer: Cipher

Question: The secret text is converted into_______text using
encryption algorithm.

a) Hidden
b) Plain
c) Cipher
d) Coded

Answer: Cipher

Question: A______key is used to encrypt and decrypt a message.
a) Secret
b) Plain
c) Cipher
d) Coded

Answer: Secret

Question: Messages are______just before they are sent on the internet
or network.

a) Coded
b) Encrypted
c) Ciphered
d) None of these

Answer: Encrypted
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Question: _____is the transformation of encrypted text back into
normal text.

a) Decryption
b) Encryption
c) Cryption
d) All of these

Answer: Decryption

Question: ______is the transformation of encrypted text back into
normal text.

a) Decryption
b) Encryption
c) Cryption
d) All of these

Answer: Decryption

Question: The key answer to the following encryption is : SCIENCE =
TDJFODF

a) Shift by 4
b) Shift by 3
c) Shift by 2
d) Shift by 1

Answer: Shift by 1

Question: ________protocol is used for securing web transactions on
the Internet.

a) SSI
b) SSL
c) SST
d) SSR

Answer: SSL

Question: Full form of SSL is_______
a) Security Safe Layer
b) Safe Secure Layer
c) Secure Socket Layer
d) Socket Safe Layer

Answer: Secure Socket Layer

Question: Protocol SSL was developed by______
a) Netscape
b) Microsoft
c) Oracle
d) Google

Answer: Netscape
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Question: If a website is secured, then the security logo of_______is
displayed on the login screen of the secured site.

a) Sign
b) VSign
c) VerySign
d) VeriSign

Answer: VeriSign

Question: An indication of a secure website is that its site address
starts from______

a) Tcpip://
b) http://
c) https://
d) All of these

Answer: https://

Question: E-commerce and M-commerce provide opportunities to
improve the_______processes.

a) Business
b) Wor
c) Employment
d) Vocation

Answer: Business

Question: Many countries have established______framework for the
electronic commerce.

a) Official
b) Legal
c) Certified
d) Verified

Answer: Legal

Question: Indian government has also established the_____laws under
the IT act.

a) Income tax
b) Information tax
c) Information technology
d) All of these

Answer: Information technology

Question: Enforcement of_______rules and regulations provides confidence to the customers that
their personal information remains secret and will not be misused.

a) Official
b) Business
c) Companies
d) Legal

Answer: Legal
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Question: Companies making online business are getting legal
support in case of misuse of their logos or any_____materials.

a) Copyright
b) Printed
c) Fixed
d) Secret

Answer: Copyright

Question: The_______property includes books, software's, music,
video, copyrights, trademarks and web pages.

a) Scholar
b) Intellectual
c) Thinker
d) Intelligent

Answer: Intellectual

Question: _______provides the author with a tool to protect his/her
original work from being used or taken by others without
permission.

a) Patent
b) Rights
c) Copyright
d) The law

Answer: Copyright

Question: _____is applicable to books, software programs and articles.
a) Patent
b) Rights
c) Copyright
d) The law

Answer: Copyright

Question: Copyright law protects intellectual______in its various forms
and cannot be used freely.

a) Information
b) Data
c) Assets
d) Property

Answer: Property

Question: It is very difficult to protect_____property in E-commerce or
M-commerce.

a) Scholarly
b) Intellectual
c) Thinker
d) Intelligent
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Answer: Intellectual

Question: Almost all web pages are protected by______
a) Patent
b) Rights
c) Copyright
d) The law

Answer: Copyright

Question: Copying contents from the website also violets
copyright______

a) Patent
b) Rights
c) Copyright
d) The law

Answer: The law

Question: A_______may be designated by the symbols TM or SM.
a) Trademark
b) Copyright
c) Symbol
d) Image

Answer: Trademark

 
Question: A specific logo, word, symbol, design, phrase or image can
be used as a______

a) Trademark
b) Copyright
c) Symbol
d) Image

Answer: Trademark

Question: The competition over domain names is a______issue.
a) Illegal
b) Legal
c) Authorized
d) Authorized

Answer: Legal

Question: When, the Registered Domain names which are not in use
are sold, it is known as______squatting.

a) Cyber
b) Online
c) Virtual
d) Domain

Answer: Cyber
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Question: _______is the process of hiding information within other
information.

a) Concealing
b) Hiding
c) Stegangraphy
d) Masking

Answer: Stegangraphy

Question: _______works by replacing unused data in computer files
such as images, sound or text with invisible information.

a) Concealing
b) Hiding
c) Stegangraphy
d) Masking

Answer: Stegangraphy

Question: There are______versions of Stegangraphy, available on
Internet, which can be easily downloaded.

a) Hidden
b) Invisible
c) Shareware
d) Freeware

Answer: Freeware

Question: The_______is a digital code inserted into a digital image,
audio or video file which can identify the file's copyright information.

a) Transparent mark
b) Invisible mark
c) Translucent mark
d) Watermark

Answer: Watermark

Question: The_______allows hiding information in a totally invisible
manner.

a) Transparent mark
b) Invisible mark
c) Translucent mark
d) Water mark

Answer: Water mark

Question: Currently, the_______distribution of digital audio over the
Internet in the MP3 format is a big problem.

a) Unauthorized
b) Authorized
c) Legal
d) Illegal

Answer: Unauthorized
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Question: _______watermarking can link information on the
documents.

a) Hybrid
b) Digital
c) Analog
d) Internet

Answer: Digital

Question: A visible digital watermark can be added to any image
using photo editor tools like_____

a) GMIP
b) GPIM
c) GIMP
d) GMIP

Answer: GIMP

Question: _______is one of the most important aspects of E-commerce
and M-commerce.

a) Payment
b) Disbursement
c) Compensation
d) Expense

Answer: Expense

Question: _______payments involve cash, cheque or credit card.
a) Usual
b) Traditional
c) Customary
d) Established

Answer: Traditional

Question: Electronic payment systems have become more important
to the______business processes.

a) Traditional
b) Shopping
c) Cards
d) Online

Answer: Online

Question: The different types of payment systems used are_____
a) Smart cards
b) Credit cards
c) Debit cards
d) All of these

Answer: All of these



13/09/2022, 20:09 CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-e-311035.html 16/26

Question: The payment cards can be classified into______types of
cards

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: ________card payment method is one of the most popular
and widely accepted methods of payment on Internet.

a) Credit
b) Debit
c) Smart
d) Payment

Answer: Credit

Question: A credit card is issued to the customers by the banks
known as______banks.

a) Issuing
b) Online
c) Card
d) Smart

Answer: Issuing

Question: ________card or Visa are established and reputed financial
institutions in the services of credit card business.

a) Head
b) Principal
c) Smart
d) Master

Answer: Master

Question: In Credit Card transactions_____parties are involved.
a) One
b) Two
c) Three
d) Four

Answer: Four

Question: The______bank issues the credit card and guarantees the
payment to the merchant.

a) Issuing
b) Online
c) Card
d) Smart

Answer: Issuing
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Question: The_____bank establishes the account with the merchant
and validates the credit card.

a) Issuing
b) Acquiring
c) Merchant's
d) Customer's

Answer: Acquiring

Question: The_______bank authorizes sale based on the customer's
credit card limit.

a) Issuing
b) Acquiring
c) Merchant's
d) Customer's

Answer: Acquiring

Question: Payment______and processors are two more entities which
play a role in online payment.

a) Doorways
b) Openings
c) Gateways
d) Windows

Answer: Gateways

Question: Payment gateway services provided by the third party
like______which connects networks of all parties involved.

a) HDFC
b) SBI
c) AXIS
d) PayPal

Answer: PayPal

Question: _________are data centers which perform the credit card
transactions and settle funds to the merchant.

a) Doorways
b) Openings
c) Processors
d) Windows

Answer: Processors

Question: Processors are connected to the E-commerce website of
the merchant through the payment

a) Doorways
b) Openings
c) Gateways
d) Windows

Answer: Gateways
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Question: The online payment through credit card on Internet is
divided into_____parts.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: Major credit card companies use the_______security system
to make online transactions secure.

a) SIGN
b) VERISIGN
c) SET
d) SECURE

Answer: SET

Question: Full form of SET is_____
a) Secure Electronic Transfer
b) Safe Electronic Transit
c) Safe Electric Transfer
d) Secure Electric Transit

Answer: Secure Electronic Transfer

 
Question: The advantage of using Credit card is_____

a) Gives flexibility to the customer.
b) Keeps record of the customer's purchase.
c) Allows customers to purchase goods even when they do not have cash in bank.
d) All of these

Answer: All of these

Question: The limitation of using credit card is_______
a) They are unsuitable for very small or very large payments.
b) Customers tend to overspend using credit cards
c) Problems arise in case lost or stolen credit cards.
d) All of these

Answer: All of these

Question: A________looks like credit card but works by transferring
fund directly from the consumer's bank.

a) Credit Card
b) Smart Card
c) Debit Card
d) Payment Card

Answer: Debit Card
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Question: The______can keep the consumer purchases under a limit
and do not allow him to exceed beyond his/her budget.

a) Credit Card
b) Smart Card
c) Debit Card
d) Payment Card

Answer: Debit Card

Question: also looks like a credit card but have a microchip
embedded in their surface.

a) Credit Card
b) Smart Card
c) Debit Card
d) Charge Card

Answer: Smart Card

Question: A______contains user's private information, such as account
information, health information etc.

a) Credit Card
b) Smart Card
c) Debit Card
d) Payment Card

Answer: Smart Card

Question: ________are popular in countries like US, Europe, Japan and
some parts of Asia.

a) Debit Card
b) Credit Card
c) Charge Card
d) Smart Card

Answer: Smart Card

Question: A_______is another form of payment mechanism wherein
the customer can pay through the card and it does not have a credit
limit.

a) Debit Card
b) Credit Card
c) Charge Card
d) Smart Card

Answer: Charge Card

Question: _______does not involve any type of card for online
transaction.

a) Net-Banking
b) Credit-Card
c) Smart-Banking
d) All of these

Answer: Net-Banking
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Question: means transferring money from one bank to another
electronically.

a) Net-Banking
b) EFT
c) ATM
d) Net-Transaction

Answer: EFT

Question: Full form of EFT is______
a) Electronic Funds Transfer.
b) Electronic Finance Transfer
c) Electronic Funds Transaction.
d) None of these

Answer: Electronic Funds Transfer.

Question: is an electronic card for making secure online payments
towards a merchant.

a) E-Wallet
b) M-Wallet
c) L-Wallet
d) Card-Wallet

Answer: E-Wallet

Question: The term______is coined from two terms Rupee and
Payment.

a) RupeeP
b) RuPay
c) Rupees Payment
d) None of these

Answer: RuPay

Question: is a new card payment mechanism launched by NPCI.
a) RupeeP
b) RuPay
c) Rupees Payment
d) None of these

Answer: RuPay

Question: Full form of NPCI is_______
a) Nation's Payment Cost of India
b) National Payments Company of India.
c) National Payments Corporation of India.
d) Nationalized Payments Corporation of India.

Answer: National Payments Corporation of India.
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Question: Anybody can create new programs and run them on
remote computers causing it to_____

a) Improve
b) Malfunction
c) Break down
d) Recover

Answer: Malfunction

Question: A firewall______from any type of network attack.
a) Blocks
b) Unprotect
c) Protects
d) Saves

Answer: Protects

Question: Digital_____are used for proving our identity in electronic
transactions.

a) Certificates
b) ID
c) Both (A) and (B)
d) Authority

Answer: Both (A) and (B)

Question: A_____is issued by a trusted third party to establish the
identity of the holder.

a) Digital Certificate
b) Digital Data
c) Digital Signature
d) Digital Service

Answer: Digital Certificate

Question: _______is the third party who issues the Digital Certificates.
a) Certification Authority
b) Certification Owner
c) Certification holder
d) Certification key

Answer: Certification Authority
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d) Netscape

Answer: Sun Micro systems

Question: Modeled after C++, the _____ language was designed to be
small, simple and portable across platforms and operating systems
both at the source and at the binary level.

a) Java
b) C
c) Basic
d) PHP

Answer: Java

Question: Java language was developed at Sun Micro systems in _____
a) 1993
b) 1992
c) 1991
d) 1990

Answer: 1992

Question: _______ is small, fast, efficient and easily portable to a wide
range of hardware devices.

a) Java
b) C
c) Basic
d) PHP

Answer: Java

Question: ______ language is considered as one of the ideal language
for distributing executable programs via the World Wide Web.

a) Java
b) C
c) Basic
d) PHP

Answer: Java

Question: Java is also a general-purpose programming language for
developing programs that are \ easily usable and portable across
different.

a) Tables
b) Stands
c) Libraries
d) Platforms

Answer: Platforms

Question: Java is an __________ language and here it differs from C.
a) Procedure-oriented
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b) Structure-oriented
c) Object-oriented
d) Executable-oriented

Answer: Object-oriented

Question: Using _______one can take full advantage of object-oriented
methodology and its capabilities of creating flexible, modular and
reusable code.

a) Java
b) C
c) Basic
d) PHP

Answer: Java

Question: Java includes a set of ___________that provide basic data
types, system input and output capabilities and other utility
functions.

a) Class libraries
b) Class functions
c) Class methods
d) All of these

Answer: Class libraries

Question: These basic classes are part of the ________ .
a) KDJ
b) JDK
c) DKJ
d) DJK

Answer: JDK

Question: _______ has classes to support networking, common
Internet protocols and user interface toolkit functions.

a) KDJ
b) JDK
c) DKJ
d) DJK

Answer: JDK

Question: ______ is platform-independent at both the source and
binary level.

a) Java
b) C
c) Basic
d) PHP

Answer: Java
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Question: ______ independence is a program's capability of being
moved easily from one computer system to another.

a) Table
b) Program
c) Library
d) Platform

Answer: Platform

Question: At the ______ level, Java's primitive data types have
consistent sizes across all development platforms.

a) Beginning
b) Destination
c) Source
d) Binary

Answer: Source

Question: At ______ level, platform-independence is possible due to
byte code interpreter.

a) Beginning
b) Destination
c) Source
d) Binary

Answer: Binary

Question: The designers of Java chose to use a combination of ______
and interpretation.

a) Assembling
b) Compilation
c) Togetherness
d) All of these

Answer: Compilation

Question: Full form of JDK is_________
a) Java Developing Kit
b) Java Development Kit
c) Both (A) and (B)
d) None of these

Answer: Java Development Kit

Question: Programs written in Java are compiled
into____________language for a computer that doesn't really exist.

a) Machine
b) Assembly
c) C++
d) Java

Answer: Machine
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Question: The so-called "virtual" computer is known as
a) JMV
b) VMJ
c) JVM
d) MVJ 21)

Answer: JVM

Question: The full form of JVM is____________
a) Java Virtual Machine
b) Java Visible Machine
c) Java Viable Machine
d) None of these

Answer: Java Virtual Machine

Question: The machine language for the Java Virtual Machine is
called Java___________

a) byte
b) byte numbers
c) byte code
d) bytes

Answer: byte code

Question: Different Java byte code__________is needed for each type
of computer.

a) Compiler
b) Interpreter
c) Translator
d) None of these

Answer: Interpreter

Question: Java binary files are actually in a form called________that is
not specific to any one processor or any operating system.

a) bytes
b) binary numbers
c) byte codes
d) byte

Answer: byte codes

Question: A disadvantage of using__________is its slow execution
speed.

a) ASCII codes
b) binary numbers
c) byte codes
d) bytes

Answer: byte codes
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Question: There are tools available tools to convert________into native
code.

a) Java Byte codes
b) Java Language
c) Java Complies
d) All of these

Answer: Java Byte codes

Question: __________code is faster to execute, but then it does not
remain machine independent.

a) Native
b) Original
c) ASCII
d) Binary

Answer: Native

Question: A Java Program should have at least one____________and it
must have main___________in it

a) Class, procedure
b) Class, variable
c) Class, method
d) Class, code

Answer: Class, method

Question: A Java program is composed of____________
a) Functions
b) Classes
c) Programs
d) Variables

Answer: Classes

Question: C programmers can think of a class as a sort of creating a
new composite data type by using_________and________

a) Structures, type
b) Functions, define
c) Classes, type def
d) Struct, type def

Answer: Struct, type def

 

Question: _______________can provide much more than just a collection
of data.

a) Functions
b) Classes
c) Programs
d) Variables

Answer: Classes
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Question: Note that__________is not available in Java.
a) Type def
b) Struct
c) Both (A) and (B)
d) All of these

Answer: Both (A) and (B)

Question: Java source file can be created using any plain_______text
editor.

a) Native
b) Original
c) ASCII
d) Binary

Answer: ASCII

Question: Java_____files are given the same name as the class defined
with an extension of Java.

a) Beginning
b) Destination
c) Source
d) Binary

Answer: Source

Question: In Java the_______name is case sensitive.
a) Folder
b) Class
c) First
d) Last

Answer: Class

Question: In Java the______name is case sensitive.
a) File
b) Folder
c) First
d) Last

Answer: File

Question: If class name is CallCost, filename should be
a) callcost
b) callcost.java
c) callCost.java
d) callcosT.java

Answer: callCost.java

Question: The source file is compiled using the_______compiler.
a) S Cite
b) C++
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c) Basic
d) Java

Answer: Java

Question: To compile the Java program, type________followed by the
name the source file

a) javac
b) JavaC
c) Java
d) cjava

Answer: javac

Question: When the program gets compiled without errors, compiler
created a file with extension________in the same directory as the
source file

a) .Java
b) .javac
c) .class
d) .javaclass

Answer: .class

Question: The programmer can run the application using Java______
a) Compiler
b) Translator
c) Interpreter
d) None of these

Answer: Interpreter

Question: In_______the Java interpreter is called by simply using Java
a) JDK
b) JKD
c) JDD
d) JKK

Answer: JDK

Question: Which of the following variable declarations is correct ?
a) Double balance
b) Double rate
c) Double duration
d) Double cost

Answer: Double rate

Question: Java source program file should have extension
a) Java
b) .javac
c) .class
d) .javaclass



13/09/2022, 20:09 CBSE Class 12 Computer Science Java Basics MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-310923.html 9/26

Answer: Java

Question: The name of_______is same as the class name containing
main method and it has an extension .class.

a) Interpreted file
b) Code file
c) Compiled file
d) byte code file

Answer: byte code file

Question: A________'Java' interprets byte code and excuses it.
a) Compiler
b) Translator
c) Interpreter
d) None of these

Answer: Interpreter

Question: The texts after________are comments.
a) //
b) \\
c) // //
d) \\ \\

Answer: //

Question: The text enclosed within_________are comments.
a) /& and &/
b) /* and */
c) /* and *\
d) //* and *//

Answer: /* and */

Question: Comments are not compiled or interpreted
a) Codes
b) Classes
c) Comments
d) Methods

Answer: Comments

Question: Variables are declared using___________followed by variable
name

a) Data type
b) Int
c) Char
d) Float

Answer: Data type
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Question: Several___________(also called function or method in Java)
call statements are used to display information to the user of the
program

a) Super routine
b) Subroutine
c) Sub program
d) None of these

Answer: Subroutine

Question: Computation part contains expressions including
assignment___________

a) Sentences
b) Numerical
c) Operators
d) Statements

Answer: Statements

Question: ____________are used to display results.
a) Methods
b) Classes
c) Outputs
d) Prints

Answer: Methods

Question: System.out.print and System.out.println are_________which
take a value to be displayed as an argument.

a) Methods
b) Classes
c) Outputs
d) Prints

Answer: Methods

Question: ___________adds a line feed after the end of the information
that it displays.

a) out.print
b) out.prindnt
c) output.print
d) output.println

Answer: out.prindnt

Question: When the program is run, the Java interpreter calls
the__________method and the statements that it contains are
executed.

a) Main()
b) String[]
c) string[] args
d) main()

Answer: main()
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Question: The___________routine can call other subroutines that are
defined in the same class or even in other classes.

a) Main()
b) String[]
c) string[] args
d) main()

Answer: main()

Question: It is the_________routine that determines how and in what
the other subroutines are used.

a) Main()
b) String[]
c) string[] args
d) main()

Answer: main()

Question: The word in the first line of main() means that this routine
can be called from outside the program

a) private
b) Public
c) public
d) Private

Answer: public

Question: This is essential because the main() routine is called by the
Java interpreter, which is__________to the program

a) External
b) Internal
c) Outside
d) Inside

Answer: External

 

Question: Start S Cite application. Select File ->
a) Save
b) New
c) Open
d) Start

Answer: New

Question: To save the file, select File __________command.
a) Save
b) New
c) Open
d) Start

Answer: Save
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Question: _________editor is used to create Java application.
a) Notepad
b) Wordpad
c) S Cite
d) Word

Answer: S Cite

Question: To compile a source program use___________Compile
command.

a) File
b) Edit
c) Tools
d) Buffers

Answer: Tools

Question: If the program is compiled without any error, execute it
using___________Go command

a) File
b) Edit
c) Tools
d) Buffers

Answer: Tools

Question: Programming____________differ from ordinary human
languages in being completely unambiguous and very strict about
what is and is not allowed in a program

a) Rules
b) Methods
c) Files
d) Languages

Answer: Languages

 
Question: The rules that determine what is allowed to be used in a
language are called the_________of the language

a) Protocols
b) Syntax
c) Methodology
d) Regulations

Answer: Syntax

 
Question: ____________rules specify the basic vocabulary of the
language and how programs can be constructed using things like
variables, expressions, statements, branches, loops and methods

a) Protocol
b) Syntax
c) Methodology
d) Regulation
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Answer: Syntax

 
Question: A syntactically correct program is one that can be
successfully_________or interpreted

a) Compiled
b) Understood
c) Executed
d) Put together

Answer: Compiled

 
Question: In a Java program, text in__________bracket is used as a
placeholder that describes something actual we need to type while
writing actual program

a) Curly
b) Square
c) Angle
d) Round

Answer: Angle

 
Question: Which of the following is an Angle bracket

a) <>
b) { }
c) ( )
d) [ ]

Answer: <>

 
Question: As Java is an object-oriented language. Everything is
defined as part of_______

a) Program
b) Procedure
c) List
d) Class

Answer: Class

 
Question: The definition of the method (function) in Java consists of
function header and the sequence of statements enclosed between
braces________

a) <>
b) { }
c) ( )
d) [ ]

Answer: { }

 
Question: A method in Java program cannot exist by itself. It has to
be a part of a___________

a) Program
b) Procedure
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c) List
d) Class

Answer: Class

 
Question: Based on the structure of a Java program_____________in the
first line is the name of the class having main method in it

a) Class-name
b) Public
c) Class
d) Name

Answer: class-name

 
Question: Class file, CallCost.class, contains the translation of the
program into Java____________which can be executed by a Java
interpreter

a) bytes
b) binary number
c) bytecode
d) byte

Answer: bytecode

 
Question: If the name of the class is CallCost, then the program
should conventionally be saved in a Java source file with a
name__________

a) CallCost.class
b) CallCost.java
c) callcost.java
d) CallCost

Answer: CallCost.java

 
Question: When this file is compiled, another file
named_____________is generated

a) CallCost.class
b) CallCost.java
c) callcost.java
d) CallCost

Answer: CallCost.class

 
Question: Variable and method declaration after and
before___________method is optional

a) main{}
b) string[]
c) string[] args
d) main()

Answer: main()
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Question: Each program must have one______that contains public
method main()

a) Program
b) Procedure
c) List
d) Class

Answer: Class

 
Question: The entire Java program can be written together on single
line but_________is important to make it more readable

a) Display
b) Layout
c) Plan
d) Design

Answer: Layout

 
Question: Java is a______format language.

a) Free
b) Busy
c) Object
d) Class

Answer: Free

 
Question: The entire Java program can be written together on single
line but______is important to make it more readable.

a) Display
b) Layout
c) Plan
d) Design

Answer: Layout

 
Question: A program can contain other methods besides_______as
well as other variables.

a) Main()
b) String[]
c) string[] args
d) main()

Answer: main()

 
Question: Which of the following are the basic java statements used
within a method definition such as main()?

a) Data Types
b) Variables
c) Literals
d) All of these

Answer: All of these
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Question: Which of the following are the basic Java statements used
within a method definition such as main() ?

a) Comments
b) Java statements and expressions
c) Arithmetic operators
d) All of these

Answer: All of these

 
Question: Which of the following are the basic java statements used
within a method definition such as main() ?

a) Comparisons
b) Logical operators
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

 
Question: _______determines the required memory size, type of
values, range of values and type of operations that can be
performed.

a) Data Types
b) Variables
c) Literals
d) All of these

Answer: Data Types

 
Question: Java supports______primitive data types that handle
common types for integers, floating point numbers, characters and
Boolean values (true or false).

a) Seven
b) Eight
c) Nine
d) Ten

Answer: Eight

 
Question: The primitive______are named byte, short, int, long, float,
double, char, Boolean.

a) Data types
b) Variables
c) Literals
d) All of these

Answer: Data types

 

Question: T&E first four data types hold_____
a) Real numbers
b) Integers
c) Single character
d) True or False

Answer: Integers
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Question: The next two data types hold_____
a) Real numbers
b) Integers
c) Single character
d) True or False

Answer: Real numbers

Question: Char data type holds a single character from the Unicode
character set.

a) Real numbers
b) Integers
c) Single character
d) True or False

Answer: Single character

Question: The Boolean data type holds one of the two logical values
true or false.

a) Real numbers
b) Integers
c) Single character
d) True or False

Answer: True or False

Question: The data types in Java are called______as they are built into
the system.

a) Fixed
b) Ancient
c) Primitive
d) New

Answer: Primitive

Question: In Java the______are machine-independent, this means that
they can be relied on their sizes and characteristics to be consistent
across all Java programs on all machines.

a) Data Types
b) Variables
c) Literals
d) All of these

Answer: Data Types

Question: _____in Java are complaint with IEEE 754 (an international
standard for defining floating point numbers and arithmetic).

a) Real numbers
b) Integers
c) Single character
d) True or False

Answer: Real numbers
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Question: Integer numbers with b bits_____store signed values in the
range of (-2  -1, 2 ). 

a) Accuracy
b) Precision
c) Exactness
d) Vagueness

Answer: Precision

Question: When the Integer numbers are preceded with
keyword_____the values are in the range of (0, 2 ). 

a) Signed
b) Unsigned
c) Boolean
d) Byte

Answer: Unsigned

Question: Java uses the Unicode_______set.
a) Numerical
b) IEEE
c) Character
d) None of these

Answer: Character

Question: The char type has____bits of precision and is unsigned.
a) 13
b) 14
c) 15
d) 16

Answer: 16

Question: Data type_____is not a number, nor can it be treated as one.
a) Char
b) Real
c) Boolean
d) Integer

Answer: Boolean

Question: If anything is to be remembered by the computer, there
will be a requirement of_____during program execution. It needs to
be stored in the memory of the computer.

a) Variables
b) Literals
c) Comments
d) Operators

Answer: Variables

b_1 b_1

b_1
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Question: ______manipulates the data that is stored in memory.
a) Information
b) Programs
c) Comments
d) Characters

Answer: Programs

Question: In machine language, data can only be referred to by
giving the______address of the location in memory where it is stored.

a) Numerical
b) Alphanumeric
c) Alphabetical
d) Real

Answer: Numerical

Question: In a______language such as Java, names are used instead of
numeric address of memory location to refer to data.

a) Low-level
b) Middle-level
c) High-level
d) Top-level

Answer: High-level

Question: A name is used to refer to the data stored in memory and
it is called a_____

a) Variable
b) Literal
c) Comment
d) Operator

Answer: Variable

Question: A_____can take different data values at different times
during the execution of the program, but it always refers to the same
memory location.

a) Variable
b) Literal
c) Comment
d) Operator

Answer: Variable

Question: A______can be used in a Java program only if it has been
declared.

a) Variable
b) Literal
c) Comment
d) Operator

Answer: Variable
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Question: One or more variables can be declared in Java
using_____statement.

a) Beginning
b) Initial
c) Declaration
d) Comment

Answer: Declaration

Question: In Java, the conventional syntax of_____denote the item to
be specified by user.

a) Curly brackets
b) Square brackets
c) Angle brackets
d) Round brackets

Answer: Angle brackets

Question: In Java, the conventional syntax of_____denote the list of
items separated by commas.

a) Curly brackets
b) Square brackets
c) Angle brackets
d) Round brackets

Answer: Curly brackets

Question: In syntax: {variable names}, it denote the list of____names.
a) Variable
b) Literal
c) Comment
d) Operator

Answer: Variable

Question: When the list contains more than one item, items should
be separated by_____

a) Semi colon
b) Commas
c) Full stop
d) Colon

Answer: Commas

Question: In typical Java syntax, the is to be replaced with the
keyword denoting the_____of the variables.

a) Data types
b) Variables
c) Literals
d) Comments

Answer: Data types
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Question: ______is used to determine the size of variable, the values it
can hold and the operations that can be performed on it.

a) Real numbers
b) Variables
c) Data Types
d) Floats

Answer: Data Types

Question: When the compute executes a variable____statement, it
sets aside memory for the variable and associates the variable's name
with that memory.

a) Data type
b) Initial
c) Declaration
d) Comment

Answer: Declaration

Question: Which of the following examples of variables is correct ?
a) Int marks;
b) Double amount, interest;
c) Float rate;
d) All of these

Answer: All of these

Question: Which of the following rule is incorrect while defining a
variable name ?

a) It must begin with an alphabet, underscore (_)
b) It must begin with a percentage sign (%)
c) No spaces are allowed in variables
d) It cannot be a reserved word

Answer: It must begin with a percentage sign (%)

Question: Which of the following is true ?
a) Java is case-sensitive
b) Java is not case-sensitive
c) Both (A) and (B)
d) None of these

Answer: Java is case-sensitive
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Answer: Classes

Question: In Java, it is customary for names of_____to begin with
lower case letters.

a) Variables
b) Methods
c) Comments
d) Both (A) and (B)

Answer: Both (A) and (B)

Question: Which of the following is not a good programming style
for declaring variables ?

a) Declare ten variables in a declaration statement
b) Include a comment with each variable declaration to explain its purpose
c) Declare important variables at the beginning of the function
d) None of these

Answer: Declare ten variables in a declaration statement

Question: In Java, there are_____kinds of variables.
a) One
b) Two
c) Three
d) Four

Answer: Three

Question: Which of the following is a kind of variable in Java ?
a) Instance variable
b) Class variable
c) Local variable
d) All of these

Answer: All of these

Question: Function parameters and variables declared in the function
are considered as_____variables.

a) External
b) Internal
c) Local
d) Limited

Answer: Local

Question: Each variable can be given a____value while declaring.
a) Initial
b) Last
c) Cumulative
d) Opening

Answer: Initial
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Question: In general, syntax of declaring variables is______
a){variable =,};
b){variable [=,]};
c) type name {variable [=,]};
d){variable [=,]}

Answer: {variable [=,]};

Question: In variable declaration syntax, the_____denotes optional
item.

a) Curly brackets { }
b) Square brackets [ ]
c) Angle brackets < >
d) Round brackets ()

Answer: Square brackets [ ]

Question: It is programmer's responsibility to assign value
to____before their first use.

a) Variables
b) Methods
c) Comments
d) Both (A) and (B)

Answer: Variables

Question: A name used for a constant value is known as
a) Data types
b) Variables
c) Literals
d) Comments

Answer: Literals

Question: There are some different kinds of_____in Java for number,
character, string and Boolean values.

a) Data types
b) Variables
c) Literals
d) Comments

Answer: Literals

Question: ____are used to represent integer or real numbers; for
example, 157 and 17.42.

a) Numeric Variables
b) Numeric Literals
c) Integer Literals
d) Character Literals

Answer: Numeric Literals
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Question: Java allows Unicode integer literals called Decimal whose
base is______

a) 10
b) 8
c) 16
d) 32

Answer: 10

Question: Java allows Unicode integer literals called Octal whose
base is______.

a) 10
b) 8
c) 16
d) 32

Answer: 8

Question: A decimal integer larger than int is automatically of
type_____

a) Short
b) Long
c) Float
d) Mixed

Answer: Long

Question: _____integers such as 4, 157, 17777 and -32 are decimal
integer literals of type byte, short or int depending on their size.

a) Ordinary
b) Simple
c) Complicated
d) Real

Answer: Ordinary

Question: ______integers such as 4, 157, 17777 and -32 are decimal
integer literals of type byte, short or int depending on their size.

a) Ordinary
b) Simple
c) Complicated
d) Real

Answer: Ordinary

Question: Java allows Unicode integer literals called Hexadecimal
whose base is______

a) 10
b) 8
c) 16
d) 32

Answer: 16
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Question: The user can force a smaller number to be long by
appending an_____as a suffix to that number.

a) S or s
b) A or a
c) L or l
d) M or m

Answer: L or l

Question: ____integers are preceded by a minus (-) sign,for example,
-45.

a) Positive
b) Real
c) Large
d) Negative

Answer: Negative

Question: _____numbers use only the digits 0 through 7. In Java, a
numeric literal with a leading 0 (zero) is interpreted as an octal
number.

a) Hexadecimal
b) Octal
c) Decimal
d) Real

Answer: Octal

Question: _______numbers use 16 digits, the usual digits 0 to 9 and the
letters A, B, C, D, E, and F.

a) Hexadecimal
b) Octal
c) Decimal
d) Real

Answer: Hexadecimal

Question: In Hexadecimal, the letters _______ represent the numbers
10 to 15 respectively.

a) A to E
b) A to G
c) A to F
d) A to D

Answer: A to F

Question: In Java, a______literal begins with Ox or OX.
a) Hexadecimal
b) Octal
c) Decimal
d) Real

Answer: Hexadecimal
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Question: Examples of______literals are 0x45 or 0xFF7A.
a) Hexadecimal
b) Octal
c) Decimal
d) Real

Answer: Hexadecimal

Question: _____numbers are also used in character literals to
represent arbitrary Unicode characters.

a) Hexadecimal
b) Octal
c) Decimal
d) Real

Answer: Hexadecimal

Question: A_____literal consists of \u followed by four hexadecimal
digits.

a) Hexacode
b) Unicode
c) Byte code
d) None of these

Answer: Unicode

Question: Which of the following is error free ?
a) For(;;) { int i=10 };
b) While (1) { int i=10 };
c) While (True) { int i=10 };
d) All of these

Answer: All of these

 

Question: The________statement makes use of branchinj decision
making.

a) While
b) For
c) If
d) Do...While

Answer: If

Question: _______literals are called floating point literals.
a) Real integer
b) Real point
c) Real float
d) Real number

Answer: Real number
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Question: _______numbers can be represented using two types of
notations : standard and scientific.

a) Real integer
b) Real point
c) Real float
d) Real number

Answer: Real number

Question: hi standard notations, the integer part and the fractional
part are separated with______for example 12.37.

a) Decimal point (.)
b) Comma (,)
c) Colon (:)
d) Semi-colon (;)

Answer: Decimal point (.)

Question: In scientific notation a number is followed by
letter________and a signed integer exponent, for example 1.3el2 and
12.3737e-108.

a) X or x
b) S or s
c) E or e
d) Both (A) and (C)

Answer: E or e

Question: ________format can be used to express very large and very
small numbers.

a) Scientific
b) Unicode
c) ASCII
d) Binary

Answer: Scientific

Question: In Java, floating point literal by default is of the type_______
a) Long
b) Float
c) Double
d) Single

Answer: Double

Question: The suffix_______can be written in either lower or upper
case.

a) F
b) R
c) X
d) OX

Answer: F
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Question: For the type________there are precisely two literals : true
and false.

a) Integer
b) Real
c) Character
d) Boolean

Answer: Boolean

Question: _______literals are to be types without quotes.
a) Integer
b) Real
c) Character
d) Boolean

Answer: Boolean

 
Question: _______literals represent values, not variables.

a) Integer
b) Real
c) Character
d) Boolean

Answer: Boolean

Question: Boolean values occur most often as the values of
conditional_______

a) Expressions
b) Statements
c) Methods
d) True or false

Answer: Expressions

Question: In C language, 0 is treated as false and_______value is
treated as true.

a) Number
b) Non-zero
c) Character
d) None of these

Answer: Non-zero

Question: In Java, literals true and false are not associated with
any_______value.

a) ASCII
b) Real
c) Numeric
d) Expression

Answer: Numeric
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Question: literals are expressed by a single character surrounded by
single quotes.

a) Integer
b) Real
c) Character
d) Boolean

Answer: Character

Question: Characters are stored as______Unicode characters.
a) 16-bit
b) 8-bit
c) 32-bit
d) 64-bit

Answer: 16-bit

Question: Certain special characters have special literals that use
a_______as an "escape character".

a) Slash (/)
b) Back slash (\)
c) Both (A) and (B)
d) None of these

Answer: Back slash (\)

Question: '\n' Escape code means_______
a) Tab
b) Line
c) New Line
d) Backspace

Answer: New Line

Question: '\t' Escape code means_____
a) Tab
b) Line
c) New Line
d) Backspace

Answer: Tab

Question: A_______is used when a conversion of a value has to be
forced.

a) Fun cast
b) Cast
c) Operator Cast
d) Type Cast

Answer: Type Cast

Question: In Java, operators are evaluated as per their precedence.
a) Order
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b) Continuity
c) Precedence
d) Evaluation

Answer: Precedence

Question: When two operators with the same precedence appear in
the expression, the expression is evaluated according to its______

a) Order
b) Associatively
c) Precedence
d) Evaluation

Answer: Associatively

Question: The Associativity of Unary operators is from :
a) Left-to-Right
b) Right-to-Left
c) Both (A) and (B)
d) None of these

Answer: Right-to-Left

Question: The Associativity of Logical operators is from :
a) Left-to-Right
b) Right-to-Left
c) Both (A) and (B)
d) None of these

Answer: Left-to-Right

Question: The Associativity of Conditional operators is from :
a) Left-to-Right
b) Right-to-Left
c) Both (A) and (B)
d) None of these

Answer: Right-to-Left

Question: The Associativity of Relational operators is from :
a) Left-to-Right
b) Right-to-Left
c) Both (A) and (B)
d) None of these

Answer: Left-to-Right

Question: The statements that enable the flow of ^execution are
considered as______

a) Blocks
b) Structures
c) Control structures
d) Logical structures
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Answer: Control structures

Question: There are_____types of control structures.
a) One
b) Two
c) Three
d) Four

Answer: Two

Question: ________are used to repeat a sequence of statements over
and over until some condition occurs.

a) Structures
b) Charts
c) Branches
d) Loops

Answer: Loops

Question: ______are used to choose among two or more possible
courses of action, so also called selective structure.

a) Structures
b) Blocks
c) Branches
d) Loops

Answer: Branches

 

Question: A block statement is a group of statement enclosed
between a pair of______braces.

a) { and }
b) < and >
c) ( and )
d) [ and ]

Answer: { and }

Question: A______declared inside a block is completely inaccessible
and invisible from OUtSlde that block.

a) Variable
b) Name
c) Integer
d) Number

Answer: Variable

Question: The_______of a variable defined inside a block is limited to
that block only.

a) Area
b) Locality
c) Scope
d) Range
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Answer: Scope

Question: The_____when used in a program enables to take one of
two alternative courses of action, depending on whether the value of
a given Boolean-valued expression is true or false.

a) Else Statement
b) If Statement
c) While
d) Do....while

Answer: If Statement

Question: _____is an example of a "branching" or "decision" or
"selective" control structure.

a) Switch statement
b) If statement
c) While
d) Do....while

Answer: If statement

Question: A_____is used when there are many alternative actions to
be taken depending upon the value of a variable or expression.

a) Switch Statement
b) If Statement
c) While
d) Do....while

Answer: Switch Statement

Question: In the________the test expression should be of the type
byte, char, short or int. It can also be of enum data type.

a) Switch Statement
b) If Statement
c) While
d) Do....while

Answer: Switch Statement

Question: Java supports_____Types of looping constructs.
a) One
b) Two
c) Three
d) Four

Answer: Three

Question: Which of the following is a type of looping construct in
Java ?

a) For
b) While
c) Do...while
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d) All of these

Answer: All of these

 

Question: The_______statement is used to transfer the control outside
switch or loop structure.

a) For
b) While
c) Continue
d) Break

Answer: Break

Question: In a loop______statement is used to exit the loop.
a) For
b) While
c) Continue
d) Break

Answer: Break

Question: Use of______statement is used to skip the following
statements in a loop and continue with the next iteration.

a) For
b) While
c) Continue
d) Break

Answer: Continue

Question: ______of same or different types can be nested in Java.
a) Loops
b) Controls
c) Charts
d) Structures

Answer: Loops

Question: If the programmer wants to control which loop to break
and which loop to reiterate_______can be used.

a) Labeled Controls
b) Labelled Loops
c) Named Controls
d) Named Loops

Answer: Labelled Loops

Question: To use a labelled loop, add the label followed
by_____before the loop.

a) Semi Colon (;)
b) Colon (:)
c) Full stop (.)
d) All of these
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Answer: Colon (:)

Question: The default value of Boolean type data is_____
a) True
b) False
c) 0
d) 1

Answer: False

Question: What will be the result of arithmetic expression 11/2 ?
a) 5
b) 5.5
c) 1
d) 0

Answer: 5.5

Question: 11%2 will give the output as_______
a) 5
b) 5.5
c) 1
d) 0

Answer: 1

Question: ______character set is used for char data type in Javj
a) Unicode
b) EBCIDIC
c) ASCII
d) All of these

Answer: Unicode

Question: What will be the output of the expressio 5*(6+2) 11 ?
a) 19
b) 20
c) 21
d) 22

Answer: 20

Tags: 
CBSE MCQ
CBSE Class 12 Computer Science MCQ
CBSE Class 12 Computer Science pdf MCQ
Class 12 Computer Science MCQ pdf
CBSE Class 12 Computer Science
Computer Science Class 12 MCQ
CBSE Class 12 Computer Science Chapter MCQ
MCQ for Class 12 Computer Science

 

https://www.studiestoday.com/tags/cbse-mcq-7953.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-mcq-20775.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-pdf-mcq-20776.html
https://www.studiestoday.com/tags/class-12-computer-science-mcq-pdf-20777.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-1057.html
https://www.studiestoday.com/tags/computer-science-class-12-mcq-20778.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-chapter-mcq-20779.html
https://www.studiestoday.com/tags/mcq-class-12-computer-science-20780.html


13/09/2022, 20:10 CBSE Class 12 Computer Science Java Basics MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html 15/19

Click for more Computer Science Study Material ›

 Cascading Style Sheets and JavaScript

CBSE Class 12 Computer Science Cascading Style Sheets and JavaScript MCQs

 Classes and Objects In Java

CBSE Class 12 Computer Science Classes and Objects In Java MCQs Set A
CBSE Class 12 Computer Science Classes and Objects In Java MCQs Set B

 Creating HTML Forms Using KompoZer

CBSE Class 12 Computer Science Creating HTML Forms Using KompoZer MCQs Set A
CBSE Class 12 Computer Science Creating HTML Forms Using KompoZer MCQs Set B

 Designing Simple Website Using Kompozer

CBSE Class 12 Computer Science Designing Simple Website Using Kompozer MCQs

 Exception Handling In Java

CBSE Class 12 Computer Science Exception Handling In Java MCQs

 File Handling

CBSE Class 12 Computer Science File Handling MCQs Set A
CBSE Class 12 Computer Science File Handling MCQs Set B

 File System

CBSE Class 12 Computer Science File System MCQs Set A
CBSE Class 12 Computer Science File System MCQs Set B

 Introduction To E Commerce

CBSE Class 12 Computer Science Introduction To E Commerce MCQs

 Introduction To M Commerce

CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set A
CBSE Class 12 Computer Science Introduction To M Commerce MCQs Set B

 Java Basics

CBSE Class 12 Computer Science Java Basics MCQs Set A
CBSE Class 12 Computer Science Java Basics MCQs Set B

 Object Oriented Concepts

CBSE Class 12 Computer Science Object Oriented Concepts MCQs

 Publishing Documents Using Latex

CBSE Class 12 Computer Science Publishing Documents Using Latex MCQs Set A
CBSE Class 12 Computer Science Publishing Documents Using Latex MCQs Set B

Multiple Choice Questions for Class XII Accountancy
Multiple Choice Questions for Class XII Biology
Multiple Choice Questions for Class XII Business Studies

https://www.studiestoday.com/taxonomy/term/448
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-cascading-style-sheets-and-javascript-mcqs-set
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-classes-and-objects-java-mcqs-set-312647.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-classes-and-objects-java-mcqs-set-c-312654.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-creating-html-forms-using-kompozer-mcqs-set
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-creating-html-forms-using-kompozer-mcqs-set-f
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-designing-simple-website-using-kompozer-mcqs-set
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-exception-handling-java-mcqs-set-311066.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-handling-mcqs-set-311074.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-handling-mcqs-set-d-311080.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-system-mcqs-set-311102.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-file-system-mcqs-set-d-311107.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-e-commerce-mcqs-set-311022.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-311028.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-introduction-m-commerce-mcqs-set-e-311035.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-310923.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-object-oriented-concepts-mcqs-set-311042.html
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-publishing-documents-using-latex-mcqs-set-311087
https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-publishing-documents-using-latex-mcqs-set-e
https://www.studiestoday.com/multiple-choice-questions/442/accountancy.html
https://www.studiestoday.com/multiple-choice-questions/446/biology.html
https://www.studiestoday.com/multiple-choice-questions/443/business-studies.html


13/09/2022, 20:10 CBSE Class 12 Computer Science Java Basics MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html 16/19

Multiple Choice Questions for Class XII Chemistry
Multiple Choice Questions for Class XII Entrepreneurship
Multiple Choice Questions for Class XII Economics
Multiple Choice Questions for Class XII Computer Science
Multiple Choice Questions for Class XII English
Multiple Choice Questions for Class XII Geography
Multiple Choice Questions for Class XII History
Multiple Choice Questions for Class XII Informatics Practices
Multiple Choice Questions for Class XII Mathematics
Multiple Choice Questions for Class XII Physics
Multiple Choice Questions for Class XII Political Science

More Study Material
NCERT Solutions
Click here to download NCERT Solutions for questions of Class 12 Computer Science NCERT Book. Access NCERT Solutions for Class 12
Computer Science. Download...
More..

Sample Papers
Download latest 2022 Sample Papers for Class 12 Computer Science as per CBSE NCERT pattern and syllabus. Free Sample Papers with
solutions for Class 12...
More..

Question Papers
Download past year Question Papers for Class 12 Computer Science as per CBSE NCERT KVS syllabus with solutions in pdf free
More..

Printable Worksheets
Download Free printable worksheets for Class 12 Computer Science designed by expert teachers for all important chapters and topics and
is available for free...
More..

Notes
Free revision notes, brief chapter explanations, chapter summary and mind maps for all important and difficult topics of CBSE Class 12
Computer Science as per...
More..

Printable Assignments
Download Class 12 Computer Science assignments. Practice test sheets for Class 12 for Computer Science made for important topics in
NCERT book 2021 available...
More..

Latest Syllabus
Get latest syllabus for Class 12 Computer Science issued by CBSE and NCERT for 2022. Download latest curriculum with important topics,
chapter weightage, topic...
More..

HOTs Questions

https://www.studiestoday.com/multiple-choice-questions/447/chemistry.html
https://www.studiestoday.com/multiple-choice-questions/22669/entrepreneurship.html
https://www.studiestoday.com/multiple-choice-questions/444/economics.html
https://www.studiestoday.com/multiple-choice-questions/448/computer-science.html
https://www.studiestoday.com/multiple-choice-questions/121/english.html
https://www.studiestoday.com/multiple-choice-questions/309/geography.html
https://www.studiestoday.com/multiple-choice-questions/307/history.html
https://www.studiestoday.com/multiple-choice-questions/505/informatics-practices.html
https://www.studiestoday.com/multiple-choice-questions/310/mathematics.html
https://www.studiestoday.com/multiple-choice-questions/449/physics.html
https://www.studiestoday.com/multiple-choice-questions/119/political-science.html
https://www.studiestoday.com/ncert-solution/448/computer-science.html
https://www.studiestoday.com/ncert-solution/448/computer-science.html
https://www.studiestoday.com/sample-paper/448/computer-science.html
https://www.studiestoday.com/sample-paper/448/computer-science.html
https://www.studiestoday.com/question-papers/448/computer-science.html
https://www.studiestoday.com/question-papers/448/computer-science.html
https://www.studiestoday.com/worksheets/448/computer-science.html
https://www.studiestoday.com/worksheets/448/computer-science.html
https://www.studiestoday.com/concepts/448/computer-science.html
https://www.studiestoday.com/concepts/448/computer-science.html
https://www.studiestoday.com/assignments/448/computer-science.html
https://www.studiestoday.com/assignments/448/computer-science.html
https://www.studiestoday.com/syllabus/448/computer-science.html
https://www.studiestoday.com/syllabus/448/computer-science.html


13/09/2022, 20:10 CBSE Class 12 Computer Science Java Basics MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html 17/19

Download HOTs Questions for Class 12 Computer Science for all important topics in Class 12 Computer Science based on CBSE NCERT
syllabus and latest pattern....
More..

VBQ
Access latest VBQ, Value Based Questions for Class 12 Computer Science as per CBSE and NCERT syllabus. Download all VBQ for Class 12
Computer Science in pdf...
More..

MCQs
Click here to free download Pdf for MCQs for Class 12 Computer Science for important topics and CBSE NCERT Chapters, Download latest
MCQ questions with answers...
More..

Useful Resources
Free download latest Useful Resources like important concepts, sure shot questions, guess papers, exam notes and other study material for
CBSE Class 12...
More..

Online Test
Free CBSE Class 12 Computer Science Online Mock Test with important multiple choice questions as per CBSE syllabus
More..

Practice Worksheets
Download free Printable Worksheets, test papers with questions and answers for Class 12 Computer Science for all important topics and
chapters as per CBSE,...
More..

Tags: 
CBSE MCQ
CBSE Class 12 Computer Science MCQ
CBSE Class 12 Computer Science pdf MCQ
Class 12 Computer Science MCQ pdf
CBSE Class 12 Computer Science
Computer Science Class 12 MCQ
CBSE Class 12 Computer Science Chapter MCQ
MCQ for Class 12 Computer Science

 

https://www.studiestoday.com/hot-questions/448/computer-science.html
https://www.studiestoday.com/hot-questions/448/computer-science.html
https://www.studiestoday.com/value-based-questions/448/computer-science.html
https://www.studiestoday.com/value-based-questions/448/computer-science.html
https://www.studiestoday.com/multiple-choice-questions/448/computer-science.html
https://www.studiestoday.com/multiple-choice-questions/448/computer-science.html
https://www.studiestoday.com/useful-resources/448/computer-science.html
https://www.studiestoday.com/useful-resources/448/computer-science.html
https://www.studiestoday.com/online-test/448/computer-science.html
https://www.studiestoday.com/online-test/448/computer-science.html
https://www.studiestoday.com/printable-worksheets/448/computer-science.html
https://www.studiestoday.com/printable-worksheets/448/computer-science.html
https://www.studiestoday.com/tags/cbse-mcq-7953.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-mcq-20775.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-pdf-mcq-20776.html
https://www.studiestoday.com/tags/class-12-computer-science-mcq-pdf-20777.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-1057.html
https://www.studiestoday.com/tags/computer-science-class-12-mcq-20778.html
https://www.studiestoday.com/tags/cbse-class-12-computer-science-chapter-mcq-20779.html
https://www.studiestoday.com/tags/mcq-class-12-computer-science-20780.html
whatsapp://send?text=https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html
mailto:?subject=&body=For%20more%20details%20go%20through%20with%20the%20url:%20https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html
https://www.studiestoday.com/blog-entry/online-courses-classes-xi-and-xii-offered-ncert-398051.html
https://www.studiestoday.com/blog-entry/cbse-notification-402021-innovation-ambassador-program-398050.html


13/09/2022, 20:10 CBSE Class 12 Computer Science Java Basics MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html 18/19

Quick Links
Syllabus
Sample Paper
NCERT Solution
Question Papers
Download Books
Concepts
Printable Assignments
Printable Worksheets
HOTs
VBQs
MCQs
Online Test

Useful Links
About Us
Contact Us
Follow us on Twitter

More CBSE News 

Online courses for classes XI
and XII offered by NCERT
Ministry of Education (MoE), Government of India
has launched a platform for offering Massive Open
Online Courses (MOOCs) that is popularly known
as SWAYAM (Study Webs of Active learning for
Young Aspiring Minds) on 9 th July, 2017. NCERT
now offers online courses for...

Read More

CBSE notification 40/2021
Innovation Ambassador
Program
This is with reference to CBSE Notification No.
40/2021 dated 04.05.2021 regarding the
Innovation Ambassador program – An online
training program for teachers by CBSE in
collaboration with Ministry of Education’s
Innovation Cell (MIC) and AICTE. In view of the
current...

Read More


Class 10th and 12th Term 2
Revaluation Process 2022
Evaluation of the Answer Books is done under a
well-settled Policy. To ensure that the evaluation is
error free, CBSE is taking several steps. After strictly
following these steps, the result is prepared.
Though, CBSE is having a well-settled system of
assessment,...

Read More



CBSE Science Challenge
2021 22
Science is inexplicably linked with our lives and
helps us to understand the world around us better.
Scientific and technological developments
contribute to progress and help improve our
standards of living. By engaging with this subject,
students learn to think, solve...

Read More


Permission to opt for
Mathematics in Class 11
You are aware that session 2022 has also been
affected severely by Covid and the session has
already been delayed, now there is a need for the
remaining activities of this session to be completed
on time. As per the earlier circular, students of
Class 10 who have...

Read More



CBSE Class 10 Revised
Syllabus
Last year CBSE had to reduce the syllabus because
of the pandemic situation but it was not very
effective because there were no examinations. This
year to avoid any confusion and conflict, CBSE has
decided to reduce the syllabus into term 1 and
term 2. 50 percent of...

Read More

https://www.studiestoday.com/syllabus/67/cbse.html
https://www.studiestoday.com/sample-paper/67/cbse.html
https://www.studiestoday.com/ncert-solution/67/cbse.html
https://www.studiestoday.com/question-papers/67/cbse.html
https://www.studiestoday.com/download-books/67/cbse.html
https://www.studiestoday.com/concepts/67/cbse.html
https://www.studiestoday.com/assignments/67/cbse.html
https://www.studiestoday.com/worksheets/67/cbse.html
https://www.studiestoday.com/hot-questions/67/cbse.html
https://www.studiestoday.com/value-based-questions/67/cbse.html
https://www.studiestoday.com/multiple-choice-questions/67/cbse.html
https://www.studiestoday.com/online-test/67/cbse.html
https://www.studiestoday.com/about-us
https://www.studiestoday.com/basic-page/contact-us-227810.html
https://twitter.com/studiestoday
https://www.studiestoday.com/blog
https://www.studiestoday.com/blog-entry/online-courses-classes-xi-and-xii-offered-ncert-398051.html
https://www.studiestoday.com/blog-entry/online-courses-classes-xi-and-xii-offered-ncert-398051.html
https://www.studiestoday.com/blog-entry/cbse-notification-402021-innovation-ambassador-program-398050.html
https://www.studiestoday.com/blog-entry/cbse-notification-402021-innovation-ambassador-program-398050.html
https://www.studiestoday.com/blog-entry/class-10th-term-2-revaluation-process-2022-410793.html
https://www.studiestoday.com/blog-entry/class-10th-term-2-revaluation-process-2022-410793.html
https://www.studiestoday.com/blog-entry/cbse-science-challenge-2021-22-399083.html
https://www.studiestoday.com/blog-entry/cbse-science-challenge-2021-22-399083.html
https://www.studiestoday.com/blog-entry/permission-opt-mathematics-class-11-412310.html
https://www.studiestoday.com/blog-entry/permission-opt-mathematics-class-11-412310.html
https://www.studiestoday.com/blog-entry/cbse-class-10-revised-syllabus-389231.html
https://www.studiestoday.com/blog-entry/cbse-class-10-revised-syllabus-389231.html


13/09/2022, 20:10 CBSE Class 12 Computer Science Java Basics MCQs Set B, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-java-basics-mcqs-set-e-310934.html 19/19

Search Tutors by Pin Code

Enter pincode to get tutors in your city.

Search Reset

Disclaimer
Privacy Policy
Report an Issue
Copyright Notice

Search Tutors

Copyright © 2022 M/s Studiestoday

https://www.studiestoday.com/basic-page/disclaimer-7.html
https://www.studiestoday.com/basic-page/privacy-policy-120.html
https://www.studiestoday.com/webform/report-issue-234840.html
https://www.studiestoday.com/reproduction-copyrights
https://www.studiestoday.com/


13/09/2022, 20:10 CBSE Class 12 Computer Science Object Oriented Concepts MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-object-oriented-concepts-mcqs-set-311042.html 1/36

Find Tutor

Search Tutors Tutor Registration Tutor Login

▾ Courses ▾ CBSE ▾ NCERT Solutions ▾ Download ▾ Solutions  MCQ Questions ▾ Free Worksheets

▾ Online Test  Blog ▾ State Boards1. CBSE
2. » Class XII
3. » Computer Science
4. » CBSE Class 12 Computer Science Object Oriented Concepts MCQs

CBSE Class 12 Computer Science Object
Oriented Concepts MCQs
Download PDF

Computer Science

CBSE Class 12 Computer Science Object Oriented Concepts MCQs with answers available in Pdf for free
download. The MCQ Questions for Class 12 Computer Science with answers have been prepared as per the
latest syllabus, NCERT books and examination pattern suggested in Standard 12 by CBSE, NCERT and KVS.
Multiple Choice Questions are an important part of Term 1 and Term 2 exams for Grade 12 Computer
Science and if practiced properly can help you to get higher marks. Refer to more Chapter-wise MCQs for
NCERT Class 12 Computer Science and also download more latest study material for all subjects

Object Oriented Concepts Class 12 Computer
Science MCQ
Class 12 Computer Science students should refer to the following multiple-choice questions with answers
for Object Oriented Concepts in standard 12. These MCQ questions with answers for Grade 12 Computer
Science will come in exams and help you to score good marks

Object Oriented Concepts MCQ Questions Class 12
Computer Science with Answers

Question: In Object-oriented methodology, the focus is on which of
the following entities ?

a) Data
b) Functions
c) Objects
d) All of the above

Answer: Objects

Question: Which of the following best suits to Java ?
a) A procedural programming language
b) An object oriented programming language
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c) A Query language
d) All of the above

Answer: An object oriented programming language

Question: Which of the following is used to distinguish objects from
each other?

a) Attributes
b) State
c) Behavior
d) All of the above

Answer: State

Question: Which of the following is used to define common features
of similar objects?

a) Class
b) Object
c) Methods
d) All of the above

Answer: Class

Question: Which of the following is not a visibility symbol ?
a) ~
b) *
c) #
d) -

Answer: *

Question: Which of the following is provided using encapsulation ?
a) Data protection
b) Data sharing
c) Separation of data and methods
d) All of these

Answer: Data protection

Question: Which of the following is enabled by data abstraction ?
a) Data protection
b) Data hiding
c) To hide implementation details of method manipulating the data
d) All of these

Answer: To hide implementation details of method manipulating the data

Question: With which of the following options polymorphism cannot
be achieved ?

a) Method overloading
b) Operator overloading
c) Data hiding
d) All of these
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Answer: Data hiding

Question: An aggregation model refers to which of the following
relationships ?

a) 'is-a' relationship
b) 'is-like' relationship
c) 'a-part-of relationship
d) All of these

Answer: 'is-a' relationship

 

Question: An inheritance model refers to which of the following
relationships ?

a) 'is-a' relationship
b) 'has-a' relationship
c) 'a-part-of relationship
d) All of these

Answer: 'is-a' relationship

Question: In class diagram, composition is represented using which
of the following symbols ?

a) Empty diamond symbol
b) Filled diamond symbol
c) Empty triangle symbol
d) All of these

Answer: Filled diamond symbol

Question: Object-oriented programming concepts started originating
in the_______

a) 1950s
b) 1960s
c) 1970s
d) 1980s

Answer: 1960s

Question: Since mid______object-oriented programming had become
the main programming paradigm used in the creation of new
software.

a) 1950s
b) 1960s
c) 1970s
d) 1980s

Answer: 1980s

Question: Some of the popular programming languages that
support______programming are C++, Java, C#, VB.net, ASP.net and
PHP.

a) Object-oriented
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b) Structural
c) Modular
d) Procedural

Answer: Object-oriented

Question: The way of programming can be divided
into______categories.

a) Four
b) Three
c) Two
d) One

Answer: Two

Question: Java is a_____programming language.
a) Object-oriented
b) Structural
c) Modular
d) Procedural

Answer: Object-oriented

Question: The categories are______and object-oriented.
a) Objective
b) Structure/procedural
c) Modular
d) Functional

Answer: Structure/procedural

Question: In_______programming, the focus is on writing functions or
procedures which operate on data.

a) Procedural
b) Modular
c) Functional
d) None of these

Answer: Procedural

Question: In object-oriented_____the focus is on objects which
contain data and functionality together.

a) Pattern
b) Prototype
c) Paradigm
d) Example

Answer: Paradigm

Question: The power of object-oriented programming language
enables the programmer to create modular, reusable and_____code.

a) Complete
b) Accomplished
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c) Perfect
d) Executable

Answer: Executable

Question: Flexibility is gained by being able to change or
replace______without disturbing other parts of code.

a) Modules
b) Parts
c) Functions
d) Methods

Answer: Modules

Question: Object-oriented programming uses_____as its fundamental
building block.

a) Method
b) Class
c) Object
d) Procedure

Answer: Object

Question: A computer language is object-oriented if they support
four specific object properties called

a) Abstraction
b) Encapsulation
c) Polymorphism and Inheritance
d) All of these

Answer: All of these

Question: C# is a______programming language.
a) Object-oriented
b) Structural
c) Modular
d) Procedural

Answer: Object-oriented

Question: In the real world______are the entities of which the world is
comprised.

a) Methods
b) Classes
c) Objects
d) Procedures

Answer: Objects

Question: Some objects can be______things like person, car or a cup
of coffee.

a) Abstract
b) Concrete
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c) Real
d) Solid

Answer: Concrete

Question: Some objects may be______that do not represent things
which can be touched or seen.

a) Abstract
b) Concrete
c) Real
d) Solid

Answer: Abstract

Question: All objects have unique______and are distinguishable from
each other.

a) Personality
b) Objects
c) Procedures
d) Identity

Answer: Identity

Question: In object-oriented terminology characteristics are known
as properties or_______

a) Features
b) Attributes
c) Values
d) States

Answer: Attributes

Question: To uniquely distinguish one person from other,the______of
its characteristics is used.

a) Worth
b) Cost
c) Value
d) Property

Answer: Value

 

Question: When two people have same name, they can be
distinguished using other attributes like______

a) Color
b) Name
c) Birth-date
d) Behavior

Answer: Birth-date

Question: To identifythe value of the attributes is used.
a) Personality
b) Objects



13/09/2022, 20:10 CBSE Class 12 Computer Science Object Oriented Concepts MCQs, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-object-oriented-concepts-mcqs-set-311042.html 7/36

c) Procedures
d) Identity

Answer: Objects

Question: There is always a behavior associated with
a) Personality
b) Objects
c) Procedures
d) Identity

Answer: Objects

Question: The behavior of objects is also known as
a) Method
b) Technique
c) Process
d) Procedure

Answer: Method

Question: The_______of the object can change due to its behavior.
a) State
b) Method
c) Status
d) Class

Answer: State

Question: Object can be described in terms of
a) What it is called (identity)
b) What it is (its state)
c) What it does (behavior)
d) All of these

Answer: All of these

Question: In object-oriented programming, attributes that describe
the object are also referred to as_____fields.

a) Information
b) Method
c) Data
d) Name

Answer: Data

Question: The data attributes and behavioral methods associated
with an object are collectively referred to as its____or features.

a) Component
b) Associate
c) Part
d) Member

Answer: Member
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Question: _______system uses the concept of class that enables to
express the set of objects that are abstractly equivalent, differing
only in the values of their attributes.

a) Object-oriented
b) Value-oriented
c) Data-oriented
d) All of these

Answer: Object-oriented

Question: ______can be considered as a blueprint for various objects.
a) Method
b) Class
c) Object
d) Member

Answer: Class

 

Question: A class is a_______for multiple objects with similar features.
a) Image
b) Representation
c) Template
d) Guide

Answer: Template

Question: A class describes a group of objects with similar______and
common behaviour.

a) Features
b) Attributes
c) Values
d) States

Answer: Attributes

Question: _______in the same class share a common semantic
purpose.

a) Methods
b) Classes
c) Objects
d) Members

Answer: Objects

Question: _______is a general concept used to embody all the
common features of a particular set of objects.

a) Method
b) Class
c) Object
d) Member

Answer: Class
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Question: The class______presents a collection of classes, constraints
and relationship among classes.

a) Diagram
b) Map
c) Drawing
d) Figure

Answer: Diagram

Question: _______can be used to create models of object-oriented
software to help with design of an application.

a) ULM
b) UML
c) LUM
d) MUL

Answer: UML

Question: _______is a visual modeling language defined and
maintained by the Object Management Group.

a) ULM
b) UML
c) LUM
d) MUL

Answer: UML

Question: _______specifies several diagrams for representing different
aspects of a software application.

a) ULM
b) UML
c) LUM
d) MUL

Answer: UML

Question: The purpose of the class________is to model the static view
of an application.

a) Diagram
b) Map
c) Drawing
d) Figure

Answer: Diagram

Question: The class's diagrams are only diagrams which can be
directly mapped with object-oriented.

a) Methods
b) Procedures
c) Languages
d) Attributes

Answer: Languages
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Question: In class diagram, a class is represented with an icon using a
rectangle split into______sections to present name, attributes and
behaviour.

a) One
b) Two
c) Three
d) Four

Answer: Three

Question: In the class diagram, the name is in the______section.
a) Top
b) Middle
c) Centre
d) Bottom

Answer: Top

Question: In the class diagram, the attributes or methods are in
the_____section.

a) Top
b) Middle
c) Centre
d) Bottom

Answer: Middle

Question: In the class diagram, the behaviour or operations are in
the_____section.

a) Top
b) Middle
c) Centre
d) Bottom

Answer: Bottom

Question: Full form of UML is______
a) Unified Modelling Language
b) United Modelling Language
c) United Model of Languages
d) None of these

Answer: Unified Modelling Language

Question: Full form of OMG is______
a) Oriented Management Group
b) Oriented Managing Group
c) Object Management Group
d) Object Management Grouping

Answer: Object Management Group
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Question: In UML notation, an attribute is declared using the
following syntax :

a) [][:[=]]
b) [][:]]
c) [][:] ]
d)[:[=]]

Answer: [] [:]]

Question: In an attribute declaration, the______brackets are optional.
a) Round
b) Chain
c) Angle
d) Square

Answer: Square

Question: In an attribute declaration, the values should be specified
in the_____brackets.

a) Round
b) Chain
c) Angle
d) Square

Answer: Angle

Question: In an attribute declaration, the______can be private,
protected, public or package.

a) Visibility
b) Invisible
c) Evident
d) Obvious

Answer: Visibility

 

Question: In an attribute declaration, the private visibility is
represented by_____symbol.

a) -
b) #
c) +
d) ~

Answer: -

Question: In an attribute declaration, the protected visibility is
represented by______symbol.

a) -
b) #
c) +
d) ~

Answer: #
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Question: In an attribute declaration, the public visibility is
represented by_____symbol.

a) -
b) #
c) +
d) ~

Answer: +

Question: In an attribute declaration, the package visibility is
represented by_____symbol.

a) -
b) #
c) +
d) ~

Answer: ~

Question: Attribute generally refers to a______
a) Variable
b) Property
c) Value
d) Class

Answer: Variable

Question: _______type and initial value identify the type of data stored
and its value at the start of the program.

a) Data
b) Date
c) Value
d) Class

Answer: Data

Question: ______is an example of declaring attribute.
a) Name:- string;
b) Name : string
c) Name ++string
d) Name = string

Answer: Name : string

Question: In UML notation, an operation is declared using_____syntax:
a) [](parameter list separated by comma):
b) [](parameter list separated by comma):
c) [](parameter list separated by comma):
d) None of these.

Answer: [](parameter list separated by comma):

Question: ________diagrams are independent of the programming
language used for coding an application.
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a) ULM
b) UML
c) LUM
d) MUL

Answer: UML

Question: _______are presented using their state during execution of
an application.

a) Methods
b) Procedures
c) Classes
d) Objects

Answer: Objects

Question: Objects are_______
a) Dynamic
b) Vibrant
c) Colorful
d) All of these

Answer: Dynamic

 
Question: An object is also called an______

a) Image
b) Illustration
c) Instance
d) Occurrence

Answer: Instance

Question: For any computer program, two or more elements are data
and________

a) Method
b) Function
c) Information
d) Procedure

Answer: Function

Question: Structured/Procedural programming views the two core
elements as______separate entities.

a) One
b) Two
c) Three
d) None of these

Answer: Two

Question: ________programming views the two coreentities as single
entity.

a) Object-oriented
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b) Structured
c) Procedural
d) Instance

Answer: Object-oriented

Question: In______programming, data can be altered by any
component of the program.

a) Object-oriented
b) Structured
c) Procedural
d) Instance

Answer: Procedural

Question: In object-oriented programming, the problem of
modification can be solved using______

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Encapsulation

Question: Data and the methods that______data are guarded against
modification or misuse by other components of the program.

a) Change
b) Modify
c) Manipulate
d) Imitate

Answer: Manipulate

Question: The mechanism of providing protection to data and
methods of a program is called______

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Encapsulation

Question: ______is possible by wrapping data and methods into a
single unit known as class and declaring them as private.

a) Encapsulation
b) Abstraction
c) Messaging
d) Polymorphism

Answer: Encapsulation

Question: ________members of the class are not available directly to
outside world.
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a) Private
b) Public
c) Void
d) Static

Answer: Private

Question: Data can be made available via public______to the outside
world.

a) Messages
b) Methods
c) Function
d) Declarations

Answer: Methods

Question: Encapsulation provides______hiding capability.
a) Information
b) Data
c) Code
d) Class

Answer: Data

Question: _______keeps the data safe from unintended actions and
inadvertent access by outside objects.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Encapsulation

Question: ________programming discourages direct access to common
data by other programs.

a) Object-oriented
b) Structured
c) Procedural
d) Instance

Answer: Object-oriented

Question: Only the object that______the data can change its content.
a) Holds
b) Possesses
c) Owns
d) Creates

Answer: Owns

Question: Other objects can view or change this data by sending
message to the "owner".

a) Vendor
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b) Businessman
c) Owner
d) Viewer

Answer: Owner

Question: Data______is a process of representing the essential
features of the objects without including implementation detail.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: _______is a concept that hides the complexity; it says what it
does, but not how it is done.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: Data______thus is a technique that relies on the separation
of interface and implementation.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

 

Question: A user defined______with necessary input data parameters
also provides data abstraction.

a) Messages
b) Methods
c) Function
d) Declarations

Answer: Function

Question: The signature of the function means the name of the
function, number and type of parameters and the return type
of______

a) Parameters
b) Methods
c) Parts
d) Variables

Answer: Parameters
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Question: Data_____provides the skeleton or templates for the
programmers use. The system hides certain details of how data is
stored, created and maintained.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: All that is______to the rest of the world is the abstract
behaviour of the data type.

a) Invisible
b) Hidden
c) Seen
d) Visible

Answer: Visible

Question: ______or structures (struct) in C/C++, classes / Java are
examples for data abstraction.

a) ADVT
b) TDA
c) DAT
d) ADT

Answer: ADT

Question: Full form of ADT is________
a) Abstraction Date Type
b) Abstract Date Type
c) Abstract Data Type
d) Abstract Data Template

Answer: Abstract Data Type

Question: In___it is simply defined a data type and a set of operations
on it. The implementation of operations is not seen.

a) ADVT
b) TDA
c) DAT
d) ADT

Answer: ADT

Question: Encapsulation_____data by making them inaccessible from
outside.

a) Hides
b) Protects
c) Displays
d) Harms

Answer: Protects
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Question: _______enables to represent data in which the
implementation details are hidden.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: In object-oriented terminology, a call to a method is
referred to as a______

a) Message
b) Function
c) Call
d) Letter

Answer: Message

 

Question: ________represents 'has-a' or 'a-part-of relationship
between classes.

a) Aggregation
b) Polymorphism
c) Work
d) Messaging

Answer: Aggregation

Question: ______represents non-exclusive relationship between two
classes.

a) Polymorphism
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Aggregation

Question: In_____the class that forms part of the owner class can exist
independently.

a) Polymorphism
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Aggregation

Question: The life of an______of the part class is not determined by
the owner class.

a) Variable
b) Parameter
c) Operator
d) Object
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Answer: Object

Question: Although the motherboard is part of the computer, it can
exist as a separate item independent of the_______

a) Workstation
b) System
c) Computer
d) Processor

Answer: Computer

Question: Basic aggregation is represented using an
empty_______symbol next to the whole class.

a) Square
b) Diamond
c) Triangle
d) Circle

Answer: Diamond

Question: ________represents exclusive relationship between two
classes.

a) Composition
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Composition

Question: ______is a strong type of aggregation where the lifetime of
the part class depends on the existence of the owner class.

a) Composition
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Composition

Question: If an object of aggregating class is deleted, its
part_______object also gets deleted.

a) Function
b) Message
c) Class
d) Variable

Answer: Class

Question: When an object of class Person is deleted, the object of
class Name is also______

a) Removed
b) Deleted
c) Detached
d) Attached
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Answer: Deleted

 
Question: _______property suits best with Java.

a) A Structured Language
b) An Object-oriented Language
c) A Procedural Language
d) An Interpreting Language

Answer: An Object-oriented Language

Question: is provided while using encapsulation.
a) Data Protection
b) Data Hiding
c) Data Sharing
d) Data and Methods Separation

Answer: Data Protection

Question: The focus is on_____entity in an object-oriented
methodology.

a) Functions
b) Data
c) Classes
d) Objects

Answer: Objects

Question: In class diagram, basic aggregation is represented using
which of the following symbols ?

a) Empty triangle symbol
b) Filled triangle symbol
c) Filled diamond symbol
d) Empty diamond symbol

Answer: Empty diamond symbol

Question: The data type for NAME variable should be______
a) String
b) Char
c) Date
d) Int

Answer: String

Question: The data type for BIRTHDATE variable should be____
a) String
b) Char
c) Date
d) Int

Answer: Date
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Question: The data type for GENDER variable should be
a) String
b) Char
c) Double
d) Int

Answer: Char

Question: The data type for NO_OF_STUDENTS variable should
be_______

a) String
b) Char
c) Double
d) Int

Answer: Int

Question: _______is used to define common features of similar
objects.

a) Class
b) Procedure
c) Object
d) Method

Answer: Method

Question: The output of the function sqrt(25) is_______
a) 5
b) 10
c) 15
d) 20

Answer: 5

 

Question: A user defined______with necessary input data parameters
also provides data abstraction.

a) Messages
b) Methods
c) Function
d) Declarations

Answer: Function

Question: The signature of the function means the name of the
function, number and type of parameters and the return type
of______

a) Parameters
b) Methods
c) Parts
d) Variables

Answer: Parameters
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Question: Data_____provides the skeleton or templates for the
programmers use. The system hides certain details of how data is
stored, created and maintained.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: All that is______to the rest of the world is the abstract
behaviour of the data type.

a) Invisible
b) Hidden
c) Seen
d) Visible

Answer: Visible

Question: ______or structures (struct) in C/C++, classes / Java are
examples for data abstraction.

a) ADVT
b) TDA
c) DAT
d) ADT

Answer: ADT

Question: Full form of ADT is________
a) Abstraction Date Type
b) Abstract Date Type
c) Abstract Data Type
d) Abstract Data Template

Answer: Abstract Data Type

Question: In___it is simply defined a data type and a set of operations
on it. The implementation of operations is not seen.

a) ADVT
b) TDA
c) DAT
d) ADT

Answer: ADT

Question: Encapsulation_____data by making them inaccessible from
outside.

a) Hides
b) Protects
c) Displays
d) Harms

Answer: Protects
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Question: _______enables to represent data in which the
implementation details are hidden.

a) Polymorphism
b) Abstraction
c) Messaging
d) Encapsulation

Answer: Abstraction

Question: In object-oriented terminology, a call to a method is
referred to as a______

a) Message
b) Function
c) Call
d) Letter

Answer: Message

 

Question: ________represents 'has-a' or 'a-part-of relationship
between classes.

a) Aggregation
b) Polymorphism
c) Work
d) Messaging

Answer: Aggregation

Question: ______represents non-exclusive relationship between two
classes.

a) Polymorphism
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Aggregation

Question: In_____the class that forms part of the owner class can exist
independently.

a) Polymorphism
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Aggregation

Question: The life of an______of the part class is not determined by
the owner class.

a) Variable
b) Parameter
c) Operator
d) Object
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Answer: Object

Question: Although the motherboard is part of the computer, it can
exist as a separate item independent of the_______

a) Workstation
b) System
c) Computer
d) Processor

Answer: Computer

Question: Basic aggregation is represented using an
empty_______symbol next to the whole class.

a) Square
b) Diamond
c) Triangle
d) Circle

Answer: Diamond

Question: ________represents exclusive relationship between two
classes.

a) Composition
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Composition

Question: ______is a strong type of aggregation where the lifetime of
the part class depends on the existence of the owner class.

a) Composition
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Composition

Question: If an object of aggregating class is deleted, its
part_______object also gets deleted.

a) Function
b) Message
c) Class
d) Variable

Answer: Class

Question: When an object of class Person is deleted, the object of
class Name is also______

a) Removed
b) Deleted
c) Detached
d) Attached
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Answer: Deleted

 
Question: _______property suits best with Java.

a) A Structured Language
b) An Object-oriented Language
c) A Procedural Language
d) An Interpreting Language

Answer: An Object-oriented Language

Question: is provided while using encapsulation.
a) Data Protection
b) Data Hiding
c) Data Sharing
d) Data and Methods Separation

Answer: Data Protection

Question: The focus is on_____entity in an object-oriented
methodology.

a) Functions
b) Data
c) Classes
d) Objects

Answer: Objects

Question: In class diagram, basic aggregation is represented using
which of the following symbols ?

a) Empty triangle symbol
b) Filled triangle symbol
c) Filled diamond symbol
d) Empty diamond symbol

Answer: Empty diamond symbol

Question: The data type for NAME variable should be______
a) String
b) Char
c) Date
d) Int

Answer: String

Question: The data type for BIRTHDATE variable should be____
a) String
b) Char
c) Date
d) Int

Answer: Date
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Question: The data type for GENDER variable should be
a) String
b) Char
c) Double
d) Int

Answer: Char

Question: The data type for NO_OF_STUDENTS variable should
be_______

a) String
b) Char
c) Double
d) Int

Answer: Int

Question: _______is used to define common features of similar
objects.

a) Class
b) Procedure
c) Object
d) Method

Answer: Method

Question: The output of the function sqrt(25) is_______
a) 5
b) 10
c) 15
d) 20

Answer: 5

 

Question: _______is generally referred to as 'is-a-kind-of relationship
between two classes.

a) Composition
b) Aggregation
c) Inheritance
d) Abstraction

Answer: Inheritance

Question: ________refers to the capability of defining a new class of
objects that inherits the characteristics of another existing class.

a) Inheritance
b) Composition
c) Aggregation
d) Messaging

Answer: Inheritance
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Question: In object-oriented terminology_______class is called sub
class or child class or derived class.

a) Latest
b) New
c) Old
d) Super

Answer: New

Question: The existing class is called______class or parent class or base
class.

a) Sub
b) New
c) Super
d) Child

Answer: Super

Question: The data_______and methods of the super class are
available to objects in the sub class without rewriting their
declarations.

a) Attributes
b) Properties
c) Operators
d) Features

Answer: Attributes

Question: The above feature (mention in above question provides)
reusability where existing method can be reused without______

a) Introduction
b) Availability
c) Definition
d) Redefining

Answer: Redefining

Question: Additionally new data and method members can be added
to the______class as an extension.

a) Sub
b) New
c) Super
d) Child

Answer: Sub

Question: In a class diagram, inheritance is represented using an
arrow pointing to______class.

a) Sub
b) New
c) Super
d) Child

Answer: Super
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Question: _________is another name for inheritance or 'is
a'relationship.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Generalization

Question: ________refers to a relationship between two classes where
one class is a specialized version of another.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Generalization

Question: Common attributes and methods are defined in______class.
a) Sub
b) New
c) Super
d) Child

Answer: Super

 

Question: _________class is a specialized version with additional
attributes and methods.

a) Sub
b) New
c) Super
d) Child

Answer: Sub

Question: A_______can be derived using more than parent classes.
a) Method
b) Program
c) Class
d) Variable

Answer: Class

Question: When a class is derived from two or more classes, it is
known as multiple________

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Inheritance
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Question: In_____class inherits from other classes in order to share,
reuse or extend functionality.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Inheritance

Question: In_______classes do not inherit from other classes, but are
'composed of other classes.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Composition

Question: _________as methodology is playing a significant role in
analysis, design and implementation of software system.

a) Object-oriented
b) Structure-oriented
c) Procedure-oriented
d) Aggregation-oriented

Answer: Object-oriented

Question: When a class contains objects of other class, the container
class is called______class or whole class or aggregating class.

a) Sub
b) Owner
c) Super
d) Whole

Answer: Owner

Question: The class that is contained in owner class is known
as_______class or part class or aggregated class.

a) Sub
b) Owner
c) Subject
d) Super

Answer: Subject

Question: ________represents non-exclusive relationship between two
classes.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Aggregation
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Question: represents exclusive relationship between two classes.
a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Composition

Question: When there is 'is-a' or 'a-kind-of relationship between two
classes, there is_____relationship.

a) Aggregation
b) Composition
c) Inheritance
d) Generalization

Answer: Inheritance

Question: General features or common features of two classes are
implemented in the______class.

a) Sub
b) Owner
c) Subject
d) Super

Answer: Super

Question: Special features of two classes are implemented in sub
class.

a) Sub
b) Owner
c) Subject
d) Super

Answer: Sub

Question: In class diagram, composition is represented using which
of the following symbols ?

a) Empty triangle symbol
b) Filled triangle symbol
c) Filled diamond symbol
d) Empty diamond symbol

Answer: Filled diamond symbol

Question: An inheritance model refers to which of the following
relationships ?

a) Has-a-relationship'
b) A-part-of relationship
c) Is-a-part-of relationship
d) Is-a' relationship

Answer: Is-a' relationship
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Question: Which of the following is enabled by data abstraction ?
a) Data protection
b) Data hiding
c) Hide implementation details
d) Hide relationship details

Answer: Hide implementation details

Question: Polymorphism cannot be achieved by which of the
following ?

a) Operator overloading
b) Data hiding
c) Method overloading
d) None of these

Answer: Data hiding

Question: Which of the following model refers to an aggregation ?
a) A-part-of relationship
b) Is-like' relationship
c) Is-a' relationship
d) Has-a' relationship

Answer: A-part-of relationship

Question: _______is used to distinguish objects from each other.
a) Attributes
b) Behaviour
c) State
d) All of these

Answer: State
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Question: Most LaTeX distribution software includes_______and some
additional software in them.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: TeX

Question: TeX Live is a very popular LaTeX distribution software
which is available in the standard_______repositories.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: Ubuntu

Question: While using LaTeX, there is also a need for
plain_______editor and software to view the output file.

a) Text
b) Transcript
c) Script
d) Word

Answer: Text

Question: LaTeX can produce output in different file______
a) Arrangements
b) Formats
c) Editors
d) Software's

Answer: Formats

Question: Depending on the output of file_______corresponding
viewer software is needed.

a) Arrangement
b) Format
c) Editor
d) Software

Answer: Format

Question: LaTeX documents are typically created using any
plain______editor.

a) Text
b) Transcript
c) Script
d) Word

Answer: Text
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Question: ______are examples of plain text editors.
a) Gedit
b) SciTE
c) Both (A) and (B)
d) None of these

Answer: Both (A) and (B)

Question: The different parts of the text are marked
using________commands that associate a meaning to them.

a) LaTeX
b) Simple
c) TeX
d) HTML

Answer: LaTeX

Question: _______command is used to define the document's title.
a) \ title
b) \author
c) \date
d) \document

Answer: \ title

Question: ________command is used to specify the author(s) of the
document.

a) \title
b) \author
c) \date
d) \document

Answer: \author

 
Question: ______command is used to indicate the date the document
was created.

a) \title
b) \author
c) \date
d) \document

Answer: \date

Question: ______command can be used to explicitly specify the logical
structure of the document.

a) \ chapter
b) \ section
c) \paragraph
d) All of these

Answer: All of these
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Question: LaTeX comes with______ways to format these document
elements in a pleasant looking professional style.

a) Integrated
b) Built-in
c) Many
d) Incorporated

Answer: Integrated

Question: When typing the document, one can see it as
plain______text with the built-in commands written as part of the text.

a) Unformatted
b) Formatted
c) In-line
d) None of these

Answer: Unformatted

Question: The document is compiled (processed) using the
LaTeX_____and an output file is produced.

a) Organization
b) Commands
c) System
d) Document

Answer: System

Question: While compilation, LaTeX can also produce some
additional_______

a) Records
b) Archives
c) Files
d) Directories

Answer: Files

Question: The produced additional files can be_______safely without
losing any information.

a) Read
b) Deleted
c) Saved
d) Documented

Answer: Deleted

Question: When the output file is viewed using appropriate software
or print it on a printer, one can see the______document.

a) Unformatted
b) Formatted
c) In-line
d) None of these

Answer: Formatted
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Question: In the output file, if the looks of the document are not
satisfactory, it can be further_______with the help of built-in styles or
own styles can be defined.

a) Adapted
b) Formatted
c) Modified
d) Customized

Answer: Customized

Question: Every time a modification is made in the_______text, there
will be a need to compile it again for seeing the effect of the change
in the output document.

a) Source
b) Basic
c) Beginning
d) Main

Answer: Source

Question: Both TeX and LaTeX use the file extension_______
a) .text
b) .tex
c) .txe
d) .latex

Answer: .tex

Question: LaTeX has a command called_______that produces the
popular PDF format files.

a) PDFtex
b) pdflatex
c) PDF
d) latexpdf

Answer: pdflatex

Question: Full form of PDF is________
a) Perfect Document Format
b) Portable Double Format
c) Portable Document Format
d) Perfect Deed Format

Answer: Portable Document Format

Question: _______files can be viewed on screen as well as printed to
printers and the printout looks exactly same as the monitor display.

a) PDF
b) LaTeX
c) Text
d) TeX
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Answer: PDF

Question: PDF files are very popular for sharing_______documents on
the Web.

a) Producible
b) Printable
c) Printed
d) Scanned

Answer: Printable

Question: PDF documents can be viewed in________default viewer.
a) TeX's
b) SciTE's
c) LaTeX's
d) Ubuntu's

Answer: Ubuntu's

Question: Ubuntu's document default viewer is______
a) Evince
b) LaTeX
c) Evine
d) All of these

Answer: Evince

Question: The edit-compile-view cycle has________steps.
a) One
b) Two
c) Three
d) Four

Answer: Three

Question: The document can be edited by using any plain editor
like______

a) Gedit
b) Word
c) Wordpad
d) Getit

Answer: Gedit

 

Question: The LaTeX document can be compiled by issuing the
command_______at the command prompt.

a) Pdflatex filename
b) PDF filename
c) latexpdf filename
d) filename pdflatex

Answer: Pdflatex filename
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Question: The generated PDF file can be viewed by opening it from
the_______

a) Desktop
b) GUI
c) Adobe
d) LaTeX

Answer: GUI

Question: The generated PDF file can also be viewed by issuing the
command______pdf filename at the command prompt.

a) Evince
b) LaTeX
c) Evine
d) All of these

Answer: Evince

Question: SciTE editor can also be used for editing_______files.
a) Evince
b) LaTeX
c) Basic
d) Gedit

Answer: LaTeX

Question: SciTE has one advantage over______one can compile and
view the document from within the SciTE program itself.

a) Evince
b) LaTeX
c) Basic
d) Gedit

Answer: Gedit

Question: To use SciTE with pdflatex, there is a need to make
changes in its______file.

a) Document
b) PDF
c) Configuration
d) LaTeX

Answer: Configuration

Question: LaTeX is essentially a_______language.
a) Markup
b) Highlighted
c) Object oriented
d) Simple

Answer: Markup
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Question: The LaTeX source consists of plain text with some parts of
the text marked up using markers known as_______

a) Instructions
b) Commands
c) Guidelines
d) Directions

Answer: Commands

Question: In LaTeX, some________are independent commands - they
do not mark any specific part of the text.

a) Instructions
b) Commands
c) Guidelines
d) Directions

Answer: Commands

Question: The LaTeX commands can perform a variety of tasks when
the_______is processed by the LaTeX system.

a) Organization
b) File
c) System
d) Document

Answer: Document

 
Question: The LaTeX commands provide information about the text
or the_____

a) Organization
b) File
c) System
d) Document

Answer: Document

Question: The LaTeX commands indicate the role of the marked text
in the overall structure of the______

a) Organization
b) File
c) System
d) Document

Answer: Document

Question: The LaTeX commands directly specify________
a) Formatting
b) Information
c) Data
d) File name

Answer: Formatting
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Question: The LaTeX________instruct LaTeX to process the document
in a certain way, for example, use a certain page size, start a new
chapter only on an odd-numbered page, etc.

a) Instructions
b) Commands
c) Guidelines
d) Directions

Answer: Commands

Question: LaTeX commands start with a______character followed by
the command name.

a) / (forward slash)
b) % (percentage)
c) \ (backslash)
d) A (caret)

Answer: \ (backslash)

Question: The LaTeX command name can be a______of alphabetic
letters only, or it can be a single non-letter.

a) String
b) Sequence
c) Series
d) Chain

Answer: String

Question: LaTeX commands are______sensitive.
a) Event
b) Case
c) Instance
d) Example

Answer: Case

Question: Some commands accept additional information which is
called_________

a) Examples
b) Data info
c) Arguments
d) Instances

Answer: Arguments

Question: There are two types of_______optional and compulsory.
a) Examples
b) Data Info
c) Arguments
d) Instances

Answer: Arguments
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Question: _______arguments are not mandatory.
a) Optional
b) Compulsory
c) Instance
d) Event

Answer: Optional

Question: If one or more optional arguments are to be provided,
they have to be written after the command name, enclosed in________

a) [] (square brackets)
b) ""(quotes)
c) <>(angular brackets)
d) {} (curly braces)

Answer: [] (square brackets)

Question: More than one optional argument has to be separated
by_______

a) (:) colon
b) (,) comma
c) (;) semi colon
d) (A) caret

Answer: (,) comma

Question: Mandatory arguments (if there are any) have to be
enclosed in in________

a) [ ] (square brackets)
b) "" (quotes)
c) <>(angular brackets)
d) { } (curly braces)

Answer: { } (curly braces)

Question: Documentclass is the________of the command.
a) Name
b) Optional argument
c) Compulsory argument
d) None of these

Answer: Name

Question: 12pt is an________argument.
a) Name
b) Optional
c) Compulsory
d) All of these

Answer: Optional

Question: Article is a_______argument.



13/09/2022, 20:11 CBSE Class 12 Computer Science Publishing Documents Using Latex MCQs Set A, Multiple Choice Questions for Computer Science

https://www.studiestoday.com/mcq-computer-science-cbse-class-12-computer-science-publishing-documents-using-latex-mcqs-set-311087 11/26

a) Name
b) Optional
c) Compulsory
d) All of these

Answer: Compulsory

Question: LaTeX treats all_______characters (the space, tab and
newline characters) as the same.

a) Special
b) Space
c) Line
d) Whitespace

Answer: Whitespace

Question: LaTeX converts all occurrences of multiple
consecutive________into a single space character.

a) Special
b) Space
c) Line
d) Whitespace

Answer: Whitespace

Question: The________at the beginning of a line are generally ignored
and one or more consecutive blank lines are considered to mark the
beginning of a new paragraph.

a) Special
b) Space
c) Line
d) Whitespace

Answer: Whitespace

Question: To insert a break in lines use_______at the end of each line
except the last line in the paragraph.

a) \\
b) ||
c) //
d) !!

Answer: \\

 

Question: _______is called the Line Break Command.
a) \\
b) ||
c) //
d) !!

Answer: \\
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Question: Which of the following characters is not a reserved
character in LaTeX?

a) #
b) &
c) !
d) $

Answer: !

Question: Which of the following is a reserved character in LaTeX?
a) #
b) $
c) %
d) All of these

Answer: All of these

Question: In LaTeX_______quotes are produced by repeating them
twice.

a) Single
b) Double
c) Back
d) None of these

Answer: Double

Question: LaTeX uses______to mark portions of text.
a) Clusters
b) Groups
c) Sets
d) Collections

Answer: Groups

Question: A______is enclosed between curly braces {and}.
a) Cluster
b) Group
c) Set
d) Collection

Answer: Group

Question: Any______in a group applies only to text following the
command within that group.

a) Instruction
b) Command
c) Guideline
d) Direction

Answer: Command

Question: ________are useful for applying few commands to a small
amount of text such as a part of a line, few lines or a paragraph.
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a) Clusters
b) Groups
c) Sets
d) Collections

Answer: Groups

Question: For the cases where a multitude of commands must be
applied (for example, for formatting a table or mathematical
equation properly) or where some command(s) have to be applied to
large portions of the text (like several paragraphs, whole sections),
LaTeX provides a facility called_________

a) Grouping
b) Printing
c) Environments
d) Sections

Answer: Environments

Question: An______begins with a \begin{environment-name}
command and ends with a \end{environment-name} command.

a) Area
b) Extent
c) Environment
d) Section

Answer: Environment

 

Question: All the formatting characteristics of the______are applied to
the entire text inside the environment.

a) Area
b) Extent
c) Environment
d) Section

Answer: Environment

Question: Environments can be nested. One_______can be nested
inside another.

a) Area
b) Extent
c) Environment
d) Section

Answer: Environment

Question: LaTeX has several advanced features, including________and
automatically generating parts of the documents or multiple
documents (mail merge).

a) Programming
b) Designing
c) Planning
d) All of these
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Answer: Programming

Question: In LaTeX, the_______Character marks the beginning of a
comment.

a) #
b) %
c) @
d) $

Answer: %

Question: ________are meant for the humans who read the LaTeX
source code in a text editor for understanding and modifying it.

a) Comments
b) Notes
c) Explanations
d) Remarks

Answer: Comments

Question: _________are completely ignored by the compilation process
and hence never make it into the output.

a) Comments
b) Notes
c) Explanations
d) Remarks

Answer: Comments

Question: A LaTeX document has________parts namely preamble and
content.

a) One
b) Two
c) Three
d) Four

Answer: Two

Question: The_______contains metadata (data about data)
a) Main content
b) Information
c) Preamble
d) Remarks

Answer: Preamble

Question: The_______is information about the document and
instructions on how LaTeX should process the document.

a) Actual content
b) Information
c) Preamble
d) Metadata
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Answer: Metadata

Question: The actual content is always inside the______document,
written between \begin{document} and \end{document}.

a) Area
b) Extent
c) Environment
d) Section

Answer: Environment

Question: The very first element in the______must be \ document
class {document-class- name} specifying the type of the document

a) Main content
b) Information
c) Preamble
d) Remarks

Answer: Preamble

Question: Option "article" in Document Class is used for writing
individual_______

a) Articles
b) Books
c) Slides
d) Letters

Answer: Articles

Question: Option "book" in Document Class is used for writing
entire_______

a) Articles
b) Books
c) Slides
d) Letters

Answer: Books

Question: Option "slides" in Document Class is used for creating
presentation_______

a) Articles
b) Books
c) Slides
d) Letters

Answer: Slides

Question: Option "letter" in Document Class is used for writing______
a) Articles
b) Books
c) Slides
d) Letter
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Answer: Letter

Question: Option_______in Document Class is used for generating
presentations using beamer package.

a) Articles
b) Books
c) Slides
d) Letters

Answer: Books

Question: _______points is the default font size in the document.
a) 12
b) 11
c) 10
d) 14

Answer: 10

Question: The most common paper_______in regular office uses are
A4, letter and legal.

a) Sizes
b) Dimensions
c) Scopes
d) Extent

Answer: Sizes

Question: With option_______displayed formulas and equations are
flushed left (left-aligned).

a) Fleq
b) Fleqn
c) Formula
d) Forleft

Answer: Fleqn

Question: The default alignment of formulas and equations is________
a) Left
b) Right
c) Center
d) Justified

Answer: Center

 

Question: The_______option changes the layout of the document to
print in landscape mode.

a) Portrait
b) Landscape
c) Vertical
d) Horizontal

Answer: Landscape
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Question: The document class declaration is followed by
optional_______declaration.

a) Package
b) Class
c) Variable
d) Formula

Answer: Package

Question: LaTeX allows users to write______that provide additional
functionality.

a) Classes
b) Packages
c) Variables
d) Formulas

Answer: Packages

Question: There is a large community of LaTeX users who develop
new LaTeX packages or enhance existing ones to cater to their own
needs and then share them with others over the___________

a) Comparative TeX Archive Network (CTAN)
b) Comprehensive TeX Archive Network (CTAN)
c) Complete TeX Archive Network (CTAN)
d) Comprehensive TeX Archive Net (CTAN)

Answer: Comprehensive TeX Archive Network (CTAN)

Question: LaTeX distributions themselves usually come with a large
number of preinstalled_________

a) Classes
b) Packages
c) Variables
d) Formulas

Answer: Packages

Question: To use one or more packages in our document, there is a
need to declare them in the________as \usepackage{package-name}.

a) Main content
b) File
c) Preamble
d) Comments

Answer: Preamble

Question: If the user is not using options for any packages, multiple
package names can be declared in a single \use package command,
separated by_______

a) (:) colon
b) (,) comma
c) (;) semi colon
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d) (A) caret

Answer: (,) comma

Question: ________package contains the advanced math extensions for
LaTeX originally developed for the American Mathematical Society.

a) Geometry
b) Amsmath
c) Setspace
d) Color

Answer: Amsmath

Question: ______package adds support for colored text.
a) Easylist
b) Listings
c) Setspace
d) Color

Answer: Color

Question: _______package adds support for multilevel text.
a) Geometry
b) Easylist
c) Setspace
d) Color

Answer: Easylist

Question: ________package is used for page layout tasks.
a) Geometry
b) Listings
c) Setspace
d) Color

Answer: Geometry

 
Question: ________package has special features for including
programming code within the document.

a) Geometry
b) Listings
c) Setspace
d) Color

Answer: Listings

Question: ________package helps in changing line spacing.
a) Geometry
b) Listings
c) Setspace
d) Easylist

Answer: Setspace
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Question: It is necessary to provide the title and the author
if________has to create an automatic title.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: LaTeX

Question: Providing date is_______If is omitted then the date of
compilation is used in the title.

a) By choice
b) Optional
c) Compulsory
d) Important

Answer: Optional

Question: _______piece of information can be supplied in the
preamble or as the first thing in the document environment also.

a) \title
b) \author
c) \date
d) All of these

Answer: All of these

Question: The document environments for articles and slides will
only have a title followed by the_______of the document.

a) Main content
b) Information
c) Preamble
d) Remarks

Answer: Main content

Question: A title is automatically generated by LaTeX when it sees
that_______command.

a) \ title
b) Vmaketitle
c) \marktitle
d) \spotitle

Answer: Vmaketitle

Question: The \title, \author and \date commands must precede
the_______command because their information is used in creating the
title.

a) \title
b) \maketitle
c) \marktitle
d) \spotitle
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Answer: \maketitle

Question: The document environment of a book is divided
into________main parts.

a) One
b) Two
c) Three
d) Four

Answer: Three

Question: The document environment of a book has______main parts.
a) The front matter
b) The main matter
c) The back matter
d) All of these

Answer: All of these

Question: The main content of a book has a hierarchical structure,
where a book is divided into_________

a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Parts

Question: The parts are divided into_______
a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Chapters

Question: The chapters are divided into_______
a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Sections

Question: The sections are divided into_______
a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Subsections
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Question: The subsections are divided into_______
a) Chapters
b) Paragraphs
c) Parts
d) Sub subsections

Answer: Sub subsections

Question: The sub subsections are divided into________
a) Chapters
b) Paragraphs
c) Parts
d) Subsections

Answer: Paragraphs

Question: The paragraphs are divided into_______
a) Chapters
b) Subparagraphs
c) Parts
d) Subsections

Answer: Subparagraphs

Question: Each of the above division (of the main content)_______one
compulsory argument, the title; and one optional argument.

a) Accepts
b) Acknowledges
c) Receives
d) Agrees

Answer: Accepts

Question: The title has to be displayed in the table of______
a) Lists
b) Details
c) Contents
d) Elements

Answer: Contents
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Question: The parts, chapters, sections are______automatically by
LaTeX.

a) Numbered
b) Listed
c) Displayed
d) Edited

Answer: Numbered

Question: The________can also move chapters, sections and
subsections without having to bother about remembering.

a) Programmer
b) Author
c) Writer
d) Essayist

Answer: Author

Question: The_______are numbered in Roman numerals (I, II, III, and
so on).

a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Parts

Question: The chapters, sections, subsections, etc. are_______in Arabic
numerals (1, 2, 3, and so on).

a) Numbered
b) Listed
c) Displayed
d) Edited

Answer: Numbered

Question: All chapters after the special________command get
uppercase numbering (A, B, C, and so on).

a) \parts
b) Mist
c) \appendices
d) \appendix

Answer: \appendix

Question: The_______command is to be used only once.
a) \parts
b) Mist
c) \appendices
d) \appendix

Answer: \appendix
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Question: The pages in the_______are numbered using Roman
numerals.

a) Front matter
b) Back matter
c) Main matter
d) Whole matter

Answer: Front matter

Question: The pages in the main matter and back matter are
numbered in_________numerals with the numbering restarting from 1.

a) Roman
b) Mathematical
c) Decimal
d) Arabic

Answer: Arabic

Question: By default elements are assigned number up to level 2 that
is up to_______

a) Chapters
b) Paragraphs
c) Parts
d) Sub subsections

Answer: Sub subsections

Question: _______and further divisions are not assigned numbers.
a) Chapters
b) Paragraphs
c) Parts
d) Sub subsections

Answer: Sub subsections

 
Question: In example, the command "\set counter{secnumdepth}{3}"

a) Ensures that elements up to depth 3 are assigned numbers.
b) Ensures that elements up to level 3 (sub subsection) are assigned numbers
c) Ensures that elements up to counter 3 (sub counter)are assigned numbers.
d) Ensures that elements up to secnumdepth 3 are assigned numbers

Answer: Ensures that elements up to level 3 (sub subsection) are assigned numbers

Question: Elements are assigned a number formed by appending a
period (.)

a) Period (.)
b) Colon (:)
c) Semi colon (;)
d) Hash (-)

Answer: Period (.)
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Question: _________are an exception as their assigned number does
not have a part number and period in front of them.

a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Chapters

Question: ________are assigned simple Arabic numeral numbers.
a) Chapters
b) Sections
c) Parts
d) Subsections

Answer: Chapters

Question: A well-formatted table of contents (TOC) is generated
automatically from the elements titles by LaTeX when it encounters
the command________

a) \TOC
b) \tableofcontents
c) \tableOC
d) \toContents

Answer: \tableofcontents

Question: By default a_______has entries up to level 2 (subsection).
a) \TOC
b) \tableofcontents
c) \tableOC
d) \toContents

Answer: \TOC

Question: TOC default entries can be changed by altering the value
of another built-in counter_________

a) Todepth
b) Tocdepth
c) Counterdepth
d) Setdepth

Answer: Tocdepth

Question: LaTeX processes the source file..........from the beginning to
end in a single pass.

a) Randomly
b) In line
c) Sequentially
d) Cautiously

Answer: Sequentially
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Question: LaTeX produces the output file________
a) Randomly
b) In line
c) Sequentially
d) Cautiously

Answer: Sequentially

Question: In the first run LaTeX collects information about the
document structure and stores it in_______files.

a) Extra
b) Complementary
c) Additional
d) Supplementary

Answer: Supplementary

Question: In the second run, LaTeX picks up the correct information
from the supplementary files in the beginning to produce the
correct_________

a) TOC
b) Table of content
c) Table
d) Content

Answer: TOC

Question: Just like the______LaTeX can also maintain list of figures, list
of tables, cross references, bibliography, and glossary or index
automatically.

a) TOC
b) Table of content
c) Table
d) Content

Answer: TOC

Question: In the SciTE editor, the file can be saved using______menu
option.

a) File → Build
b) File → Save
c) File → Save as
d) File → Edit

Answer: File → Save

Question: In the SciTE editor, the file can be compiled
using_______menu option.

a) Tools → Build
b) File → Save
c) File → Save as
d) Tools → Edit

Answer: Tools → Build
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Question: In the SciTE editor, the shortcut key for compilation
is_______

a) F8
b) F4
c) F7
d) F5

Answer: F7

Question: In the SciTE editor, the last line "Exit code: 0" is_______in
color.

a) Yellow
b) Black
c) Red
d) Blue

Answer: Blue

Question: In the SciTE editor, the file can be viewed in the default
document viewer by selecting_______menu option.

a) Tools → Edit
b) Tools → New
c) Tools → Build
d) Tools → Go

Answer: Tools → Go

Question: In the SciTE editor, the shortcut key for viewing in the
default document is_______

a) F8
b) F4
c) F7
d) F5

Answer: F5

Question: In LaTeX documents, a paragraph is typed in a continuous
flow without pressing_________key.

a) Tab
b) Enter
c) Shift
d) Delete

Answer: Enter

 

Question: LaTeX usually avoids breaking a word in______parts.
a) One
b) Two
c) Three
d) Four

Answer: Two
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Question: LaTeX has a hyphenation algorithm to decide the most
appropriate way of breaking the word with a______

a) Hyphen (-)
b) Tilde(~)
c) Underscore( _ )
d) Colon(:)

Answer: Hyphen (-)

Question: LaTeX uses the_______character to denote a non-breaking
space.

a) Hyphen .(-)
b) Tilde(~)
c) Underscore( _ )
d) Colon(:)

Answer: Tilde(~)

Question: LaTeX divides font families into______categories.
a) One
b) Two
c) Three
d) Four

Answer: Three

Question: ________(also called serif) font have a tiny line or curve
called serif at the end of the strokes lines.

a) Roman
b) Monospace
c) Script
d) Sans serif

Answer: Roman

Question: _______fonts do not have serifs.
a) Roman
b) Monospace
c) Script
d) Sans serif

Answer: Sans serif

Question: _______fonts use equal width for all characters.
a) Roman
b) Monospace
c) Script
d) Sans serif

Answer: Monospace

Question: ________fonts are typically used for computer code listings.
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a) Roman
b) Monospace
c) Script
d) Sans serif

Answer: Monospace

Question: The default font is__________
a) Roman
b) Monospace
c) Script
d) Sans serif

Answer: Roman

Question: Roman font can be used for any text by employing
the______command.

a) \textrm{text}
b) \textsf{text}
c) \texttt{text}
d) None of these

Answer: \textrm{text}

Question: Sans serif font can be used for any text by employing
the_______command.

a) \textrm{text}
b) \textsf{text}
c) \texttt{text}
d) None of these

Answer: \textsf{text}

 
Question: Monospace font can be used for any text by employing
the________command.

a) \textrm{text}
b) \textsf{text}
c) \texttt{text}
d) None of these

Answer: \texttt{text}

Question: The font size can be changed using the command_________
a) \tiny
b) \scriptsize
c) \footnotesize
d) All of these

Answer: All of these

Question: The font size can be changed using the command_________
a) \ small
b) \normalsize
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c) Marge
d) All of these

Answer: All of these

Question: The font size can be changed using the command______
a) \LARGE
b) \huge
c) \Huge
d) All of these

Answer: All of these

Question: The command________can be used to add the bold effect to
the text.

a) \textbf
b) \textit
c) \emph
d) All of these

Answer: \textbf

Question: The command______can be used to add the italic effect to
the text.

a) \textbf
b) \textit
c) \emph
d) All of these

Answer: \textit

Question: The command_______can be used to add the emphasis
effect to the text.

a) \textbf
b) \textit
c) \emph
d) All of these

Answer: \emph

Question: ________command provides small capital letters.
a) \textbf
b) \textit
c) \emph
d) \textsc

Answer: \textsc

Question: Superscripts can be created in text mode using the
command__________

a) \text super script
b) \text sub script
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c) fixltx2e
d) None of these

Answer: \text super script

Question: Subscripts can be created in text mode using the
command________

a) \text super script
b) \text sub script
c) fixltx2e
d) None of these

Answer: \text sub script

Question: Superscripts and Subscripts can be created in the text
using the package_______

a) \text super script
b) \text sub script
c) fixltx2e
d) None of these

Answer: fixltx2e

Question: In LaTeX, the______package provides the single space, one
half space, double space and spacing {amount-of-spacing}
environments for setting the line spacing.

a) Space set
b) Set space
c) Space out
d) Space line

Answer: Set space

Question: By default, body text alignment is fully_______in LaTeX.
a) Justified
b) Left
c) Right
d) Centered

Answer: Justified

Question: To achieve left alignment, one has to use the
environment_______

a) Flushleft
b) flushright
c) Center
d) Justify

Answer: Flushleft

Question: To achieve right alignment, one has to use the
environment_________
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a) Flushleft
b) Flushright
c) Center
d) Justify

Answer: Flushright

Question: To achieve center alignment, one has to use the
environment________

a) Flushleft
b) Flushright
c) Center
d) Flushcenter

Answer: Center

Question: The first line of a paragraph is_______except for the
paragraphs immediately following a heading.

a) Margined
b) Indented
c) Single spaced
d) Tabbed

Answer: Indented

Question: The_________command is used immediately before a
paragraph to explicitly make the first line indented.

a) \tab
b) \para
c) \indent
d) \noindent

Answer: \indent

Question: The_______command is used immediately before a
paragraph to explicitly make the first line unindented.

a) \tab
b) \unindent
c) \ indent
d) \noindent

Answer: \noindent

 

Question: The________environment outputs everything inside it
(including special characters, spaces, newlines and LaTeX commands)
as it is without any processing.

a) Verbatim
b) Moreverb
c) Listing
d) Newline

Answer: Verbatim
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Question: The________package provides a listing environment with
one mandatory argument line-number-of-first-line for program code
listing with line numbers.

a) Verbatim
b) More verb
c) Listing
d) Newline

Answer: More verb

Question: The paper size and margins can be passed as optional
arguments with the________command itself.

a) \moreverb
b) Verbatim
c) \usepackage
d) \usesize

Answer: \usepackage

Question: Page_______have been standardized internationally.
a) Sizes
b) Length
c) Width
d) Dimension

Answer: Sizes

Question: The page_______commonly used with regular printers are
A4, letter and legal.

a) Sizes
b) Length
c) Width
d) Dimension

Answer: Sizes

Question: The page size of 'A4' can be specified by_________
a) Paper a4
b) a4 paper
c) Letter paper
d) Legal paper

Answer: a4 paper

Question: The page size of 'letter' can be specified by_______
a) Paper a4
b) a4 paper
c) Letter paper
d) Paperletter

Answer: Letter paper

Question: The page size of 'legal' can be specified by_________
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a) Paper a4
b) a4 paper
c) Paperlegal
d) Legal paper

Answer: Legal paper

Question: The default page orientation is the_________
a) Landscape
b) Portrait
c) A4
d) Legal

Answer: Portrait

Question: _______can be either one-sided or two-sided.
a) Letters
b) Files
c) Documents
d) Papers

Answer: Documents

 
Question: ______are by default one-sided while books are two-sided.

a) Articles
b) Files
c) Documents
d) Papers

Answer: Articles

Question: Ability of automatically laying out complex mathematical
content is a major strength of

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: LaTeX

Question: The most common way of laying out mathematical content
in LaTeX is using the package_______created by the American
Mathematical Society.

a) Amsmath
b) Amssymb
c) Amsfonts
d) All of these

Answer: All of these

Question: A convenient way of embedding math environment in
running text is to enclose the mathematical content between________

a) #...#
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b) %...%
c) &...&
d) $...$

Answer: $...$

Question: In mathematical environments, each letter is treated as a
mathematical________

a) Value
b) Number
c) Variable
d) Equation

Answer: Variable

Question: LaTeX commands and the mathematical symbols are
produced by them using the_______packages.

a) MAS
b) AMS
c) MATH
d) GREEK

Answer: AMS

Question: LaTeX supports a large number of mathematical_______
a) Operators
b) Formulas
c) Signs
d) Text

Answer: Operators

Question: The subscript operator in LaTeX is__________
a) (the underscore character)
b) ^ (the caret character)
c) % (the percentage character)
d) ~ (tilde character)

Answer: (the underscore character)

Question: The superscript operator in LaTeX is the________
a) ^ (the caret character)
b) _(the underscore character)
c) % (the percentage character)
d) ~ (tilde character)

Answer: ^ (the caret character)

Question: The superscript operator_______the text that follows it.
a) Raises
b) Lowers
c) Underlines
d) Strikes
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Answer: Raises

Question: The subscript operator______lowers the text that follows it.
a) Raises
b) Lowers
c) Underlines
d) Strikes

Answer: Lowers

Question: Absolute values can be denoted by enclosing the
expression between two________symbols.

a) $ (dollar)
b) | (vertical bar)
c) % (percentage)
d) " (quotes)

Answer: | (vertical bar)

Question: Fractions are created using the
command________{numeratorHdenominator}.

a) \ fraction
b) Fractions
c) Frcs
d) \frac

Answer: \frac

Question: Square root of a number x is denoted using the
command________{x}.

a) \ square
b) Squareroot
c) \sqrt
d) Sqroot

Answer: \sqrt

 

Question: LaTeX provides a special_______environment for typesetting
equations.

a) Math
b) Displaymath
c) Equation
d) Math formula

Answer: Equation

Question: _______are numbered automatically and center-aligned.
a) Values
b) Numbers
c) Variables
d) Equations

Answer: Equations
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Question: Just as_______was extended to LaTeX, LaTeX itself also can
be extended.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: TeX

Question: Anyone can create additional packages to enhance the
features provided in_______to add new features or to provide
alternate implementations.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: LaTeX

Question: Thousands of LaTeX_______have been created by LaTeX
users around the world to cater to different needs.

a) Packages
b) Softwares
c) Programs
d) Files

Answer: Packages

Question: Most of LaTeX packages are________
a) Charged
b) Free
c) Shareware
d) Fined

Answer: Free

Question: The LaTeX packages are hosted on the________
a) Comparative TeX Archive Network (CTAN)
b) Comprehensive TeX Archive Network (CTAN)
c) Complete TeX Archive Network (CTAN)
d) Comprehensive TeX Archive Net (CTAN)

Answer: Comprehensive TeX Archive Network (CTAN)

Question: CTAN website is at_________
a) www.ctan.com
b) www.ctan.in
c) www.ctan.co.in
d) www.ctan.org

Answer: www.ctan.org

http://www.ctan.com/
http://www.ctan.in/
http://www.ctan.co.in/
http://www.ctan.org/
http://www.ctan.org/
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Question: ________is quite popular among authors and publishers in
mathematics, engineering, computer science and other technical
areas.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: LaTeX

Question: LaTeX is______it is highly systematic and is developed in the
academic spirit of knowledge sharing and collaboration.

a) Open source
b) Closed source
c) Open foundation
d) None of these

Answer: Open source

 

Question: _______is also getting popular among academicians and
scholars.

a) TeX
b) SciTE
c) LaTeX
d) Ubuntu

Answer: LaTeX

Question: The output of (\frac{x_l+x_2}{2},\frac{y_l+y_2}{2}) is_______
a)

b)

c)

d)

Answer:
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Question: The subsections are divided int________
a) Chapters
b) Paragraphs
c) Parts
d) Sub subsections

Answer: Sub subsections

Question: The sub subsections are divided into_______
a) Chapters
b) Paragraphs
c) Parts
d) Subsections

Answer: Paragraphs

Question: Each of the above division (of the main content)______one
compulsory argument, the title; and one optional argument.

a) Accepts
b) Acknowledges
c) Receives
d) Agrees

Answer: Accepts

Question: The title has to be displayed in the table of________
a) Lists
b) Details
c) Contents
d) Elements

Answer: Contents

Question: The paragraphs are divided into_______
a) Chapters
b) Sub paragraphs
c) Parts
d) Subsections

Answer: Sub paragraphs

Question: LaTeX has_______facilities to automatically update
numbering and references and to automatically create table of
contents, indexes, and other such needs, taking a major burden off
the mind of the author.

a) Integrated
b) Built-in
c) Many
d) Incorporated

Answer: Built-in
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Question: The output of \sqrt{b} \\[6pt] is______
a) 4b C
b) 4b + 6
c) 4b 16
d) 4b - pt

Answer: 4b C
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